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Legal Information
The information in this document is subject to change without notice and does not represent a commitment on the part of MacroMotion GmbH. No part of this manual may be 
copied, reproduced or otherwise transmitted, in any form, for any purpose, without prior express written permission by MacroMotion GmbH. All product and company names are 
trademarks of their respective owners.

We recommend that you carefully read the information in this manual, in order to avoid operator errors.
We have taken great care in developing and testing this program. Since it is currently not possible to guarantee error-free operation under all circumstances and at all times, we 
can unfortunately not entirely exclude that some errors may have crept in. Hence, MacroMotion GmbH and its distributors do not guarantee a problem-free or completely error-free 
operation of the product.

With respect to any warranty, liability and damage claims, the provisions of the terms and conditions of MacroMotion GmbH shall apply. 

We cannot accept any liability for loss of data/time or any consequential damages that may occur as a result, particularly since we have no influence over correct software installa-
tion and operation by the customer. MacroMotion GmbH and its dealers therefore cannot be held liable for any defects or unintentional damage in connection with the installation 
or use of the program Bogart 9.
Claims for damages and compensation, regardless of the legal basis, in particular due to breach of duties in connection with obligation or tortuous acts are therefore excluded. 
This shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act (Produkthaftungsgesetz), in the case of intent, gross negligence, injury of life, body 
or health, or breach of essential contractual obligations. Damage compensation entitlement for breach of essential contractual obligations is, however, limited to the foreseeable 
damage typical of the contract, unless there is willful intent or gross negligence or in case of injury to life, body or health. The provisions above do not imply a change of the burden 
of proof to the detriment of the purchaser.

Neither MacroMotion GmbH nor its dealers are responsible for any damages resulting either directly or indirectly through the use of the software or the operating instructions. This 
applies in particular to loss of profits and compensation for expenses. Any implied guarantee is excluded, including guarantee of suitability of the software or operating instructions 
for a particular purpose.

For this reason, you should make a backup of your video footage before you start using the device. We recommend that you do not delete the video footage and that you create a 
backup copy beforehand.

Since it is possible that changes were made to the software after the manual was prepared, the functions shown and described in this manual might differ from the software.

Contact Information

Germany

MacroMotion GmbH
Lindenstraße 3
24790 Schacht-Audorf, Germany

www.macrosystem.de

Support Forum 
www.macrosystem.de/forum
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Chapter 2

1  Introduction

Thank you for purchasing Bogart 9, the full-featured nonlinear editor (NLE) for video and multitrack digital audio designed for 
video postproduction.

1.1  What‘s new in Bogart 9?

Audio
The Audio-Mix menu has been redesigned and offers new functions:
• Easier operation with tabs for quick access to all important editing functions.
•  Continuous drag & drop (i.e. shifting of audio samples) and extended mouse functions (i.e. trimming of audio samples directly 

in the audio track).
• Up to 9 audio tracks (Gold-Edition).
• Advanced roll and zoom options.
• Copy function for the original sound track, which can be placed in any other track.
• Mixer window for mixing all audio tracks
• Multiple range options when combining audio tracks.
• Rendering of multiple scenes / audio tracks in the Record and Edit/Special menu (Gold-Edition).
• The “Action” button is now also available in the Audio Recording menu (Gold-Edition). 

Note: The new features in the audio mix menu require a min. screen resolution of 1,280 x 720 pixels  
(screen resolution “medium”).

Edit
•  Scenes in the Edit menu can be pasted into the storyboard more quickly, simply by double-clicking the large preview or via 

drag & drop. If the selected scene in the bin is equal to the selected scene in the storyboard, the storyboard scene will be 
replaced upon double clicking the big preview picture.

• Extensive support for trimmed areas:
• When splitting scenes / audio clips, an area for trimming is automatically added.
•  Extended trimming areas are included in the storyboard during insert scenes so that a later extension is possible.
• Extended trimming areas are added to audio clips in the audio mix and can be trimmed there again.
•  Audio areas of trimmed scenes are included in the storyboard and can also be extended in the audio mix (after copying the 

original scenes audio to another track).

Titling
• Redesigned user interface of the standard Titler ( „Bogart 9 Titler“) with tabs for quick access to all important functions.
• If additional title programs are installed (i.e. Vertigo, Title-Studio), you can select the desired Titler.

ImagePool
• Tabs in the ImagePool provide easier access to settings.
• Introduction of groups for a better overview of long lists.
• Images can be rotated freely (several options available).
• Images in the selection list are now resized depending on their quantity (in the selected product).
• The preview is updated permamently when using the alpha slider.
• When titling, the sections can be mirrored alternately.

Operation, Miscellaneous
• The selector switches can be switched using the mouse scroll wheel.
• When trimming in the preview window, a 2nd window/screen is now supported.
• For all color selection windows, colors can also be set with RGB values.
• In the Range menu, the active image can be saved directly as JPEG file.

Finish / Export
• Export in MP4 format also as a 360° video (Gold Edition).
• Graphics (overlays) can now be placed in the Export menu with a fixed aspect ratio (Gold Edition)
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NEU!

Look for this logo to jump directly into the description of the new Bogart 9 functions.

2  Installation and activation

To run Bogart, make sure the operating system on your machine is Microsoft Windows Vista© or higher (Windows 7©, Windows 
8©, Windows 10©).
To install Bogart you should be logged in as administrator on your PC. The program will be installed on the boot partition of your 
system, which usually is drive C:\. All additional files as well as video and audio data are stored on this partition.
You need at least 24 GB of free disk space. When running, Bogart reserves 16 GB hard disk space for finishing your project.
Start the installation by double-clicking the file Bogartinstall.msi. Follow the instructions that guide you through the installation.

After you have completed the installation, you will find the Bogart program icon on your Windows desktop. Double-click on the 
icon to start Bogart

When starting Bogart for the first time, the menu “Install Product” will open automatically. Select Bogart 9 from the shown list 
and click the button “activate”. Here you can input your activation code. Click “Ok” to confirm. The same way you can activate 
other products, you have purchased.

Once, Bogart is activated, it always starts in this main menu. From here, it is possible to switch to the individual applications. 
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Note: When using Bogart 9 without Windows Media Center functionality, or Windows 7 / Vista Starter or Home Basic, 
video playback might run in a slower mode, which will be inicated by a message on the screen after the first play. It is 

recommended to upgrade to a Windows version with Windows Media Center functionality.

Note: Changing the name of the Windows program icon “Bogart”, you manually have to delete the icon after a deinstalla-
tion or update of Bogart.

The functionality of Bogart SE can be expanded considerably. For 
this, there are many add-on software packages (more effects, 
fonts, specialized add-ons), which you can purchase from dealers. 
You must unlock these products. Included with your device is an 
Installation CD with lots of add-on software that you can use in its 
demo version. You can also download all software products from 
our website. When rendering, demo versions will be labelled with a 
demo logo. In order to use the effects (without the Demo overlay) 
you can give your dealer the serial number of your system machine 
(found in the System Settings menu, in the lower-left field). Your 
dealer can then charge you for the supplemental software and give 
you a key code for unlocking the software.

To install add-on software for Bogart run the installation program (*.msi) of the corresponding product you like to use. Some of 
the most important products are already installed with Bogart like Arabesk, HD-Backup Sentry and others. 
Before you can use an installed product you have to activate it. Start Bogart and open the menu “Settings”, “System”, “Install 
Product”. When using the Bronze Edition please open the menu “Settings”, “Products, ...” and then “Install Product”. All installed 
products are displayed in a list. The term after the product name indicates the status for your installation:

• (active): the products, effects, or fonts are unlocked and are available to the user without restriction.

•  (demo): the products, effects, or fonts are displayed in the lists, but are labelled with a red flag in the effect list and are identi-
fied as demo effects when used in a scene.

•  (hidden): this product and the corresponding effects/fonts  are not displayed in the Bogart SE software list. This can be used 
to hide demos once they have been previewed. Hidden demo effects will no longer appear in the effects lists.
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Now select the product or the desired bonus effect and click on “Activate” . If the effect is not yet unlocked, a menu for entering 
the key code appears . Once more, you will see the name of the product you wish to unlock as well as the Bogart serial number. 
After entering the code, you can now use the new product without restriction. Please note that if you are using a different PC, 
you will require new licensing codes for that machine.

Note: When installing Bogart on different Windows user accounts, Bogart will have a different serial number for each 
account. An activation code for a particular program does only work for one serial number.

2.1  Bronze, Silver and Gold Edition

Bogart SE is available in three editions: Bronze, Silver and Gold. The editions have some features in common, but Silver and 
Gold provide many additional features and functions. When working with Bronze or Silver Edition, you can upgrade to Silver 
respectively Gold Edition at any time.

The active edition is shown in the Bogart main menu at the top left below “Bogart SE”. 

This manual describes the functionality of all editions. Functions that are only available with either the Silver or Gold Edition, will 
show a little icon:

S  Silver Edition (those functions also included with the Gold Edition)
G  Gold Edition

2.2  Deleting Bogart and software add-ons

Sometimes it might be necessary to delete Bogart or a software add-on from your machine. To uninstall programs, go to the 
Windows Settings by selecting “Settings” on the Start menu. Select “System” and “Apps & features”. Select the desired pro-
gram, and then select Uninstall. Follow the directions on the screen. 
Please note that uninstalling an add-on software means, the corresponding effect is no longer available in Bogart. For that rea-
son make sure, that you do not uninstall effects, that are used in the storyboard but not yet rendered.

2.3  The Bogart Demo version

Bogart 9 is also available as demo version (incl. the Silver and Gold Edition). The installation file for the demo is named “Bogar-
tInstall_9. X_Demo_DE. msi”. You can install the demo version in addition to the Bogart full version. 

 
After installation you will see in the top left of the main menu that you are working with the demo 
version. 

Note: The Bogart 9 demo version can be used for any length of time. In the case of export or DVD/BD production, a demo 
lettering is stamped. So you can edit with the demo version without limitations, but the results bear the demo sign (Bogart 

hat with demo).
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To activate Bogart 9, you need to install the full version. This then creates an individual serial number that is assigned to your  
PC + user account. An unlock code can only be ordered with this serial number. The demo version does not have a serial num-
ber and therefore cannot be unlocked.
In the reverse end, this means that projects that were cut with the demo version cannot be used or finished. The demo version 
runs completely separate and parallel to the full version.
Advantage: The demo version can also be installed and tested in parallel to an older Bogart edition. This does not affect current 
projects. Projects cannot be exchanged between the full and the demo version.

3  Basics

3.1  Using the Trackball or Mouse

With Bogart you can use either a trackball or a mouse. There are small differences between the control elements for setting and 
adjusting, depending on the input device used. With a 4-button trackball the small buttons are very useful in some menus like 
“Storyboard”.

Trackball: the trackball shown here is only an example. Another model may be supplied with your 
machine, but it will function in a similar manner. Depending on the system in use, the trackball 
may utilize two or four buttons:

(1) The ball is used to move the screen cursor or, in the Trim and Split screens, to scroll through 
the video. This is also used to change the settings of sliders (scroll bars). The increment of the 
adjustment depends on the acceleration of the ball. 

(2) The large left button (selection button) is used for selecting. Press a button on the screen by 
positioning the cursor over the on-screen button and pressing (clicking) the left trackball button.

(3) The small left button is used for special functions, i.e. marking scenes in the scene bin.

(4) The large right button (cancel button) returns you to the previous state, canceling or stopping 
the current operation. Pressing this button without having selected anything will return you to the 

previous screen. Pressing the cancel button when you are making settings cancels anything you have just set and reinstates the 
prior settings. If you are playing or recording video, then clicking the cancel button will cause playback or recording to stop.

(5) The small right button is used by add-on software, i.e. opening the context menu in the Gold Edition.

Mouse: Since there are several computer mice or touchpads available, only a general meaning of 
the buttons can be given here. For any special buttons or programming keys please refer to your 
manual that came with your mouse. Please make sure also to install the appropriate drivers. When 
using a mouse with more than two buttons, the above-described functions of the small trackball 
buttons (3 and 5) might be available.

(1) The left button (selection button) is used for selecting. Move the screen cursor on a button and 
click to confirm.

(2) The right button (cancel button) returns you to the previous state, canceling or stopping the 
current operation. Pressing this button without having selected anything will return you to the 
previous screen. Pressing the cancel button when you are making settings cancels anything you 
have just set and reinstates the prior settings. If you are playing or recording video, then clicking 
the cancel button will cause playback or recording to stop.

(3) The scroll wheel is used to move through lists. Therefore just move the screen cursor within a list or the storyboard and move 
the wheel.
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(4) By moving the mouse you can scroll through scenes to trim or split. This is also used to change the settings of sliders (scroll 
bars). A Touchpad on a Notebook works identically.

 Note: When using a mouse or touchpad, the cursor will change into a double arrow on a slide 
bar. Click on the bar and a “seesaw” symbol (see picture left) will appear to control the direc-

tion and acceleration of the particular controller. just with a little move with your mouse.

Different behavior of trackball and mouse using the example of a selector switch
These switches are marked with three small white horizontal strokes in the upper right corner. To open a selection, click the field 
with the left Trackball button. If you have a mouse, press the left mouse button on the field and hold it down.
To change the selection, roll the ball or the wheel. The active field is highlighted. Clicking on the left trackball button selects the 
action. With a mouse, releasing the mouse button is enough.
A click on the right trackball button cancels the selection and restores the initial state. With a mouse, click on the right while 
holding the left button to cancel.

You usually see the mouse pointer , which allows you to select controls. If the system is busy (i.e. analysing video or audio 
footage, title rendering, or similar) it is displayed by a timer . Be patient when you see the timer. Bogart does not accept any 
further orders during this time.

3.2  Editing philosophy

Editing with Bogart SE operates in a non-linear fashion. This means that every recorded scene can be accessed instantly. The 
system does not have to wind tape to access the desired scene. Direct access is achieved by recording the video onto a hard 
drive. This means that there are practically no waiting times, even when jumping from the beginning to the end of a video. This 
technique is called “random access”. Random access (or direct access) is the fundamental characteristic of a non-linear editing 
system. It allows for a direct and total control over the recorded data.
The following principles apply to Bogart SE video editing:

1.  Recording of the desired material (video and audio), either completely or in designated sequences, which is stored in indepen-
dent projects.

2. Splitting of the recorded material into individual scenes that can each be named as you choose.

3. Trimming of the individual scenes (setting the In/Out points to ignore unwanted footage).

4. Sequential ordering of the trimmed scenes on the storyboard, in the order that you designate. You can also add Insert Scenes, 
(the overlapping of video without affecting the original audio).

5.  Selection and use of transition effects (e.g. crossfade, double exposure, etc.), with preview of the effects, and when you like 
what you see, the effects can be rendered, even in the background, if necessary.

6. Selection of image processing effects (e.g. solarize, sharpen, etc .) to add to scenes or entire sequences.

7. Titling of the storyboard (the addition of text in different fonts, sizes, colors, shades and effects).

8. Audio mixing with up to six tracks for original sound, commentary, background music and sound effects.

9. Rendering and export to several multimedia formats on external storage media or CD, DVD or Blu-ray. And of course, you can 
record and edit more footage at any time. There is no set sequence. 

This list serves only to outline the basic concepts involved.
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3.3  The user interface

The Bogart user interface contains various elements wich are explained here, although they are fairly obvious. To use a function, 
click on the appropriate button. Dark (shaded) buttons are inactive and cannot be clicked. Using certain functions may cause 
some buttons to de-activate, meaning they cannot be used. Some buttons may appear usable but at the moment have no corre-
sponding function. When they are clicked, a red, crossed-out circle  appears indicating that no function is currently possible.

Help Texts (bubble help)

Navigate the screen pointer across a user-interface element that is only represented by a 
symbol, and let it rest there for a little while. After about one second, a Help Text will appear 
just above this interface element, telling you what the function does. As soon as you move the 

pointer again, the Help Text will disappear. This function is available for most symbols; however, it is not available for all add-on 
products. You can (de-)activate the Help Texts by going to `Settings´ and then `Operation`
In a similar manner, information with respect to a scene will be displayed when you pause the mouse pointer on a scene in the 
Storyboard or in the scene bin. You will be shown information on the indicated scene.

Buttons

Simple Buttons are fields containing text captions that describe the functions they perform. They cause 
something to happen when they are clicked upon, and they are usually clearly labelled. For example, clicking with the left track-
ball button on the “Delete” button causes the selected scene to be deleted.

Selection buttons

These buttons are indicated with three small, white horizontal bars in the upper right 
corner. Clicking with the left trackball button opens a list of different options (click and hold, when using a mouse). You can scroll 
among them with the trackball (by rolling the ball up and down). The currently active field will be highlighted. Clicking on the left 
trackball button (release button when using a mouse) then activates the selected option. Clicking on the right trackball button 
cancels the operation and restores the original situation (or click the right mouse button while still holding the left button).

Sliders

Sliders can be either horizontal or vertical. After a slider has been clicked, the ball of the trackball is used to control movement of 
the slider. The cursor disappears and the trackball now controls the slider. Control of the slider is relinquished by again pressing 
one of the trackball‘s buttons. Clicking the left button accepts the current slider setting and relinquishes control. 
When using a mouse, press and hold the left button. Move the mouse in the direction the slider should move. A click on the right 
mouse button accepts the current slider setting.
Clicking the right button cancels any changes you have made, returns the slider to its previous position and relinquishes control.

You can use the arrow buttons (usually to the right of a horizontal slider or below a vertical slider) to step through footage one 
step at a time (e.g. from one effect to the next). 

The symbols |< and >| are used in the Edit menu to jump to the beginning or end of the storyboard.

Sliders let you quickly adjust a desired value, for example, to adjust the length of 
an effect. The value is shown next to the knob. Clicking in the display resets the 

previous setting again.
In some cases you will find additionally three buttons below the slider with default values. Those values can be changed to your 
own preferred settings by using the button “Save”.

Name field

By clicking on this button you cause an on-screen keyboard to appear, showing 
the name of the selected scene. You can use the keyboard to enter a new name.



11Bogart for Windows User manual

Chapter 3

On-screen keyboard

At certain points, such as in the text input menu for titling, Bogart SE allows or requires text input, (for example when naming 
scenes, entering text for titles, and naming audio sequences).
You can enter text with your keyboard or by trackball/mouse when the on-screen keyboard appears. The text is entered by using 
the trackball to click on each individual letter key. Some of the keys are especially important:

(1) Delete key (delete text letter-by-letter)
(2) Newline key (start a new line)
(3) Shift key (toggle between uppercase and lowercase)
(4) Single shift key (only the next key appears in uppercase)
(5) Alt key (special characters, such as @ and €)
(6) The S key to the left, used to display the special characters menu. This menu contains all available characters. This includes 
many letters that are primarily used in foreign languages, such as the ç or accented letters in French. If you want to enter the 
characters “é”, “á”, or “ô”, you can either select them in the special characters menu or use the normal keyboard. Click first on 
the accent and then on the corresponding letter. The accent is not displayed until you select the letter.

When the keyboard is displayed you will see that the entire current name of the scene is highlighted. This allows you to immedi-
ately delete the entire name, with a single click on Delete. A new name can then be quickly entered. If you only want to change 
one letter within the word, click on the letter just after the letter to be changed or move the cursor (vertical bar) by using the 
arrow buttons to the right of the scene name. Press the delete key and then the key for the new letter. This works the same way 
when inserting new letters: simply click on the character just after the desired insert position and then type in the desired charac-
ters. Characters are always inserted just before the cursor.

IN- and OUT Points

These points are set to mark certain segments of a scene. This can be a Trim 
procedure, but also the placement of an Image Processing effect in the storyboard 

(“Range”). When you click with the left trackball button on “IN” or “OUT”, the trackball function changes. Rolling the trackball 
then causes the video to scroll forward or backward through the video scene with a speed depending on the speed the ball 
is rotated. An additional click with the left button sets the new beginning (IN) or end (OUT) point. A click with the right button 
reinstates the original setting. The time (Time code) is shown in the same format you have chosen for the Time code display: 
000:00:00 (min:sec:frames) or 00:00:00:00 (hrs:min:sec:frames).

Scene check

These two buttons (see above) serve to quickly review the first and last few seconds of a scene or audio segment. The 
“|>” button plays the first 3 seconds starting from the IN point. The “>|” button plays the 3 seconds just prior to the OUT point.

Arrow buttons 

Stepping through individual frames (see slider) works by clicking on the “>” and “<” symbols. Clicking on “>” moves 
forward to the next frame. Clicking on “<” moves backward to the previous frame. This behavior is found at several points in the 
program, for example when trimming, splitting, or using sliders within the effect lists.
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Symbols for playback, pause, stop

Several menus have buttons for playback, pause, and stop, with which you can play your video and audio material. 
You are probably familiar with these functions on other devices, such as your DVD-player.

This is the symbol for Play. Clicking it will play the video scenes or audio samples.

This is the Pause button. Clicking on it causes a pause in the playback of the video footage. Clicking on it again ends the 
pause and the video material is played from the point at which the pause was made.

Clicking on the Stop symbol stops playback/recording. If you initiate playback again, the video footage will be replayed 
from the beginning. Playback can also be stopped by pressing the right trackball button.

Level indicator

The level indicator is displayed in various menus of Bogart to control the level of audio 
in samples or scenes.

NEU!

The classification of the scale (from left to right) shows:-54,-48,-42,-36,-30,-24,-18,-12,-6, and 0 dB. Blue flickering or 
leveling in the blue area is not critical (at most too quiet). Level swings in the yellow area mean hig-her volume. However, 

there is a risk of over modulation if multiple clips are mixed with levels in the yellow area.
A level rash in the red area (over 0 db) signals an overdrive. If you don’t want to hear any distorted sound in your movie, you 
should decrease the volume.

Color box

The color box enables you to select a color, any color. Clicking on the pal-
ette arrow (1) enables you to choose a specific color. Scroll through the color 
palette (2) until your desired color is displayed in the color window below (3). 
After confirming this color by clicking the left trackball button you can define the 
color more precisely. Click in the large color window and use the upper arrow 
(4) to scroll left or right in order to attain the desired saturation. Use the left ar-
row (5) to scroll up or down to set the color brightness.
With a little practice you can specify your desired color by simultaneously using 
both arrows. The intersection point of both arrows (if you imagine them extend-
ing until they touch within the box) indicates the selected color, which is always 
displayed to the right in the rectangle (6). Clicking on the left trackball button 
confirms the setting. You can also click directly on the color you wish without 
having to use the arrow keys, by simply clicking on the desired color within the 

color window (3). The color that you selected is at the same time displayed in the top left color button (9) for as long as the but-
ton remains activated. Below it you will see five other color buttons/memory buttons (10), which allow you to select frequently-
used colors quickly and conveniently. To assign your preferred colors to the memory buttons, first activate a memory button and 
then select a color in the big color window. Once the required color is assigned to the memory button, activate another memory 
button or the top color button (9).
In many cases (e.g. when titling) the color box provides the Alpha option (7). Here you let the desired color shine through your 
motif displayed on the right (6), (the Eiffel tower is shown here as an example). You can specify the alpha value in percent by 
moving the scroll bar. The lower the percentage value the more transparent your selected color and the more clearly your motif 
shines through. Clicking on the “Pick color” button (11) opens the first frame of the scene that is selected in the scene bin (in the 
case of the “New” menu) or in the storyboard (in the case of the Effects menus). There is a toolbar in the foreground containing 
several buttons.
If you have opened the color box from an effects menu, you can first of all use the top left selection button to specify whether the 
scene (“Effect”) that is currently selected in the storyboard or another freely selectable scene (“Choose”) should be displayed.
Clicking on “Choose Scene” opens the scene bin and you can specify a scene from which you want to capture the color. If the 
upper selection button was previously set to “Effect” it will automatically switch to “Choose” after you select another scene. You 
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can then use the selection button to conveniently jump back and forth between the two scenes. (by activating the color box in 
the transition effect menu, you can use the two “Left scene” and “Right scene” buttons allowing you to switch back and forth 
between the respective scenes). You can use the slider control or separate buttons at the bottom to roll through the selected 
scene frame-by-frame (in the case of image-processing effects, you also have the option of rolling through the entire length of 
the effect, i.e. through several scenes).
The “Position” and “Size” buttons allow you to adjust further settings for the color capture function. The smaller the little selec-
tion box is, the more precisely you can specify the color. In the little “Color” box, you can view the color over which the box is 
currently placed. If there are several colors contained within the area of the selection box, an average color value is taken.
After you click on “OK” you will see that your selection is applied to the color window of the color box. If you click on “Cancel”, 
you will close the menu without applying any settings changes.
You can use the Archive function (8) to save the colors you specify for later use (see “Archive function”).

NEU!

Under “RGB” (12) you get access to the RGB color input field, which lets you enter the values for the colors as numerical 
values for the red, green, and blue portion of a color. This has the big advantage over the previous color selection 

method, that you can define a specific, always reproducible colour value.

In addition, the RGB color values are common in many programs on the PC and can be recalled much more precisely.

When you have finished making all the settings you want, click on “OK” to confirm and to exit the color box.

Tip: If you would like to reuse a color for titling that has already been used for an effect (e.g. picture-in-picture), archive the 
effect color, change to Titling and reload the color. You can access archived colors from all projects!

The symbols for direct menu change

Most of the Bogart menus (i.e. the Edit menu) have icons (bottom right) which serve to jump from one menu to another. It is 
always possible to return to the Main menu and go from there to the individual menus, but the experienced user will save time by 
using the symbols to access menus directly. You will become used to the symbols while doing some editing. Instant memoriza-
tion of their uses is not necessary.

G  Wave form and audio scrubbing

The menus Insert, Range, Split, and Trim (video and audio) contain a loudspeaker symbol in the operating panel (only if the 
Gold Edition has been activated).

When this symbol is active (blue) a small box containing the Audio Wave Form is 
displayed at the other side of the operating panel. The wave form graphically displays the 
volume over time. The height of the curve represents loudness (the higher, the louder) and 

the width is a measure of time. In the wave form you see a vertical, black position marker indicating your current picture position. 
This position marker is also shown when you scroll through the scene or the audio segment.
The Audio Wave Form is automatically played when one of the buttons “In”,  “Out”, “Split position” or “I” or “I” is clicked and 
the trackball is held motionless for approximately 0.5 seconds. A movable, vertical white-hatch bar indicates the actual playback 
position.

When trimming the beginning of a scene (In) the black position marker can be seen to the left on the curve. When trimming the 
end of a scene (Out), it can be seen to the right. As you scroll through the scene you hear the corresponding audio. Depending 
on the scrolling speed you hear the audio faster or slower (often referred to as “scrub audio”). The wave form has two different 
display forms. When scrolling through the scene you see a detailed wave form or a segment of the wave form. As soon as you 
receive a preview of the last second the wave form for the entire playback time is shown.
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If you do not need the wave form, it can be deactivated. Click on the button with the loudspeaker symbol to make it return to its 
original color and to make the frame disappear. To bring the wave form back, click on the symbol again.

i-buttons
Most effect menus, including transition / image processing effects, and Titling screens all have an “i” button. This is a button for 
obtaining information. If you have selected supplementary or bonus effects and click on this button, a Product information menu 
opens and gives you an explanation or summary instructions for the selected effect. If there is a manual available for a product, 
the information will refer to that manual. This button is inactive for those effects for which no information is provided. The “i” but-
ton is also present in the Install product menu in the System Settings screen. There you can bring up information on the products 
selected in the list (e.g. effect modules, font packages, etc.). You will also find information and summary instructions for products 
that are only installed as demo versions, if available. The info button of the edit menu is available both in the “Storyboard” part 
(displays information about the storyboard) as well as in the “Scene Bin” (displays information about the activated scene).

Archive function

You will see the “Archive” button in various menus and screens (e.g. titling, color box). Clicking on 
this button opens a screen in which there are four buttons: “Load”, “Save”, “Delete”, and “Cancel”. 
Clicking on “Load” displays a list of the titles, effects, or settings that have previously been saved. 

You can then directly select an entry or scroll to an entry in this list and confirm. A click on “Save” displays the same list. There 
are now two possible courses of action:

1. You can click on the rectangle directly below the list so that the keyboard is called up and you can type in a name, after which 
you click on “OK” in the keyboard and in the text archive field. This creates a new archive entry.

2. You can select an entry from the list and then click on the rectangle in which the name of the selected entry is now visible. 
Now you can use the keyboard field to overwrite this name with another name of your choice. You may also click on an entry 
without clicking on the name field. You can then confirm by clicking on OK. The selected entry will be replaced by the previously 
created entry, but it will keep its name.
With the help of archiving you can save frequently used standard text and reuse the text at any time in any of the projects. If you 
click on “Delete”, a list of the saved entries is displayed in which you can select an entry to delete and confirm with “OK”. Click-
ing on “Cancel” exits the window without making any changes.

Determine position as effect property
Many effects, like transitions, long-term effects or titling, offer the possibility to determine a 
position in their settings. This is required to define the origin of an effect or the insertion of a 
second scene for a transition, as well as for the positioning of text in Titler or effect position in 
long-term effects. For example, in the transition effect “Rectangle Wipe”. Selecting the button 
“Position / Size” will open the “Position” menu. You will see a dashed frame in your scene, by 
which the position of the effect / scene is defined.

To change the position, click on the button “Position”, then you can directly change the loca-
tion of the frame. By clicking on “Size”, you can change the dimensions of the frame, the upper 
left vertex is always fixed. A grid can be adjusted in order to position a scene better. Especially 

when creating a multi-layer effect, the positioning is much more precise when using a grid.
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Image-Pool

The Image Pool is a particularly useful function. This 
is a global area in which graphics and masks can 
be stored. Graphics and masks can also be ex-
changed between different software packages. For 
example, graphics can be stored here, directly from 
your video footage. The main program and almost 
all add-on programs make use of the Image Pool. In 
this way, graphics brought into the system by one 
program can automatically be used by all other  
programs.
The Image Pool is used in many areas of the sys-
tem, e.g. titling, when creating new scenes, in the 
edit screen or in conjunction with Arabesk. If you 
select the scene “Pattern” in the menu “New”, the 

option “Select Pattern” appears to the right. You can click on this to open the Select pattern screen which offers you a number 
of patterns to choose from. In the upper left area, the selection button “Product” offers you a list of the main program “Bogart 
SE”, “Arabesk” (if installed), different additional programs and the option “Custom Images” ( G  requires Gold Edition). The next 
selection button “Type” offers you up to four different types of graphics:

Masks are used mainly by programs such as “Ultimate Spice Box” or “Pattern Fade”. The masks are gray pictures whose form is 
used by these programs to specify the course of effects. But the masks can also be used for other purposes. For example, they 
can be colored and used to achieve variety in backgrounds for titling.

Pattern monochromatic (gray) patterns (also called “textures”) are listed here. These can be colored and used as a background 
elsewhere. Because the patterns are usually smaller than the screen, they are automatically tiled on the screen, until the desired 
surface is completely covered.

Pattern polychromatic shows multi-colored patterns that are used in the same way as the monochrome patterns.

Images can be found in this category, (e.g. you see here the maps of the program “Columbus” (if it is installed) or the back-
ground pictures for Arabesk). Although they are intended to be used as a background for DVD titles, the pictures can also be 
used elsewhere in the system.

You‘ll find “Bogart SE” under “Product”, where you can find logos of the single systems as well as the MacroSystem logo. These 
can be used as background pictures when creating your own text panel in the titling screen and are therefore very useful for 
credits. In addition, you will find many pictures provided here (e.g. stars). They have many uses particularly when creating titles.

NEU!

In Bogart 9 it is possible to further divide individual types by means of a “group” definition (see picture above). This 
division does not yet exist for many products, but will be expanded in the future.
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In the bottom left corner of the image pool you will see the i-button described earlier. This button allows you to access informa-
tion on the currently selected “Product”.

G  If you click on the “Custom” button, the “Product” selection will change to “Custom Images” and the “Type” selection will 
change to “Images”. 

At the same time, you are prompted to choose the source from which you want to import a still im-
age into your own pictures. “image from scene” brings you to scene storage of the currently select-
ed project, where you can select a scene and then define the corresponding image with “position”. 
“Import image” allows you to import an image, graphic, or photo from a disc, i.e. a CD/DVD, an 
internal or external hard drive, or a USB stick. “Remove image” deletes the image previously marked 
in the “Custom images” pool.

You can use the “Custom images” as all other images stored in the image pool in various areas of the program.

Tip: You can‘t delete your own pictures, but you can replace them anytime with new ones. You can of course also readjust 
the “Product” selection and “Type” selection manually before saving a picture.

NEU!
In addition, there are other improvements to the image pool. Selected images, masks or patterns can be changed in a 
variety of ways with the setting options on the right side of the menu “Select Pattern”.

The different design possibilities are divided into tabs. The “Format” tab is active in the image below. As soon as you make a set-
ting here, the tab gets a blue dot. If you select a different tab, you can also make changes there.

The „Reset“ button  resets all settings back to default.

Format
In “Format” we can mirror the image vertically, horizontally or in both ways at the same time.

In Bogart 9, there is another type of mirroring that may not necessarily be used for images, but rather for textures that are not 
entirely designed for the “endless tiles”.

 

In the upper left picture you can see a texture that is actually inappropriate, but which can be used with the “every second image 
horizontal + vertical mirror” function on the right side. This function becomes even more important when we use the “rotate” op-
tion. The mode of an image can be changed from “Positive” to “Negative” as usual (image above right side).
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NEU!

New in the version Bogart 9 is the possibility to rotate a picture or a texture. The angle of rotation can be changed 
from-180 º to + 180 º.

If you apply this option to an image, the question arises, of course, how to deal with the edges. With the preset at rotation, the 
corners of the rotated image disappear, at the same time you see the background. If you do not want to see this clearly visible 
picture for stylistic reasons, this is rather disturbing.

The second “rotation option” zooms the rotated image so that the background is no longer visible. The rotated image is thus 
filled and the corners cut off.
The third option zooms out so far that the image is completely visible and nothing is cut off. This may be useful for pictures or 
photos that are put together according to the type of collage.
The fourth option “tile” the rotated graphic to get a format-filling image.

 
This function is very useful for relatively small 
textures. You can use it if you want to rotate 
it and fill it in a format that is relatively close 
to zoom (image left, left part). With the fourth 
rotation option, Bogart tiles these rotated tex-
tures to allow much larger or more zoomed-
out background images.

Image

The “Image” tab lets you change the brightness, contrast, and color saturation of the 
selected graphic.

Color
The Color tab allows you to color the selected graphic, a photo, a scene image, a texture or a mask (also when already colored). 
Use color to open a window with multiple switches.
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Use “Mode” to select how many colors are to be used. This will then lead to the 
respective amount of palette buttons appearing.

Your coloring will be displayed in the preview window.

Original: There is no coloring and the image/pattern remains in its original color or monochrome. Additionally, you can use this 
function to return to the original color of the pattern.

1 Color: The image/pattern brightness remains; yet one color is added according to the color you choose in “Color 1”. The 
brightness chosen in the color box is ignored as this is controlled by the monochrome part of the image/pattern.

2 Colors: You can create a color gradient from one color to another. “Color 1” is added in the parts used by the monochrome 
image. “Color 3” replaces white. Depending on the pattern, instead of the black and white parts, the most bright and dark parts 
of the pattern are used. Between the two colors, all previously monochrome tones are replaced by the respective color tones and 
a soft color gradient is created.

3 Colors: In comparison with the shift between two colors, a third color is added: “Color 2”. This color replaces the gray tone 
found in the middle of the original monochrome gradient. The result is a gradient from Color 1 to Color 2 to Color 3.

Tint: This mode is only provided for color masks. If you select this function, the “Color 1” button is activated, which you should 
then click. Specify a color and confirm with “OK”. All the colors of the mask are then replaced by the one you selected. The 
entire picture is then filled with one shade of color, though the saturation and brightness are retained.

Hue: This option is likewise only provided for color masks. If you click on this button, the system first of all determines which is 
the dominant color in the mask and then displays it as “Color 1”. You cannot select this button. Now click on “Color 2” and use 
the upper palette arrow to select any color shade that you want to replace the dominant color with. All the colors in this mask are 
thus replaced with a new one, whereby the distance in the color palette between the original and replacement color is equal to 
the distance between the dominant color and Color 2.

Hue 2: This option functions in a similar way to “Hue”, and is therefore only displayed for colored masks. Though in this case you 
can freely select the color that is to be replaced by capturing it from the image (see Color box). You can customize the settings 
for your mask still further by using the “Brightness”, “Contrast” and “Color” buttons that are located in the bottom area of the 
window.

For simple, soft gradients, it is recommended that you use the “Linear H” (horizontal gradient), “Linear V” (vertical gradient) and 
“Linear D” (diagonal gradient). The direction of the color shift can be altered using the “Mode” button. 

The little box next to the “Colorize” button can be used to activate or deactivate the colorization of the pattern displayed in the 
upper preview window. If a dash appears in the little box, you can see the original color. If a check mark is shown, you can see 
the pattern with the colorization that you set. You do not have to activate the check mark in order to colorize a pattern. All you 
need do is click on the “Colorize” button.

With “Mode” you can choose from eight different positive and negative inverses. To select a color, you can access the color box 
directly using the little color box in the bottom left corner of the right-hand image pool area (on the left next to “OK”). If, for exam-
ple, you click on the “Color/Pattern” button when selecting a border for the titles, you will first of all see the image pool in which 
you can either select (using the button described here) a mask or a color as desired.
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S  The pattern chosen, with its chosen settings (e.g. direction, color), can be saved and used again at a later stage. For this 
purpose, use the “Archives” button.

The pattern archive makes a distinction between patterns (Edit menu “New”, “Pattern”, such as patterns for fonts and back-
grounds in the titler) and effects (alpha masks for pattern fades or the add-on program Ultimate Spice Box). Patterns that have 
been stored in one of both archives cannot be accessed from the other. Included, you‘ll find a number of pre-set examples 
(“Granite dark”, “Wood”,…) in the archive.

Selection in lists

In some menus, you can select multiple items from a list. 
For example in the audio dubbing, if you want to apply 
effects to an audio track or sample.  
All selection lists work in the same way.
There is a little box before every item in the list. A dash 
in the box means, this item is not selected. If you want to 
select one or more items out of the list, click on the par-
ticular boxes and a check mark will appear. Those items 
are selcted now. Clicking again on a box with a check 
mark will deselect this item.

Clicking this button opens a menu, where you can 
select or deselct all items in a list just by clicking 

the button “Select all” or “Deselect all”. This possibility is 
also useful, if you want to select almost all items for the 
import i.e. very fast. Click „Select all“ and uncheck the 
items you do not need.

Menu
There are different kinds of menus in Bogart. Some menus take up the entire screen like the “Main menu”, „Editing“ or „Mix“.
Some menus are smaller and will partially cover a main menu, so the background is slightly darkened to draw attention to the 
currently open menu, or options.

4  Reference 

This part of the manual serves as a reference to the individual menus. Look here for information on individual functions or menu 
items you may be unsure about. To get the most out of Bogart, we recommend that you read this part in its
entirety. Please note that depending on the activated Edition (Bronze, Silver Gold), the functions explained in this text may vary 
slightly or may be missing. 

Bogart always starts in this main menu. From here, it is possible to switch to the individual applications. It is also possible to 
switch directly from one application to another. For example, it is possible to switch directly from the transition effects menu to 
the image processing menu. It is also possible to go via the main menu. When a menu is displayed, clicking the right trackball 
button will go back one menu level. The last step will usually also be this main menu. 

4.1  Settings

After selecting the top “Settings” and you will enter the “Settings” menu, where all configurations of the program are defined in 
the sub-divisions.
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4.1.1  System
This menu is used to make general settings.

Install product
Clicking on the “Install product” button opens up a window, with a list of all products you have installed on your machine. You 
can use the “activate” function to activate software. You do this by first selecting the desired software, after which a window is 
displayed in which you then enter the code obtained from your dealer. The product is displayed in the corresponding selection 
menu and can now be used. Software demo versions are installed by activating the product without entering a code, instead by 
pressing the Demo button (see also chapter 2.1). The “Hide” button prevents display of the product and thus also prevents its 
use. A hidden product is not deleted from the hard-drive. It can be reactivated at any time. You can activate the software by tell-
ing your dealer the serial number of your system (bottom left in the information field) so that you can purchase the code.
Another function in this window is the “i” button. Clicking on this button displays additional information on the selected software.

Among these buttons, there is a button with a USB symbol. This function can make it easier to repeatedly enter unlocking codes. 
When you have unlocked all your products, and manually entered the unlocking codes, these codes can now be stored on a 
USB key. This has the advantage that you will not have to manually re-enter the codes in the system after a reinstall. Connect 
a USB key to your system. Click on the button with the USB symbol. A small menu will open in which you can choose between 
Import and Export. When you want to store your licence codes, click on Export. A file named “licenses.txt” will be written to the 
USB key. This file now contains all the product codes you have entered so far. You can also look at this file or print it out.

If you have saved this file and you need to re-enter the codes after reinstalling the system, you will now be able to use this USB 
key. Insert the USB key in your system, click Import in the menu and then select your key in the list. The file with the license 
codes that was written on your USB key will then be read into your system. These products will then be unlocked on your sys-
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tem. This means that, if these products are already on the hard disk, these will be activated automatically. Should you load these 
products afterwards, you will not have to unlock them.

Prefer external DVD/Blu-ray drive
When activating this option (click on the dash in the box, so that a check mark is shown) an external optical drive is preferred 
from the system when burning CDs, DVDs or Blu-rays.

Move (Arabesk) data-directory

Usually video and audio data are stored on the same hard disk partition (boot 
drive) on which Bogart is installed to. But you can choose also another directory 
on another partition of your drive or even another internal hard disk, i.e. if you 
don’t have enough free space on your boot drive. Therefore you have to move 
your data-directory.
Click the button “Move data-directory” an on screen text will appear. Clicking 
“Ok” opens a Windows menu where you can choose the desired hard drive and 
directory where you want to move your Bogart AV directory. Clicking “Cancel” 

aborts the procedure. External (removable) drives are only supported with the optional “Disk-Juggler” software.
You can also move your data-directory for Arabesk like described above by clicking “Move Arabesk data-directory”. Since Ara-
besk can create 10 disk projects with 50 GB each you might need up to 500 GB of free disk space.

Information

Clicking “Information” will show some useful information like the used 
Bogart Edition, free disk space and file directories or playback mode.

4.1.2  Operation

Use “Operation” to select basic settings for the operation of the sys-
tem. Use this menu to select the language that should be displayed 
in menus and on buttons. The keyboard layout depends on your 
Windows settings. 

Language: This displays a list with several languages that can be 
used to change the language of the system. Select the desired 
language and confirm with “Ok” and the switch takes place immedi-
ately.

Input Device: Here you can select your input device for Bogart: 
“Trackball”, “Mouse” or “Mouse without seesaw”. When you change your input device once in a while you should select “Auto-
matic”.

S  G  Display bubble help: This activates (checkmark in the box), or deactivates (dash in the box) the Help Texts. Once activat-
ed, Help Texts appear for the many user interface elements that are only represented by symbols. If you leave the screen pointer 
unattended for about one second, resting upon the function symbol, the text will appear. This option is not available for some 
separately purchased add-on products. If the option has been deactivated, these texts will not be displayed.

Display PowerKey-mapping: This activates (checkmark in the box), or deactivates (dash in the box) the PowerKey Help Texts. 
Once activated, the PowerKey shortcuts appear for many user interface elements that are only represented by symbols.

G  Timecode display: is used to select one of two possible time displays for play back. The formats 000.00:00 (mmm. ss.ff) or 
00:00:00:00 (hh.mm.ss.ff) can be selected (ff = frame or image number).
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G  Play-Timecode: determines if the time is displayed running from 0 to the end (Casablanca) or if the tape position (on the DV/
HDV tape or within an AVCHD scene) is shown. This tape position can of course only be shown if the information was transferred 
correctly when the footage was loaded into Bogart SE.

PC Interface: activate (checkmark in the box) this option, if you want to use typical PC operation like double-clicking the mouse 
button to add a scene into the storyboard.

Size of user interface elements: here you can optimaize the appearance of the user-interface for your individual needs. More 
options are available in some Bogart menus, which are described later in this manual.

Additionally to your screen settings (see 4.1.4), you can setup the size of the user interface elements 
(buttons, sliders) in four stages “small”, “normal”, “large” und “very large”.

We see the effect of this setting in the following example of a 1.920 x 1.080 resolution screen:
 

“small”       “normal”
 

“large”       “very large”

As you can see here, the buttons, fonts and control elements are getting bigger, the scene images are bigger in the “normal” set-
ting and the number is less. When setting “large” and “very large”, the images shrink in size in favor of switches and knobs. On 
the other hand, readability and operation becomes much more easier, even when working in very high screen resolution.

Mouse pointer: The size of the mouse pointer can be set to “small”, “medium”, and “large”, regardless of the screen resolution 
and the size of the controls. The adjustable mouse pointer size is also useful for better usability. 
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4.1.3 Storyboard, Timeline
              

You can choose here if you want to use the Storyboard view or the Timeline view in your projects.

S  G  Requires Silver or Gold Edition. Only with the Gold Edition the full functionality is available.

Use the Mode button to indicate whether you want your movie to be displayed as a storyboard or in a timeline.
To use the “Timeline” method, your screen resolution must set to “high”, otherwise you have to choose “small” for Stamps and 
“off” for Insert.

Storyboard

Mode (Image top left): This switches between the Storyboard and Timeline display. The Timeline method gives you two options. 
Either ‘Timeline’ for using the Timeline in all menus, or ‘Timeline (Mix only)’ for using the Timeline only in the audio mix screen.
The options “Video”, “Insert” and “Change colors” are deactivated when Mode is “Storyboard”.

Video (Image top center): You can display a text in the video track, using the name of a scene as identification. It is also possi-
ble to use a relevant image at the start and the end as representation of the scenes. If you opt for the image, you can also select 
a size (small, medium, large). The images have priority over the text so in some cases, the text may be overlapped by the image.

Insert (Image top right): You can make the same settings that are possible for the video track. In addition, you can also deacti-
vate the insert track altogether, if you don’t need it.

Stamps: This is used to select between three settings for the size of the scene images in the storyboard as well in the timeline: 
“small”,” medium” and “large” einstellen. When screen resolution is high and Stamps set to “small” you will see many scenes in  
the storyboard (timeline) but with less details. When Stamps is set to large, you will get fewer images but with much more details.

Change colors: This button activates an alternative scene display for the video track. If you activate this option, scene will also 
be displayed in differing tones of blue, in addition to the yellow separation line.

Draw Envelope: This is used when mixing sound when sound samples are displayed with a sound curve and an envelope in the 
timeline view. If you remove the checkmark for the sound curve, the sound curve will no longer be drawn. This makes it possible 
to have a smoother image when working with longer samples (several minutes) on older equipment. Therefore, when you think 
that the image in the sound mix menu seems very slow to come up, you can try to deactivate the sound curve display.
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Scene bin
       

The display mode of the scene bin can also be set in this menu. This setting is also dependent on the currently selected screen 
resolution and therefore not always available.

Mode (Image top left): The scene bin will automatically change from a single line scene list to a multiline scene list. With these 
settings it is possible to set the type of scene bin you want to use, even in higher resolutions.

Stamps (Image top right): This is used to select between three settings for the size of the scene images. This changes the size 
of the scenes in the bin, the Storyboard display does not change.

4.1.4  Screen
              

S  G  Requires Silver or Gold Edition. In the Bronze Edition you can set your screen resolution in the menu “Settings”, “Resolu-
tion”. Only with the Gold Edition the full functionality is available.
Click on the “Screen” button to make various screen settings. Under Bogart SE, you can choose to work with one or two 
screens, if your device allows it. There are two separate selections for this.

Resolution: Choose between four settings for the resolution of the Bogart 8 workspace (Image top center).

Note: Bogart allows four different resolutions that are also available in the Windows settings. When your setting for the 
resolution in the Windows setup is ≥ the Bogart settings, the Bogart user interface will be shown in one window and you 

can switch to full screen. There might be small artifacts because of upscaling the screen. For a crisp, clear display we recom-
mend to setup “original resolutions”.

low: This setup shows a 16:9 screen with a resolution of 1.024 x 576 pixels (matches 720 x 576, 16: 9 at 1:1 pixel aspect. Suits 
well with low resolution monitors (i.e. old VGA monitors).

medium: This setup shows a 16:9 screen with a resolution of 1.280 x 720 pixels. Suits well with mid resolution monitors.
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high: This setup shows a 16:9 screen with a resolution of 1.920 x 1.080 pixels. This resolution matches well with typical AVCHD-
footage. That means you can see your HD-footage in its original resolution. This setting is kind of a standard for modern PC and 
TV monitors.

very high: This setup shows a 16:9 screen with a resolution of 3.840 x 2.160 pixels. This resolution matches well with typical 
4k-footage. To work in very high resolution you will need a 4k-monitor that is connected to a HighEnd PC via Display-Port- or 
HDMI 2.2 port.

Window 2 (Image top right): Use this setting if you want to playback a scene or video image in a second window. The second 
window can be on the same monitor as the first window or on a second monitor connected to your machine. Choose between 
the following options:

--- : No second window, playback should be done in only one window.

scalable: you can scale the size of your window as desired.

as Video: Choose this option when the window size should get the aspect ratio of the video.

Full Screen: The video will play in a separate full-screen window. Switching between the two windows for Video and Bogart 
takes place via the Windows keyboard control.

G  16:9 as 21:9 Cinemascope: If you have activated the Cinemascope product, this will allow you to switch your 16:9 screen to 
a 21:9 presentation.

Change interface colors
  

S  The menu “Screen colors” offers many options to set up the look of the Bogart interface individually. But you also can use 
one of the delivered Color schemes as well.
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“color to change” allows to adjust the colors of the background, gadgets, text and the mouse pointer with the three sliders for 
hue, brightness and saturation.
“Structure” gives you the option to choose a texture for the background.

Note: Please pay attention in the color definition of the text, so that it keeps always readable, even when pressing a 
button or selecting an item in a list.

 
Selecting a color scheme or clicking the button  all settings are set to default.

Edit visible position and size
Some TV sets cutting the left, right, top or bottom edges of the image by a so-called. „Passepartout“. In order to view all switch-
es and image areas when in full-screen mode, you can set the position and size of the working window by clicking on „Position“ 
and „Size“ (top left is „0.0“).

Video-Colorboost
The „Video-Colorboost“ is used to increase the color of the scenes when working with Bogart. This gives you more vibrant colors 
when play back and editing scenes, but also the images in the scene bin and storyboard will be affected.

Note: The “Video-Colorboost” will only affect the display on your screen, but not the exported scenes. When working in 
dual-monitor mode you can choose whether you want to boost the color for window 1, window 2 or both.

4.1.5 Recording, playback

S  G  This menu has several settings for recording and playing.

Record

Cut recognition: Gives HDV videographers the ability to recognize cut points 
automatically, even if the HDV signal was converted in the camera and sent to 
Bogart SE as a DV signal. The default setting of the software is “Automatic”. It at-
tempts to recognize the best setting by itself. If the automatic split using the start 

code is not possible, the system is able to search for cut points via the “clock time”. It is essential to switch to this mode before 
transferring the footage to Bogart SE. Depending on the camcorder you use, the required method and editing accuracy can vary.

Playback

A/V asynchronity: This controls the adjustment of the synchronisation between image and sound. This setting only influences 
the display of footage with the device. It has no effect when burning to DVD or Blu-ray. It can be necessary to use this setting 
to adjust the time difference between the sound and the image when you play the sound on another device than the image (for 
example via a monitor and a separate amplifier). Many monitors need a short time to display the video. In case you are listening 
to the sound via headphones or a sound system, this can lead to a minimal, but irritating timing difference. In order to adjust the 
timing difference during play back, you should do the following:
•  In case your sound comes before the image, e.g. in case the sound of a closing door can be heard before you see it, you 

should move the slider to the right (positive direction)
•  If, on the contrary, you see the image before you hear the corresponding sound, you should compensate by moving the slider 

to the left (negative direction)

Play mode: Depending on your hard- and software-configuration the setting of the Play mode might occur to different results.
By default “Auto” delivers the best results and allows smooth playback of your footage. If you are not satisfied with the result of 
your playback you can either switch to “Simple” or “Standard” mode. Please keep in mind that the playback quality of your video 
depends on many factors like the setting of your PC and monitor/TV.
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4.1.6  Effects, Rendering

S  G  Only with the Gold Edition the full functionality is availablefor this menu. This 
menu contains settings for the display of effect lists and effect rendering..

G  Cover Border: This function can be activated by placing a mark next to it. This 
creates a black border around the edges of the screen, covering any unwanted 
disturbances during play back. Please note that the affected border is so thin that it 
is normally not visible on a normal TV set. This function will only become visible when 
displayed on an HDTV screen or projector.

Set Border: This sets the size of the border area. With the sliders you can adjust the border approxi-
mately 100 pixel for left, right, top and bottom. Activating “Original size” will reset to the default 
settings.

Sound after creation: This setting is used to set up a sound after a render-
ing process. This is to let you know that the process has ended. The render-
ing time after which the sound signal has to be played can be set here. This 
function is useful when you want to do something else during longer render-
ing times, but still do not want to miss the end of the rendering process.

G  Should you not want to hear a sound signal, you should change “When” to “never”. Use “when” to set the minimum rendering 
time after which a sound signal should be played.
The duration of the sound signal can be set with “Max. Duration per sound”. Should you choose a sound that is shorter than the 
set duration, it will be played shorter as well. It is possible to set a repeat to indicate how often the signal should be repeated. It 
is also possible to set the sound itself. Either the system default sound is used or you can choose a sound from the audio jingles.

G  Edit favorites: This setting is used to define your personal favorits for effects. Those effects are accessible much faster in the 
Bogart effect menus.
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On the right side of the menu you choose the desired effect menu 
i.e. “Transition effects” or “Title effects”. All effects of a choosen 
category are shown on the left side of the menu. You now can acti-
vate your most favorite effects by placing a mark in front of the 
desired effect name.
With the selection button below the effect list you can choose 
whether you want to show all effects, the default effects or effects 
of a particular product.
Your favourite effects are shown in effect lists separately when 
clicking the button “Fav.”.
Clicking “Clear selections on this list” will deactivate all effects of 
the current effect category. To deactivate the effects of all catego-
ries click “Clear selection on all lists”.

Reset often used effects: Additionally to the manually created favorits for effects, Bogart 8 also automatically collects all effects 
you often use. Those effects are shown in effect lists separately when clicking the button “LRU”. You can reset the list by clicking 
“Reset often used effects”.

G  Smart Rendering: This can be used to activate the background rendering of the effects.
Just checkmark the box (next to “Smart Rendering”) to do this. Click on it again to deactivate the background rendering func-
tion. When you activate the ‘Smart Rendering’ function, most effects are rendered in the background. In the meantime, you can 
continue working in other menus. Several renderings can be started that will be completed one after another, while you continue 
to work.

The function ”Abort rendering” is used to abort the current and waiting renderings. Below this, you can see the number of effects 
and their total time.

In addition, you can decide how the current effect is to be rendered. For the “last inserted” effect, you can choose between 
“first” and “last”. Confirm your settings and close the window with “OK”.

You can also access the “Smart Rendering” menu from the effect screen by pressing the “SR” symbol in 
the top right corner of the effect menu. The three dots under the SR symbol are shown when Smart Rendering is active. While 
rendering in the background, you will see a small blinking “fx” symbol.

4.1.7  Archive

G  The “Backup/Restore Archives” function allows you to store saved data archives (colors, title 
texts, audio-effect combinations) to a separate medium and later restore back into the system. 
This way, you can access your archives data after a full re-installation, or you can transfer data to 
a second unit. Click onto the “Backup/Restore Archives” button and a window will appear. This 
allows you to choose between “Backup” and “Restore”.
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Click on the button “Backup” to select the destinated folder on your hard disk or USB stick. Enter a name for your archive and 
click “Save”.

Click on the button “Restore” to load an earlier saved archive. 
Choose the desired file from your hard disk or USB stick and click 
“Load”.

Information field: At the bottom left of the menu, there is an information field with the program version number and the Bogart 
serial number. Click on the information field to bring up additional system information.

Menu symbol: Clicking on the menu symbol returns you to the Main menu. Clicking the right trackball button does the same.

4.2  Project Settings

In the menu “Project Settings” you make the settings for your current or next project. This affects, for example, the project name, 
image size, and other project relevant settings. 

The button “Select” (Hard-drive)” only appears 
when the optional software “Disk-Juggler” is 
activated. This allows to create projects also on 
any external hard drive.

S  G  Name: On the top edge (of the “Hard-drive” section) you see the “Name” button. Clicking on the name-field brings up the 
on-screen keyboard with which you can enter the desired name for the hard drive. This has no effect on the name shown in the 
Windows Explorer.

Note: Although Windows systems support special characters please avoid characters like „ /) § * #!“.

Used Capacity: Gives information on the space used on the hard drive (in dark), and on the total remaining time (in light). A 
display for individual projects is not possible because this display refers to the entire hard drive. Audio and video are pooled 
together here. They “dynamically” divide the area among themselves.
The percentage value also takes into account the usage by the rest of the system.

Select (project): Clicking on the “Select” button brings up the Select Project menu, in which you can select several (up to 30) 
different projects. If some projects already contain scenes, the corresponding projects are marked to the right of the project 
name (with a little dot).
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After you click on “OK”, the project you have 
selected is displayed next to the selection button 
(e.g. “P 1”). If you want to rename the project, click 
on “P 1” (or “P 2”, etc .). The on-screen keyboard 
appears so that you can enter another project 
name. The chosen project name is also displayed 
in the edit screen above the scene bin.
Only the currently active project can be edited. Ex-
changing video data between different projects is 
possible using the Clipboard or Media Pool feature 
in the Edit screen (Please refer to Chapter 4.4,  
item (20)).

S  G  Image: Under “Image” you have the choice among Small, Normal, Large and Complete. We advise to set this to “Com-
plete” for use with modern HDTV screens. The image size can be changed at anytime in the current project. It takes effect only 
when applying to the calculation of effects and titles.

Format: The “Format” button provides different settings. The settings that are made here should be adapted to the footage that 
is being used.

  

Video Format: Here you can set the refresh rate for your project. Manly there are two different TV standards: PAL and NTSC. 
PAL uses a refresh rate of 50 Hz and NTSC of 60 Hz. This setting must be set before using a project and it should match with 
your footage (please check the settings of your camcorder if you are not sure). Mixing PAL and NTSC footage is not advisable 
and might occur into stuttering play back of some scenes. In addition, you can choose the typical „Film“ mode with 24 Hz.

S  G  Resolution: This setting allows you to set the basic property of your project. This setting will usually be in accordance with 
your video footage. This selection will only be available in projects that are not yet in use. Once you have selected a format and 
you have started editing, it is not possible to revert back to another format for that project. However, it is possible to import any 
footage in the current project. This footage will then be scaled to fit the resolution of the project.
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Image size Pixels Aspect ratio When used
UHD 4096x2160 8.847.360 16:9 This resolution is commonly used by Ultra HD- (4K-) cameras.
UHD 3840x2160 8.294.400 16:9 This resolution is commonly used by Ultra HD- (4K-) cameras.
HD 1920x1080 2.073.600 16:9 This resolution is commonly used by AVCHD cameras, compliant with HDTV standard.
HD 1440x1080 1.555.200 16:9 Is usually i=interlaced, and is the standard resolution of HDV cameras. Many cameras can 

also be switched to p=progressive.
HD 1280x720 921.600 16:9 There are a few cameras that support only this resolution and that mostly record in p mode.
SD PAL 720x576 414.720 4:3, 16:9 Analog and DV quality of imported PAL material.
SD NTSC 720x480 345.600 4:3, 16:9 Analog and DV quality of imported NTSC material.
i: Interlaced, this means that the image has been recorded or is being displayed with half images.
p: Progressive, this means that the image has been recorded or is being displayed with full (complete) images.

  

S  G  Aspect: This is where you indicate whether your project should have an aspect ratio of 4:3 or 16:9. If you have activated 
the software option “Cinemascope” you additionally have the option 21:9.

Mixing footage with different aspect ratios might occur in deformation of some scenes. If you want to use 4.3 scenes in a 16:9 
project we recommend the optional software “Aspector”.

Interlace: Cameras which support the “Progressive” function only work with 30 frames (PAL: 25) instead of 60 fields (PAL: 50) or 
half images (interlace) per second. If you activate one of the Progressive formats, a warning is displayed saying that you should 
only use this setting in combination with a Progressive Scan camera. Otherwise you could limit the use of effects.

If you have chosen a progressive format for your project, the system will edit with a progressive (full frame) display.

Clicking “Ok” brings you back to the menu “Project Settings” where you can see your format settings beside the button  
“Format”.

S  G  Copy: This enables you to copy individual projects. There are several ways to make use of such a copy:
• Save the current version of your film, in order to try something without risking losing it.
• Create several different versions of a movie, for example a short one and a long one.
•  Save a “Start project” to start all new projects with. This way, your opening and closing credits, or your favorite background 

music will always be available.

Note: It is not possible to use the “Copy project” function to combine two projects.

To copy a project, you should select the project you want to copy in the Project menu under “Project”, “Select”. This project 
should not be empty. You can now choose what parts of the project must be included in the copy:
• Storyboard
• Scene bin
• Samples
It can be useful not to copy the storyboard if you want to create another version on the basis of the same material. In order to 
create a direct copy, all checkmarks must be set. Now you can select the destination project. Only empty projects can be cho-
sen here.

Note: You must have at least one empty project in order to be able to copy a project.

It usually doesn’t take more than a few seconds to copy a project.
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Delete: Clicking on “Delete” (in the Project area) opens a window which offers the possibility to determine which areas of the 
selected project can be deleted. You have three options: “Delete Storyboard”, “Delete scenes” and “Delete samples”. It is pos-
sible to select two or even all three options at the same time. A click on the box next to the option activates or deactivates that 
particular function.
If you choose all options, all data (video and audio, and all effects) within the currently active project are deleted. All project set-
tings can now be reset. Project settings are fixed only after video recording or creation has begun.

The following are not deleted:
• Other edited projects
• Archived colors and titles
• Effect modules, including those that have been installed later
• Installed fonts
• Other supplementary programs

If you choose only one function, merely this part of the project will be deleted.

Information: The “Information” button gives information on project name, sto-
ryboard length, scenes and effects inserted into the storyboard, and on the total 
number of existing scenes and samples.

G  Save AV-Data: This is to export the “Storyboard”, “Scene bin” and Audio” to exchange the data with other systems. Click 
on the box behind the three options to choose the desired data for the export. Clicking on “Ok” opens the WIndows Open/Save 
dialog box where you can choose the destination and file name. Click “Save” to start the export.

Read AV-Data: This is to import data again that were saved on your or another machine.

Note: “Save AV-Data” and “Read AV-Data” will not transcode the internal Bogart project data. That means saving and 
reading AV-Data is lossless and usually very fast (depending on your disk or USB stick. Inserts, effects or audio mix will not 

be saved.

This menu symbol returns you to the Main menu, the same as clicking the right trackball button.

4.3  Recording and Import

4.3.1  The recording menu

S  G  The recording function for DV /HDV footage is available when your system is equipped with a FireWire port and Silver or 
Gold Edition is active.
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It is possible to record and edit DV- and HDV-footage within a project. Additionally you can import AVCHD-footage in the same 
project by clicking “Import”. You also can record DV footage into your HD project. In both cases the footage is automatically 
converted to the current project setting. When importing via Firewire, the format will automatically be recognized and displayed 
during the recording (SD / HD). If the format is displayed in a yellow font, it is not compatible with the project and will be convert-
ed during the recording. You should pay particular attention to the format display, in case you occasionally change the HD->SD 
conversion (iLink conversion) of an HDV camcorder.

This button is used to start recording once a video signal is available. Please note that, when HD/SD signals are being 
recorded, a video monitoring picture may not be displayed, depending on the monitor settings. For HD signals there will 

only be a preview in the middle at the bottom. This preview will not be in full size and at the full frequency. Recording non-HD 
footage however, is shown in a full-size/frame-rate preview. 
Monitoring during the recording is performed as a so-called tape monitoring. That means you see the footage like it is stored on 
the hard drive. For that reason it might take a few seconds until the video image is displayed. During this time you can see an “L” 
before the recording time. As soon as the video is displayed on the monitor you can see “P” before the recording time, meaning 
the “tape monitor” is active.
While recording, a click on the trackball right button has the same effect as pressing the stop button in the small display. By 
alternately clicking on the left and the right trackball buttons, while the pointer is located over the recording symbol, it becomes 
possible to separate desired footage from undesired footage, while recording is taking place. If you want to divide up your re-
corded video material, you should proceed to the Edit screen when your recording is finished. You can find more information in 
section “4.7 Editing” under “splitting”.

When a new scene is recorded, the system will automatically name it (S1, S2 etc.). Its name is displayed below the record but-
ton. Clicking on the name brings up the keyboard which allows you to give scenes the name you choose.

Rest: The field Rem. shows you how much time remains, meaning how much video can still be recorded. This amount is an es-
timate. This is especially the case for longer recordings or for HD footage, because the system calculates the remaining time on 
the basis of the level of detail of the footage already recorded. The value is not recalculated until the current recording is finished. 
If the quality settings change, the actual space may be slightly more or less than this estimate.

 Just like the video settings, this menu is superimposed over the video. You can see the video during recording and thus 
always decide whether you want to digitize a sequence or not. The symbol at the bottom left with the two triangles moves 

the panel to the top edge of the screen. This is useful if the panel happens to be covering important parts of your material. 

 G  ”DV control” is done with these five buttons. You can directly control the connected DV device 
through the i-Link interface. You should be aware that most devices are compatible, but some are 

not. If this is the case, the DV/HDV device can be started manually and should then input correctly. Seen from left to right, the 
buttons are used to: stop the recorder, play, pause, rewind, and fast forward. Rewind and fast forward have three different 
effects. Fast rewind and fast forward are achieved while the DV source is in stop mode, viewable slow rewind and slow forward 
in play back mode, and frame-by-frame backward and forward in pause mode. 

 The three menu symbols bring you directly to the Edit, Record/Edit and to the Main menu screens.
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4.3.2  The import menu

Click on the button “Import” will open the 
Import menu.

On the top left your current project settings are 
displayed.

The first step is to select the files for the import by clicking “Choose File(s)”. After 
selecting one or more files, the system indicates whether the selected scenes match 
the resolution of the project.

Click “Start Import” below the preview window to start the import of your scenes. During the import a preview of the footage is 
shown. If the format of your footage does not match your project settings (which is indicated by the yellow message “Format 
mismatch, automatic adaptation”, additional information are shown in the preview window (i.e. “slow scaling required, frame rate 
conversion”).

NEU!

For the import and treatment of 360º video footage, you will find more detailed information in the Chapter “Export menu” 
(chap. 4.9).

Click on the button “Import-Settings” if you want to automatically shorten the IN 
and OUT points of your scenes. Additionally you can set the scene lenght for 
pictures.

The maximum values are 2 seconds for the reduction of the IN and OUT points 
and 30 seconds for the length of the scenes created from Photos.

The Import menu offers further options: on the one hand you can “combine files to one scene”. One the other hand you can 
activate the “Expert Menu” G .

The “Expert” menu allows to do adjustments if 
you are not completely satisfied with your 
footage.

With “adjust aspect” you have various options 
to match the aspect of your footage to the 
project settings: “black borders”, “no borders”, 
“centered” and “distort”.
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After selecting one of the options, the corresponding result is 
displayed in the preview window.

You also can „adjust (the) frame rate“. If you want to keep the frame rate of your original footage this is only possible „without 
sound“.

You can activate the “Deinterlacer” (which is “off” by default) 
if a comb effect is shown in your footage. You also can set 
the “Deinterlacer” to “auto” if you are not sure.

Clicking the button “AV correction” opens a 
sub menu that gives you different settings for 
the correction of your footage before the 
import. All changes are shown in the preview 
window.

You can adjust “Brightness”, “Contrast”, 
“Saturation” and “Gamma”. Additionally you 
can adjust the “Volume” of the audio as well 
(-20 to +20db).

Click the button “reset to Defaults” to reset your settings to default.



36

Chapter 4

Confirm your settings with “OK” or click “Cancel” to leave the 
menu without any changes. Your settings for brightness, 
contrast, saturation and gamma are now displayed beside the 
button “AV correction”.

Activate the checkbox “use format archives” if you want to use the same settings for brightness, contrast, saturation and gamma 
next time when importing footage of the the same type. This is useful if you have a batch of scenes you want to import with the 
same settings.

The “Expert” menu offers also the possibility to rotate your footage. Therefore“Rotate” offers the angles +90°, -90° and 180°. 
This option is useful when your shootings are in portrait format. In combination with the optional software “Aspector” you will get 
best results for such scenes which usually have wide black borders on the left and right side. You also can try the options for 
“adjust aspect”.

Click this button (bottom right of the preview window) for a full size preview during the import. 

4.3.2.1  Photo Import

The “Import” menu allows also to import photos which can be found in the scene bin as freezed frames in the same resolution 
as your project. The original resolution is stored as well, which is usefull using the zoom effect i.e. The image quality of a zoom 
effect depends on the resolution of your original photo and the zoom factor.

4.4  Editing

This screen is used for most of your editing work, and for sequencing of trimmed scenes. This is the most important menu.
The view of the scene bin can also be modified or defined in the menu under “Settings” -> “Storyboard, Timeline”. The menu can 
be displayed in different ways. The display depends on the screen resolution and also depends on whether you are using the 
Timeline or the Storyboard modes. All buttons described here are present in both view types.

(1) The Storyboard is displayed in the top third/quarter/fifth (depending on your screen resolution) of the Edit menu. This is a tool 
that has been used since movies were invented. The idea is to clearly lay out all the scenes of a production in order to more eas-
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ily implement editing principles. A single frame, (the first pictures of a scene), are used as symbols (“thumbnails”) to represent the 
scene. A glimpse at the storyboard allows you to grasp the whole story without having to review all of the material.
Scenes are selected from the scene bin (surrounded by a dashed line) and put into order on the storyboard, located in the upper 
section of the screen. In the storyboard the selected scene is in the center. The selected scene length (duration) is displayed 
above the scene to highlight it. Scenes are added to the storyboard from the scene bin. The selected scene in the scene bin is 
added to the storyboard by clicking the “Add” button. The added scene always appears after the currently selected scene in the 
storyboard. There is one exception. When the very first scene is the current scene in the storyboard, the user is asked by the 
system whether the scene to add should be put In front or behind the first scene. Clicking on a scene in the storyboard causes 
it to be moved to the center (often referred to as the “selected” or “active” scene). Depending on the chosen resolution, at least 
seven complete scenes will fit into a visible part of the Storyboard. But there is no limit to the number of scenes that may actually 
be present on the storyboard. The storyboard can be scrolled to the left or right. The starting point is to the left, and scenes are 
played sequentially from left to right.

To scroll up or down in the scene bin, you can use the scrollbar on the right or the arrow buttons below (9). It is even faster when 
you move through the scene bin using the left/right/up/down arrow keys (cursor) on a Power Key keyboard.

Go with the mouse pointer to a scene in the bin or the storyboard and let it stay there for a 
second. Information will be displayed with respect to this scene or the effect that has been 
applied to it. In the storyboard, you will see the name of the scene and its length, in the 
scene bin you will also see if the scene has been shortened (and the shortened and original 
length) and if it has already been used.

Note: This function assumes that the option “Display bubble help” has been activated in the settings. Otherwise, nothing 
is displayed.

If you click with the small right trackball button on a scene, you will get a context 
menu that allows fast access to several actions. This will greatly reduce your work 
when you have a high screen resolution because the long mouse movements 
necessary to trim or display a scene in the bin will no longer be necessary. The 
functionality included in the menu is also available via buttons or options of the edit 
menu.
The menu allows you to play, trim or delete the scene. You can also mark the scene 
or put the pointer on top of it and open its action menu for the markings. The scene 
can also be renamed, be assigned to a group, stored in the clipboard and its scene 
information can be accessed.

The Storyboard can also be displayed as a ‘Timeline’. For this, you require a high screen resolution. To use the Timeline display, 
you must activate it in the System Settings. Until now, you have been using a Storyboard style editing suite, which sorts the 
scenes in order of play back. These scenes are tagged with symbols representing the effects. This (particularly for beginners) 
very effective method can be further optimized by also making use of a Timeline display (especially for more professional use).
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G  The Timeline

You can make use of the Timeline display as opposed to the Storyboard method. This is often preferred by many professional 
video editors. In the Storyboard, all added scenes are shown as a sequence of pictures, each representing a specific scene. Ef-
fects, inserts and titles are also shown as pictures in the Storyboard. This allows for a very clean and uncluttered display of the 
sequence of scenes and effects used. Important information such as the length of the scene in relation to the entire Storyboard 
can not be seen right away however.

When viewing the project as a Timeline, you instead see scenes and effects as bars positioned on a time axis. The length of the 
bars is shown in proportion to the length of the entire project. In addition, you can compare scene lengths directly with each 
other.
Effects and inserts are also shown as bars in the Timeline. In order to improve the overview, they are shown as separate bars – 
or tracks as we’ll call them. Apart from the video track, there’s a track for inserts, image processing effects, titles and transitions. 
Above the tracks, there is a time scale to help you keep track of the time position for the scenes and effects. The Timeline is the 
central element for your video editing work.

You can activate the Timeline via System “Settings” -> “Storyboard, Timeline” -> “Mode”. Depending on the settings you make, 
the system switches between the Storyboard and Timeline display mode.
This menu can also be used to access even more settings to adjust the scene bin and the storyboard. The Timeline is shown in 
the same way in the edit menu, as well as the effect menu. The audio menu additionally shows the audio tracks.
The top part of the screen contains the Timeline, which is divided into different parts. The view depends on the settings you have 
made for the Timeline. The top of the screens holds the time scale for reading the time and position of scenes in the project. You 
can change the time display type via System “Settings” -> “User Interface” -> “Timecode display”. Below the time scale, you’ll 
find the video track. All scenes are shown as a sequence of bars or tracks, which can be zoomed at varying factors. One option 
is to zoom so that the first and last frame of a scene are seen on the ends of the bar. The scene name is shown in the middle. If 
the bar is too short to show all elements, only the start frame is shown. If you zoom out even further, only the scene name will be 
displayed. Each scene is separated by a vertical yellow line, representing the beginning of a new scene. The active scene is high-
lighted by a different color and is not, unlike the Storyboard mode, positioned in the middle of the screen. In addition, the active 
scene (or the active insert part) sports a bright line at the bottom.
If you position an insert over a scene, you’ll find the insert scene in the insert track, just below the video track. It is positioned 
correctly below the background scene. The elements found in this track can also display frame pictures or just text, depending 
on your settings. Below the insert track is the effect track for image processing and title effects. The effects are also precisely 
positioned in the timeline, on the basis of time and their relation to the scenes. Just as scenes, effects are shown as stripes, with 
a corresponding effect symbol in them.
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Transitions can be positioned on the lowest track, they are shown in a way which is similar to image processing effects. The 
display method is the same as used for image processing effects. As soon as you insert a transition, the video track display will 
change. Two consecutive scenes will be placed ‘over each other’. The overlapping area will be shown as having its own field, at 
the same length as the transition. The field contains a diagonal yellow line. In addition, depending on the setup, two smaller im-
ages representing the first and last frame of the area may be shown.

To the right of the Timeline, you can see a larger version of first frame of the currently used 
scene. Directly below the image, the scene name and the scene length. Below this, there are  
various settings for “Range” and “Zoom” to help you define the  best possible overview for 
the Timeline part you are working on.

Zoom +: Zoom into the Timeline display to improve visibility of  short clips and effects. Each click doubles the zoom area. The 
time scale carries information about the currently displayed area in seconds (s) or minutes (m).

Zoom -: Zoom out of the Timeline to improve the overall overview of the project. If you are using long scenes, a smaller Timeline 
view may be more appropriate. Each click makes the view half as small.

O: This button switches the view to 20 scenes wide, but at a maximum of 10 minutes length of your project. The current scene is 
shown in the middle.

Range: This function is used to set an area length for displaying the Timeline in seconds or minutes. The time scale then switch-
es to the value you are using. To set the value, click into the number field for “Range” and use the keyboard to enter a number.
s: for a range in seconds (1-60)
m: for a range in minutes (only complete minutes)
If you enter a number without a letter, the number will be set up in seconds per default. 

 This button adjusts the presentation to the length of the current scene. 

 This button adjusts the presentation to the length of the current audio sample.

Also in the effect menus the Timeline is displayed in the same way as described above. The audio mix screen displays the audio 
tracks below the Timeline.
In this area, you will also find a play button and a stop button, as well as a counter. This specific play button starts playing your 
storyboard in a small preview window in the top right area of the screen. This window can be seen in your storyboard while the 
counter to its left indicates the point in time of the play back. Play back is stopped with the stop button. There is no pause  
function.

Play back always starts with the first scene of the current Timeline view, not with the currently active scene. A vertical bar in the 
Timeline indicates the current position during play back. When play back goes beyond the visible part of the Timeline, it will scroll 
further in order to remain current. The scene currently displayed is highlighted. Should you stop the play back, the scene last 
displayed will remain active.
The Timeline offers a very fast method for switching over to an effect menu. If you want to change or delete an effect in the Time-
line, click onto it directly in the Timeline itself. You will then be transported to the respective effect menu with the options for the 
effect you have selected. Activating an effect in the Timeline also activates and highlights (with color) the corresponding scene. 
The scene will also be marked by a bright line that highlights the relation between the effect and the scene. This is particularly 
useful when working with inserts. If you are working with an insert in the Storyboard and wish to apply a transition to it, the line 
will help you to see if the effect will be positioned at the beginning of the insert (Storyboard scene during insert sports a low 
line) or at the end (the scene has a line). If this part of the scene is brightly underlined, the transition will be placed between the 
marked and subsequent scene.
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Using the timeline to edit audio
In the audio mix, the Timeline is constructed in the same way as in the other menus. Additionally, the audio tracks are being 
displayed.
The top audio track is the original sound belonging to the scene above it. If there is a transition effect between two scenes, the 
crossfade will also be applied to the corresponding original sound, by means of a diagonally divided range. Positioning and 
manipulating audio in the Timeline menu is generally similar to the well-known Storyboard view. Across the entire area, the audio 
tracks show status bars, giving you information (via its color) about the audio below. If the audio is rendered, and the volume 
levels are adjusted correctly, it will be shown in blue. If the audio is overmodulated, it is red. Finally, unrendered audio is shown 
in yellow.
At the bottom left of the menu, there is button to switch the view. This makes it possible to quickly switch between Timeline and 
Storyboard View.

Setting up the Timeline
Setting up the Timeline is described in Chapter 4.1.3 (System settings).

(2) To scroll through the Storyboard, click on the slider below the Storyboard and roll the trackball to the right or to the left.

(3) The buttons “<” and “>” next to the slider can be used to move from one scene to the next in the storyboard, one scene at  
a time.
(4) The buttons “|<” and “>|” take you to the beginning or end of the storyboard.

(5) You can use the Play button to the right of the slider to play the storyboard, beginning with the selected scene until the end of 
the storyboard (or until you stop playing either by pressing the Stop button which is now visible, or by clicking the right track-
ball button.) In addition to a representation of a scene or the Storyboard, sound modulation is also shown. This way, you have a 
means of assessing the sound mix.
When the Storyboard is played, a window can be displayed with information relevant to the scene that is being played. The refer-
ence image from the storyboard and the name of the scene are being displayed.
n addition, you have the ability to stop playing at the scene that is being displayed, regardless of where play back was started. 
This information window is quite large. It should therefore only be opened for information purposes and should not usually 
remain open when everything is being played. If you use your system in dual-monitor (dual window) mode, this information will 
automatically be displayed in the playback window on your monitor.
Note that the displays quality may be lower than the actual output, depending on the screen-mode used. You also have a pause 
button which you can use to stop play back until you press the pause button again (or press the play button). The last frame ap-
pearing before the pause button was pressed remains as a single picture on the monitor until playback is resumed.
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(6) Click on the button “i” to display information about the Storyboard. You’ll see 
the project name, the current position of the Storyboard (the time is displayed), 
the length of the whole Storyboard and the remaining length (after the current 
position).

(7) This button starts the Storyboard rendering process. All effects found in the Storyboard are rendered, as well 
as the audio. It allows you to render the complete Storyboard in one go (if you want to avoid seeing  

unrendered parts).

(8) Recorded scenes appear automatically in the Scene bin in the lower section of the screen. They are represented as small 
thumbnails (the first frame of the video scene). Depending on your screen settings the number of scenes that can be viewed 
simultaneously in the scene bin may vary. Use the slider (item (9)) to scroll to the desired scene. The edit menu display resolu-
tion depends on the monitor mode used and your settings in “Storyboard, Timeline”. Scenes from the scene bin that have been 
inserted into the storyboard are indicated by a small white triangle in the upper right corner of the scene. Additionally a scene in 
the scene bin can be tagged with various symbols:

‚>‘ = The scene is trimmed in the IN area
‚<‘ = The scene is trimmed in the OUT area
‚x‘ = The scene is rendered, is an empty scene, has been imported or contains rendered parts
‚+‘ = The scene is an imported picture
‚^‘ = The scene is also used in the Storyboard
‚n‘ = The scene is marked
‚p‘ = This is the current scene
In the scene bin (right), you can see the project name you have chosen, the project number and information to the project set-
tings. When using a higher resolution, you will see a larger view of the currently selected scene on the right side.

(9) The slider below (right) the scene bin is used to select the scenes to be displayed. The buttons next to the slider can also be 
used to move through the Scene bin one scene at a time. The buttons “|<” and “>|” are used to jump to the beginning or the end 
of the scene bin. The “<” and “>” buttons will move through the scene bin one scene at a time.

(10) IThe play back button is to the right of the Storyboard slider. This button is used to play back the active scene displayed in 
the center of the scene bin. Stop and pause buttons are also available.

S  G  (11) Clicking on the “i” button displays a window showing information about the activated scene in the scene bin. In the 
upper part of this window you’ll see the timecode, the recording date, the recording time and the format. Further, you can call up 
the keyboard by clicking on “Enter/change comment” in order to add your notes to this scene, which then will be displayed in the 
lower box. The original path of the imported scene is shown here as well. Clicking on “OK” confirms the notes, so that it will be 
displayed in this information window when it is called up again.

(12) In case you have not yet renamed the scenes in the Record screen, you again have the chance here to give the scenes your 
own names. Simply select the desired scene in the scene bin and then click on the button below the large preview image on the 
right of the scene bin to bring up the on-screen keyboard.

(13) Many users require “overlapping” of certain video sequences with other scenes without changing the original audio.

Example: A music video must be created. A complete recording of the singer is available. Certain portions of this recording are 
to be substituted with other scenes, but the view of the artist singing is to reappear several times. The movement of the singer’s 
lips should always be synchronized with the music. This means that the original audio does not change, even though scenes are 
changed.

With an Insert-edit, the selected scene in the scene bin is overlaid onto the Storyboard. Only the video is overlaid, not the audio 
of the scene. Clicking on “Insert” overlays the selected scene in the Storyboard with the selected scene from the scene bin. The 
scene in the Storyboard (background) is then partially or completely covered with the insert scene (foreground). The background 
scene must, of course, be longer than the foreground scene.
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The range (start position, length) 
can be set freely and changed at 
any time, even after the Insert is 
placed. Every click on “Insert” 
leads automatically to a Range 

menu. The starting point, which is by default set to the first frame of the insert, can be moved towards the end (“Start” button). 
To do this, you have to select “Position”. Now you can see the background scene. To trim the insert-scene either from the front 
or from behind, switch the selection button to “Trim” so that you can see the “IN” and “OUT” buttons. During this setting, you 
can see the background scene. Set the selection button to “Trim E” so that you can see the insert-scene instead.

The “Trimming small” mode is used to show both foreground and background scene in smaller versions. When trimming an 
Insert scene, you’ll see the “Foreground IN” and “Foreground OUT” screens. Above, you’ll see two smaller screens depicting the 
scene frame just prior (“Backgr.IN-1”) and after (“Backgr. OUT+”) the insert. In this fashion, you have all the information about the 
insert length and the position on top of the base scene.

Using the “Position, small” mode, you will see the same layout of the menu, however, in this case you are moving the insert 
scene on top of the background scene. The preview for “Start” and “End” shows you the position of the background scene, 
where the insert begins and ends. The smaller scene images above show you the “IN” and “OUT” frames of the insert itself. 
Press play in the Insert menu to monitor how your insert has been added. Click the Play button to play your insert. The Story-
board is played from 2 seconds before to 2 seconds after the Insert. While this is being played, the original audio track of the 
Storyboard scene is also played. This gives you good control over the position of the Insert. To the right of the play button, there 
is a special play button. When you click on this play button, a split screen will be displayed.
The left image shows the background scene and the right image the Insert scene. Since the combined play back begins a little 
before the Insert scene and stops only after it, you will see the storyboard scene in both fields at this time. Play back can be 
paused, restarted and stopped at any time. When you exit the Insert positioning and return to the Edit or Main menu, your set-
tings will be saved. The so-called “background scene”, in other words the Storyboard, can be split in three parts:

1. The background scene before the insert
2. The Insert part
3. The rest of the background scene after the insert

This division allows you to place any number of insert sequences onto a single background scene. It is also not necessary to 
manually split the long recording of the singer, since this is done automatically. Inserts are indicated in the storyboard by a 
symbol (two overlapping rectangles ) in the upper part of the scene in the storyboard and can be removed at any time. Divided 
background sequences are automatically put back together. The button “Remove” offers the possibility to delete the first and 
the last part of the background scene in front of or behind the insert scene. Transition effects can also be used. The operation is 
hardly different from the usual process. One difference is that the length of the Storyboard does not change. This is important, 
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since the unchanged sound would otherwise no longer exist. Instead of a hard fade-in of the insert scene, it will – depending on 
the effect – be faded-in smoothly. Therefore, the transition is entirely at the expense of the insert scene. In the Insert menu, the 
audio envelope can be faded in and out, using the speaker symbol. You can find more details in Chapter 3.3.
Neighboring insert scenes can also be connected with transition effects. For this to be possible, the system must push the next 
insert scene forward for the duration of the transition.

(14) After you have added an insert and if the scene is still selected in the Storyboard, you can use the “Range” button to modify 
inserted scenes. These scenes can either be moved (Set the mode to “Position”, and then click “Start”.) The Insert scene can 
also be re-trimmed at the beginning or at the end (using the “IN/OUT” buttons in Trim mode). The function “Trim E” allows you to 
see the insert-scene while trimming.
For insert scenes, the user is taken to the usual Range menu. Here also you can display and hide the audio wave form with the 
loudspeaker symbols (section 3.3 “Envelope and audio scrubbing”).

If you click on the “Range” button while no insert scene is activated, you 
can reach every position of the activated scene or of the entire storyboard. 
This function is helpful if you have added a very long scene to the story-

board and want to view its middle position. You can reach the desired position by the help of the button “Position” or with the 
arrow buttons. The slider to the right shows the current position in relation to the complete Storyboard. The position can also be 
changed by clicking the play button; the stop button stops the play back. If you exit the “Range” menu by clicking on “OK”, the 
new position is confirmed and you will be taken to this Storyboard position.

NEU!
The “photo” button at the top right saves the scene image that is currently being displayed as a single image.

When the switch is selected, a Windows window opens and prompts you to specify a disk space. Here the frames are saved as 
JPG files, the filename consists of the project name, an @ and the frame number in the project. In the example above, the 3,201 
and the 3,323 image of the project were saved.

(15) Scenes are added to the storyboard from the scene bin. The selected scene in the scene bin is added to the storyboard by 
clicking the “Add” button. The added scene always appears after the currently selected scene in the storyboard.

S  G  Scenes can also added to the storyboard by „drag and drop“. Move the trackball or mouse pointer over a scene, click the 
left button of your trackball/mouse and drag it to another location in the scene bin or storyboard. Leave the left trackball/mouse 
button to drop the scene at the desired point (for better orientation a vertical yellow bar is shown). This technique allows a very 
fast workflow i.e. when rearranging scenes in the scene bin.

When dragging a scene the mouse pointer shows a red “+” symbol. When moving the mouse 
pointer directly on another scene instead between two scenes, the particular scene is surrounded 
by a yellow border.
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Leaving the left trackball/mouse button now, opens an option menu where you can 
choose to add, replace or insert the scene.

Click the left trackball button to confirm your choice.
You also can add scenes to the storyboard by double clicking on the desired scene (when 
“PC Interface” is activated in the “Settings” -> “ User Interface”).

NEU!

There is another way to insert a scene into the storyboard. Since Bogart 8, we have been able to use the preview image 
on the right side of the scene bin to trim (T). Double-clicking this preview image inserts the scene also into  

the storyboard.

The added scene always appears after the currently selected scene in the storyboard. There is one exception. When the very first 
scene is the current scene in the storyboard, the user is asked by the system whether the scene to add should be put In front or 
behind the first scene. It is also possible to cancel. If you add the scene before the first scene then you will be asked – if there 
is audio on a music track – whether the music track should be shifted backward. Answering “Yes” causes all audio tracks to be 
shifted (synchronized to the picture). “No” causes the free music tracks (by default sound tracks 3 and 4) to stay at their time 
position, and this causes them to slip under another previous scene. When the scene has been inserted, the original in the scene 
bin can be deleted or trimmed without affecting the storyboard scene.

(16) The function “Remove” deletes the scene located in the center of the storyboard. An “Insert” scene can also deleted, and 
this covers the background. If you have already created audio and this affects the scene that is to be deleted, you will receive 
a warning message. When a scene is removed from the storyboard, this scene will automatically be activated in the scene bin. 
This will enable a fast re-sort of the storyboard, since the scene that has just been removed must not be searched for to keep it 
ready for re-insertion. If you have marked multiple scenes in the storyboard, clicking the button “Remove” gives you the option to 
rmove “all marked” or the “active only”.

NEU!

With Bogart 9, you now have the ability to move scenes directly in the storyboard by “picking up” and dragging with the 
mouse/trackball. Analogous to inserting from the scene bin, you can “grab” a scene from the storyboard (you get a + 

sign, see above) and put it back elsewhere in the storyboard. This also works in non-visible areas. If you move “with the scene 
on the pointer” to the right or left side of the storyboard, the storyboard starts scrolling backward or forward. After reaching the 
destination area, you place the scene exactly and “Let it Fall”.

(17) Clicking on “Replace” causes the selected scene in the center of the storyboard to be replaced by the active scene in the 
scene bin. This can be a completely different scene, or the same scene with different In and Out points. For example, if you find 
that a scene is too long and needs shortening. If the scene makes use of effects, remember that changing the scene may result 
in a different effect length. If the new scene is shorter than the previous one, it may also affect the audio tracks below. You will 
get a text message to this effect beforehand.

Note: Trimming scenes in the Storyboard can be a lot easier with the optional Power Key keyboard and software.

(18) The “Search” button makes it possible to find the same scene in the scene bin that is currently selected in the storyboard 
(assuming it has not been deleted or renamed). After clicking on “Search” the scene in the scene bin is activated and can, for 
example, be trimmed. Finally, the scene in the storyboard can be replaced with the newly trimmed scene. If you have deleted the 
scene from the scene bin, then after you click on “Search” the message “The scene was not found. Should it be restored?” will 
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be displayed. If you then click on “Yes” and the scene will again appear in the scene bin. This function can be activated at any 
time, even after restart, after which a deleted scene cannot normally be re-created.

Note: Searching for scenes in the Storyboard can be a lot easier with the optional Power Key keyboard and software.

(19) “New” creates a scene whose duration (“Length”) can be freely set and various content that is available to you from a selec-
tion list. This is very interesting for leaders and trailers (black video), but also for certain transition effects. The length of the scene 
can be set using the slider (max. of 1 minute). Alternatively, enter the length directly. Clicking on the button “New” causes a list of 
various options to appear. On the left side of the menu all available effects are listed.

Clicking on “FAV.” or “LRU” shows additionally your favorite or 
often used effects in the list (see also chapter 4.6.1 for setting 
up your favorite effects list).

   
 

 

The following new scenes are available in the standard version: Countdown, Color bars, Color, Pattern, Black. Further effects are 
available that you can obtain either as full or demo versions from your dealer. You can select a new scene simply by clicking on it 
or by activating the slider control.

Countdown: This function creates a countdown effect. For each second, it shows a number counting backwards. The proper-
ties of the counter can be modified. You can change the font and style used. The background picture for the countdown can 
also be changed. If you want to show a background picture instead of a color or pattern, set the alpha channel value to 0%. This 
makes the selection completely translucent and allows you to select a background picture. The current project’s scene bin will 
be shown, allowing you to select a suitable image from the available scenes. If the background scene is shorter than the count-
down, the scene will repeat. If it is longer, only the necessary part will be shown.

Color bars: This scene creates a striped test image according to the standard IRE 100 (for PAL) or IRE 92.5 (for NTSC) with 
changeable duration. In professional usage, it is normal to have a colorbar test image several seconds before each video project.

Color: This option creates a one-color scene that is mainly used as background for titling. Selecting the option “Color” opens the 
color box so that you may select a color.

Pattern: After you select this button, you see the “Select pattern” button to the right. Click on this button to open a screen in 
which you can select a pattern. More details on the “Image Pool” can be found in chapter 3.3. The special effect called “Pattern” 
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applies the aspect ratio of the used pictures and patterns to the 16:9 format (in SD and HD). Activate the function “Enable distor-
tion” to stop this correction.

Black: This mode creates black video that can be used as a background for titles or combined with the transition effect Cross-
fade for fading into and out of a video.

Below the selection list you find the “Preview” button. On the right-hand side, you will be able to set the scene length to a maxi-
mum of 1 minute. To make quick settings possible, we have put frequently used scene lengths below, for direct access. Clicking 
on OK brings you back to the editing menu. The scene, named after the effect, is now available.

Clicking on the button “Full size” (if your Bogart Edition is provided with this button) brings up another menu that again displays 
the effect options in the area to the right. In the left area you see the “Frame” slider under the effect name. With this slider you 
can set the point in time in the new scene you wish to see.
Below, you can see the button “Display”. In the case of these effects, it does not hold any further options. The function is re-
quired for other effects options.
You can also shrink the panel by pressing the button above. With “OK” the settings for the effect options in this menu are ac-
cepted and you are returned to the “New scene” window. With “Cancel” you exit the “Single image” menu without having made 
any changes. The arrow button serves to move the single-image menu to the top edge of the screen.

Next to the ‘Full size’ preview, you’ll find a loop preview option. This plays a small preview of the scene with all current settings. 
You can directly change options and see the result in the animated preview.
The selection button displayed below the “Preview” button offers three settings. The function “All” shows all possible “New 
scenes”, which can be found in the system. “Default” shows the scenes, which are integrated in the system and “Optional” 
shows only the scenes, which have been installed afterwards.

(20) In the “Special” menu you find various special effects and all image processing effects.
Listing of all image processing effects under this item has a special reason: multi-layering. If you want to edit a scene with sev-
eral image processing effects then you must first activate the scene in the scene bin.



47Bogart for Windows User manual

Chapter 4

Then select the image processing effect from the list in the 
“Special” menu, (not in the image processing effects screen). 
The image processing effects listed in the “Special” menu are 
not applied to a scene in the storyboard. Instead, a copy is 
made of the active scene in the scene bin. The copy incorpo-
rates the effect, and its name is supplemented with SP, SP 2, 
etc. You can repeat this procedure at will (see also section 4.7 
Image Processing effects). The list is separated into two sec-
tions, the first of which is also divided. The top section contains 
the effects you already used, if the option has been activated in 
the extended settings. This is the favorites list. used effects. You 
can use this list for faster access to these effects. Below the line, 
you can see the regular effect list.

Some of the special effects (the ones listed in the upper part, or later in the middle part of the list) can be applied to recorded and 
possibly trimmed scenes, i.e. a copy is made with a different motion sequence than the original. The starting point is always the 
scene selected in the scene bin. Here too, there is a preview and – for some effects – the single image menu (only available with 
activated Gold Edition). Below the effect names, the effect options are on the right, and the Image button on the left, with which 
you can set the timepoint of the scene that you want to use. The button “View” provides various options.

With “Original” you can view your original scene, with “Effect” you can view your scene with the special effect applied, and “Orig. 
+ Effect” puts the original scene on the left screen half and the applied effect on the right half, so that you can directly compare 
them. “O +E center” does the same but compares the center cutout of a scene. With “O +E small” you will see the complete 
scene of both versions.

The option “Compare” divides the screen into two parts. To the right you see your new scene (with effect) and to the left a scene 
that you can freely choose from the scene bin using the button “Choose scene” positioned below. This enables, for example, an 
exact color adjustment. The effect options can be set directly in this window. You’ll even get a real-time preview without hav-
ing to confirm the selection with the slider. With “OK” the settings for the effect options in this menu are accepted and you are 
returned to the “New scene” window. With “Cancel” you exit the “Single image” menu without having made any changes.

Further on you’ll see a selection button below the “Preview” button, which offers the following functions. The function “All” 
shows all programs which are to be found in the system. “Default” shows the effects, which are integrated in the system and 
“Optional” shows only optional add-on effects, which have been installed afterwards. Additionally you can show all your favorite 
effects “Fav.” or often used effects “LRU”.
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The arrow buttons serve to move the single-image menu to the top edge of the screen.

Copy: A scene can be copied as often as desired within the edit menu without requiring additional space on the hard drive. 
Copying also requires no time. You can simply select one of the scenes by clicking on it. The outline of this scene changes to 
a dashed line. Clicking on “Copy” creates a copy immediately. The copy appears in the scene bin with the same name as the 
original, with the suffix “.K” (e.g. Vacation.K). By creating such copies, it becomes very easy for example to test several different 
scene lengths in the storyboard. Instead of inserting one scene and trim and replace it several times, you can now simply create 
several copies. You can trim these to the desired length and replace them for testing until you have found the right length. In 
case a previously used length was a better fit, this will always remain available, without new trimming. Superfluous copies can be 
deleted afterwards.

Jitter: Sometimes, a jitter or stroboscopic effect is desired. This can lead to a change of pace or give  your video an artistic note. 
Simply pick a scene, select “Special”, click on “Jitter”, then set the Still time (still time 000.00:04 = one image remains as it is for 
a length of time corresponding to four frames), and in “Type” select between “Half frame” and “Full frame”. Now you have cre-
ated a stroboscopic scene that has an extension “RU”. The option “Full Frame” has an improved picture quality and is recom-
mended for scenes with little motion. The full image option results in a better image quality and is recommended when there is 
not much movement in a scene. For scenes with considerable motion the option “Half Frame” is recommended.  
Audio is not affected by jitter and remains lip-synchronized. A preview of this effect is not possible. If you click on the “Preview” 
button, a white, crossed-out circle appears.

Backward: Clicking on the button “Backward” creates a scene with the extension “RW” which has the same length as the origi-
nal, but runs backward. The audio is also run backward. You can mute the audio in the “Audio Mix” screen if you don’t want to 
hear it. This function can be used to reverse camera movements, to lengthen a scene where it is run forward and backward.

Still scene: Frequently a still scene is required in a video. For example, when introducing actors. Bogart SE can quickly create 
such stills, without noise lines. The selected scene (with a blue frame) is simply frozen at its first frame for the length of time set 
(up to 1 minute), using the slider to the right. Any remaining part of the scene after the first frame is not used to create the still im-
age. If you want to have a specific still image that is not the first frame in the scene, then simply copy the scene and trim it down 
to where the first frame is the desired one, then apply the Still Scene function. The created scene has the extension “SC”.
Under Type you have the choice between Half Frame and Full Frame, whereby Full Frame has a better quality and is recom-
mended for scenes without too much motion. “Frame” means that Bogart SE tries to remove unwanted artifacts which occur 
during fast movements or also during quick camera pans. If the movements are not too dramatic, you will gain better results and 
a very calm still by choosing “Full Frame”. In some rare cases, it may be better to use the “Field” option. There is no audio for still 
images.

Scene -> Sample: This function copies the original audio of the active scene contained in the scene bin to the audio sample list 
of the audio menu. The new audio sample is named the same as the video scene it was created from. If you click on the “Pre-
view” button, a white, crossed-out circle appears meaning that preview is not possible.

Slow motion: “Slow motion” creates a scene that is a copy of the original but which runs more slowly. You can specify the delay 
factor with a slider. The higher the delay factor, the slower the scene. A value of 2 (the smallest possible value) creates a scene 
that runs at only half the speed of the original. If the original scene was, for example, 4 seconds long, then the scene in slow 
motion is 8 seconds long. To calculate the length of the new scene, the scene length must be multiplied with the delay factor. 
The finished scene with the extension “ZL”, can be trimmed like any other scene and placed in the storyboard. Effects can also 
be applied if needed. Bogart SE plays the scene more slowly than the normal 50 images per second. Movement can be jumpy. 
The extreme slow motion known from sports transmissions is only possible with the use of expensive special cameras that can 
film at a much higher frame rate per second. A preview of this effect is not possible. If you click on the “Preview” button, a red, 
crossed-out circle appears indicating that preview is not possible. Audio is rendered as well, but the pitch will be lower than the 
original so it sounds distorted/slower in a strange way – you might want to use that as special effect.

Quick motion: “Quick motion” works principally the same way as slow motion, but creates a new scene that runs faster than 
the original. Here you can specify a speed-up factor between 2 and 50. Uneven values are recommended in order to obtain full 
resolution. The new scene has the suffix “ZR”. You calculate the length by  dividing the time of the original scene by the speci-
fied speedup factor. Here, too, a preview of this effect is not possible. If you click on the “Preview” button a white, crossed-out 
circle appears indicating that preview is not possible. Audio is rendered as well, but the pitch will be higher than the original so it 
sounds distorted/faster in a strange way – you might want to use that as special effect.
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S  G  Clipboard: This is a function for temporary storage. Instead you might want to use the more comfortable Media Pool we 
introduced with Bogart 8 (for details refer to chapter 4.4.1). The clipboard is available in all screen resolutions, the Media Pool is 
only accessible in high screen resolutions.

Select “Clipboard” to access a selection menu. You can add scenes 
from the current project to the list or choose an item from the list to 
be added to the current storyboard. The top part of the menu shows 
a list of all scenes in the Clipboard. When you first use this function, 
the list will be empty.

These are the available functions:

add actual scene: The currently selected scene (in the scene bin) will be added to the clipboard.

add other scene: You can add any other scene from the scene bin of the current project. The window “Choose scene” will 
open - which is a larger view of your scene bin – where you can click on the desired scene.

add all selected scenes: All marked scenes (in the scene bin) will be added to the clipboard at once.

add scene from different project: You can add any scene from one of your projects. To do this, first select the right project 
and then choose from the scene bin of this project.

remove scene(s): This option is only available if you activate at least one scene in the list. All marked scenes will be deleted.

import scene(s): This option is only available if you activate at least one scene in the list. All marked (tagged) scenes will be 
imported into the current project.

Options: You can choose if trimmed parts of a scene are copied as well. You can also choose to import scenes with a different 
format, if required. You will then see the inserted scenes in the scene bin. The scenes might have new numbers if the scene or 
scene name are already present in the scene bin.

Click on the function “Remove scene” in the clipboard. This will open the “Remove scene from the clipboard” window in which 
you can select the scene you want to delete from the clipboard. Using checkmarks, it is possible to select more than one scene. 
You must then click on OK to delete the scenes.
The most important function of the clipboard is to provide a temporary storage for video scenes that you will eventually use in 
other menus. The clipboard goes beyond projects. It is, of course, also possible to use the clipboard to take video footage from 
a DV project and use it in an HD project.
In order to quickly deposit scenes in the clipboard, you can do this by means of the keyboard, if the Power Key option (add-on) 
product has been activated. Press the “b” key to insert the currently select scene in the scene bin in the clipboard, after confirm-
ing. Use the key combination “Ctrl+b” to insert the current scene and to activate the next scene in the scene bin. It is also pos-
sible to select scenes that should be included in the clipboard and then simply press “b”. You will then confirm that all selected 
scenes must be put in the clipboard. “Nav+b” directly opens the clipboard menu. 
The scenes contained in the clipboard are deleted when quitting Bogart.
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These special image processing effects (only to be found in the edit menu) are shown first in the list. The remaining effects in the 
special menu are the same as the image processing effects (the individual image processing effects are explained in  
chapter 4.7).
(21) In general, you will record scenes that have more than one camera setting (take). These scenes must usually be split up in 
order to make the video you intend. You can skip this step only if you want to keep the complete footage as is without transition 
effects.

Clicking on the “split” button brings you to the split menu: splitting can be compared to cutting a roll of film. The film is still on 
the roll. A segment of film, (the first take in the scene selected in the scene bin), is pulled out of the roll. This happens by clicking 
on “Split position”. The trackball can be used to scroll through the entire scene.

Select the last frame of the first take and click on the left trackball button. Check (and correct if necessary) with the arrow but-
tons (“<,>”) that you have hit the exact split points. The audio wave form (Chapter 3.3 “Envelope and audio scrubbing”) can help 
you. You can turn if on and off with the loudspeaker symbol. Audio “scrubbing” can help you with splitting by allowing you to 
make splits according to specific moments in the audio. Now you have isolated the first take. The segment is highlighted in light 
blue. You can play back the segment (and rename it, if desired). You must now decide whether the segment is valuable or can be 
deleted. Clicking on “Use” causes the segment to be “cut” and placed into the scene bin, where you can access it later. “Drop” 
skips the segment and moves on to set the next the split position in the scene.
Bogart SE offers a further display mode for splitting a scene, which makes it even easier to determine the correct splitting posi-
tion. Click onto the button beneath the speaker symbol to see the display of two scene images next to each other. The left scene 
is the current frame at the set split position. The right frame display the direct next frame after the split position. You can there-
fore see both options at the same time and can decide more easily which frame really ends the scene, just prior to a new scene, 
or when new content begins.

Note: In this mode, it is not possible to move the menu to the top of the screen.

Bogart SE does not delete any video material during this procedure. The individual scenes are only copied (“Use”) or not copied 
(“Drop”). The original scene with all takes (the “film roll”) remains unchanged until it is intentionally deleted in the Edit menu. After 
clicking on “Use” or “Drop” you continue to work with the rest of the roll. Another strip must be taken out and judged either as 
good (“Use”) or bad (“Drop”). The last scene is automatically displayed as “.Rest” in the scene bin. This enables you to easily 
interrupt your work and to continue later with the “.Rest”.

Note: Further splitting of “.Rest” scenes is possible, but for better clarity you should rename the scene. Atherwise you will 
get names like “00042.Rest.Rest.Rest.Rest.Rest”.
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An additional function is splitting a scene in series through the “Index” button. Click (in the 
splitting menu) on the Play button so that you see the “Index” button. While the video is 
running with audio, each time you click on the “Index” button a split position is set. Afterward 
the split segments are positioned after the original scene in the scene bin. This function 

serves to roughly split up a scene before you begin with final editing.
In addition, you can make use of the automatic splitting function if the video material has been recorded via DV/HDV/ AVCHD. 
Click on the “Auto” button to cause your footage to be automatically split. You now can decide where the divided scenes are 
to appear. You can choose from the options “Add to Storyboard” and /or “Add to Scene Bin”. The newly created scenes will 
appear directly after the currently selected scene. The video scene that you have filmed most recently is split up very quickly 
according to shot changes. (If there are no camera changes, no splits will be made.) For scenes that are a little further back, 
splitting can take some time because a new analysis is made of the scene.

(22) Scenes must generally be trimmed before they are suitable for production. Jittery and blurred images can be removed down 
to the last unsuitable frame. Clicking on “Trim” brings up the trim menu.

This is where every scene can be precisely edited. You can set a scene’s In point (start, first image) and Output (end, last image) 
anywhere you want. Clicking on “IN” displays a that enables you to scroll through the scene and set the new In point. The bright 
area shows how much of the scene is still active, the dark area to the left shows the trimmed away part. The time display top 
right of the bar shows the length of the scene. Once you have found the correct starting image, confirm by clicking on the left 
Trackball button

You proceed in the same manner with the Out point. You can carry out fine editing by using the arrow keys (below the “IN”and 
“OUT” buttons) to step through the individual frames one at a time. This takes you one image further or back. You can play the 
trimmed scene to check it by clicking on the play symbol (all the way to the right).

Note: When trimming the IN-point, the system always displays the first available even field. When trimming the OUT-point, 
the system shows the odd (later) field. When splitting, the first field is even, when positioning, it’s an odd field. This makes 

it easier to have clean edits.

G  Like in the “Split” menu you can turn on the audio wave form (Chapter 3.3 “Envelope and audio scrubbing”) by clicking the 
loudspeaker symbol.

Bogart SE offers an alternative mode for trimming, showing multiple scene positions next to each other. Press the button just 
below the speaker symbol. You will see several scene positions next to each other. Using the images for IN and OUT, you can 
immediately see the first and last frame of your trimmed scene. It begins with the IN frame and ends with the OUT frame. The 
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smaller images left and right (above) show the respective frame just before and after the trimmed area. You can easily determine 
if the scene is trimmed correctly.

Note: In this mode, it is not possible to move the menu to the top of the screen.

With the two buttons next to the time displays for the start and end images you can play the first and last 3 seconds of the 
scene. Note that segments of a scene removed by trimming can be reinstated at any time by repeated trimming. To the right and 
below you can directly activate the Edit screen and the Main menu with the menu symbols.

G  Depending on your user interface settings (more details later in this chapter) you can trim your scenes directly in the Edit 
menu. Therefore just click the “IN” or “OUT” button below the preview window right beside the scene bin. 

The bar between the “In” and “OUT” buttons always shows the trimmed part of a scene.

(23) You can delete a scene at any time. Clicking on the “Delete” button deletes the currently selected scene in the scene bin. 
If you want to delete more than one scene at once, mark the desired scenes and click “Delete”. A menu opens where you can 
choose whether you want to delete “all marked” or “active only”. Click “Cancel” you exit the menu without deleting.

(24) In case you want to retrieve deleted scenes, you can use the UnDo button (curved arrow) to be found to the right of the 
“Delete” button. With the UnDo button you can retrieve the last ten most recently deleted scenes. Deleted scenes are lost per-
manently when restarting Bogart, when switching between two projects, and when there is no more space for recording (video 
or audio). This button can be used to reinstate scenes that you deleted in the scene bin and now have removed from the story-
board.

Tip: You can use the “Delete” and UnDo functions to easily sort scenes in the scene bin. Delete the active scene, activate 
another scene, and then click on UnDo. The scene removed from the scene bin is now reinserted just after the activated 

scene. A better way to sort scenes is to use the buttons “Mark” and “Action” (more details later in this chapter).

G  (25) If you activate the “Smart Rendering” function (rendering effects in the background), you will see a small symbol “SR” 
shown in the top right corner of the screen.

If the system is currently rendering an effect, you will see “fx” followed by a small dot flashing behind the 
“SR” symbol. Rendering multiple effects in the edit menu results in an additional dot for each extra effect being rendered. In the 
System Settings, you can determine if rendering should start with the last placed effect or if the effect is to be rendered at the 
end. The rendering will be activated either with the button “Smart Rendering” in the “System settings” (see chapter 4.1.6) or by 
clicking onto this display in the upper right corner (as well as in other menus, which support inserting effects), which also opens 
the window.
After rendering was started, you can continue editing – the rendering will be done in the background. The scene with the ren-
dered special effect is automatically placed to the right next to the original scene in the scene bin.

Note: The display allows a maximum of 10 dots. If there are more than 10 effects (which have to be rendered) inserted, 
you’ll see three little dots, which means that further effects are waiting to be rendered. Some effects (i.e. “Still scene” from 

the menu “Special”) cannot rendered in the background.

S  G  (MC) Media Pool / Clipboard
With Bogart 8 we introduced the “Media Pool” which is an advanced version of the clipboard. In earlier versions of Bogart, the 
clipboard was used to exchange scenes between different projects. But the clipboard could keep its content only temporarily. 
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Quitting Bogart also deleted the complete content of the clipboard. 

With the Media Pool often used scenes, photos and audio samples are stored permanently. You can access and manage the 
content of the Media Pool from every project.

(MC) Click this button to open the “Media Pool”. The scene bin is divided into two halfs. On the left side you see the scene bin, 
on the right side you see the Media Pool. Click either into the aera of the scene bin or Media Pool to activate it. The non-active 
aera becomes slightly shaded

   

To fill the Media Pool with content, just click the desired scene in the scene bin and drag it to the Media Pool (like described on 
page 40, item (15)). If you want to use a scene from the Media Pool in your current project, click on a scene in the Media Pool 
and drag it to the scene bin. Alternative you can click this button .

Scenes and photos are stored in the Media Pool in their original resolution. Importing a scene from the Media Pool to your cur-
rent project is possible without delay when the format of the particular scene and your project are identical. Otherwise the scene 
has to be rendered to match the format of your project.

Tip: You should archive scenes in the Media Pool always in the highest available resolution. This avoids quality loss since 
the downscaling of scenes and photos always provides better results than upscaling.

(Op) There are different options to manage your scenes in the Media Pool. You can create folders and sub-folders by clicking 
“create new folder”. The folders are named automatically but you should give them appropriate names to keep track of your 
content.

Clicking “Options” opens the “Media Pool options” menu. “4:3 <=>16:9” can set to “borders” to keep the aspect ratio when 
importing a 4:3 scene into a 16:9 project. Choose “distorted” if you want to match 4:3 footage to 16:9 without black borders (but 
with deformed width).

With “transfer trimmed regions” activated the com-
plete scene including trimmed aereas will be trans-
ferred. This allows to change the IN and OUT points in 
the new project if desired.

You can activate “delete temporary scenes (yellow) at program exit” to make sure that all temporary scenes are deleted from the 
Media Pool when quitting Bogart. More details to temporary scenes can be found later in this chapter.

In the “Edit” menu you can manage scenes and photos in the Media Pool. In the “Record, Edit” menu you can do this as well 
with audio samples and clips (see chapter 4.10.1).
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When importing an audio sample from the Media Pool into the scene bin, a black scene will be created in the same resolution 
like your project.

(D) These two buttons allow you to navigate through folders. Click the lower button to open a folder or sub-folder to show its 
content. You can do this as well by double-clicking on a particular folder. The upper button brings you back one directory level.

Note: To keep track of your content you should be careful with too many sub folders. Appropriate naming of folders will 
help to find desired scenes and audio samples fast.

The functions “New” (19), “Special” (20), “Split” (21), “Trim” (22) and “Opt” (28) are not supported if the Media Pool is active.

Like in the scene bin, the functions “Delete” (23), “Undelete scene” (24) and “Play” (10) are also available for the scenes in the 
Media Pool.

Clicking on the “i” button (11) displays a window showing information about the activated scene in the Media Pool. In the upper 
part of this window you’ll see the recording date, the recording time and the format. Further, you can call up the keyboard by 
clicking on “Enter/change comment” in order to add your notes to this scene, which then will be displayed in the lower box. The 
original path of the imported scene is shown here as well. Clicking on “OK” confirms the notes, so that it will be displayed in this 
information window when it is called up again. 

Note: Clicking the “i” button with an activated audio sample or folder in the Media Pool will show current information. 
The Media Pool can keep different versions of the same scene but with different resolution and format.

(C) The Media Pool can also be used as temporarily clipboard when desired.

Clicking the button with the yellow drawer (C) will give you various options.

add element(s) from Scene Bin (temporary): will add selected scenes from the scene bin to the Media Pool. Temporary scenes 
can be identified by a yellow name. Those files are deleted when quitting Bogart.

add element(s) from another project (temporary): will open the menu “Select project”. Choose the desired project and confirm 
with “OK”. The menu “Choose scene” opens. Select your scene(s) and confirm with “OK”.
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make active/marked element(s) permanent: Choose this option if you want to keep a temporary scene permanent in the  
Media Pool.

make all temporary elements (yellow) permanent: This will keep all temporary scenes permanent in the Media Pool.

delete all temporary elements (yellow) now: This will delete all temporary elements at once.

The Media Pool is also available in the menu “Record, Edit”, more details can be found in chapter 4.10.1.

(26) Bottom right you see ten menu symbols for the following menus: Recording, Import, Edit, Transition effects, Image Process-
ing effects, Titling, Audio Record, Audio mix, Settings and Main menu. If you enter the menu via these symbols, you can exit 
using the right trackball button. This will even work if you enter several menus in succession using the symbol buttons.

(27) Underneath the scene names, you can see a field with the group name (when activated in the settings). An empty field 
means that there is no group affiliation. You can access the group info by pressing either “Opt” or the info button “i”. If you wish 
to change the group affiliation, press the text field “Group” underneath the active scene preview. This will prompt a list of avail-
able, existing groups to select from. Working with groups is described below.

(28) The ‘Opt’ button gives you further options that can be used to improve and optimize the scene arrangement in the scene 
bin.

G  Choosing reference image: In order to differentiate better between the 
various scenes, it may be necessary to change the ‘Reference frame’ which 
represents the entire scene. Even effects that are available in the scene bin 
could be easier to recognize thanks to an individual reference image. For 
example, if you apply an image processing effect to a scene and create a new 
scene from this, you could give the scene an expressive reference image. To do 
this, go to the options “Opt” and press “Choose reference frame”. You will see a 
menu that allows you to determine the image within the scene. Activate “Posi-
tion” to scroll through the scene and to select a new image.

Note: Changes the reference image of a scene has no result 
for scenes that have already been included in the Story-

board, but only on the once in the scene bin.

G  Set group name: You can group scenes in Groups and hence make them 
easier to find. For example, you can only show the scenes of a particular group. 
Activate the scene you want. The option “New” allows you to enter a new group 
name. If you want set the group name for more than one scene at once, you can 
first mark the desired scenes. When clicking “Set group name” you can choose 
between “all marked” and “active scene only”.
Once you have a large number of group names, it may be beneficial to reorder the 
groups that are being shown.  This way, you could create archives in which only 
specific group names are visible. This way you can limit the choice of groups. This 
way you have also made possible to select scenes in the group selection.
With the “Stock” button, all the existing group names of the project will be listed.
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Group selection: When you work with groups, you have several possibilities to select scenes in the bin. If you wish to show only 
selected scenes of a particular group or even several groups, press “Opt” and then “Group selection”. This next list contains all 
available groups for this project. Use the multiple selection function to choose one or more groups by placing a tick next to the 
groups. Press “OK” to show only the scenes that have been assigned to those groups. The remaining scenes are not deleted, 
merely “hidden”.

If you wish to delete the group name of a scene (un-assign), select the “---” name 
from the group list. If you wish to see all scenes, even those not assigned to any 
group, open the group selection once more and confirm by pressing “All”. You will 
now once again see all of your clips in the scene bin. Whenever you are not dis-
playing all scenes, the header of the scene bin, on the right next to “Scene bin”, 
you’ll find the text “Filter active”. Make sure to check for this if you feel that some 
scenes are “missing”.

Show already added scenes: You can even improve the organization of the 
scene bin more by hiding any scenes that you already added to the storyboard. 
Go to the options menu “Opt”. If the checkbox next to “Show already added 
scenes” is ticked, any added scenes (all scenes marked with a small white dot 
above the stamp) will be shown in the scene bin. An unticked box means that 
the function is deactivated and that already added scenes are not shown in the 
scene bin. Of course, “hiding” scenes in this fashion does not mean that they are 
deleted, but merely not shown.

Tip: If you cannot find particular scenes in the scene bin, please check first, whether you have activated “Show already 
added scenes”.

Exporting scene: The currently selected scene can be directly exported as file. Clicking this button opens the “Export” menu. 
Like described in chapter 4.5 you can choose between different modes and quality settings. When “show Expert menu” is acta-
vitad, additional options are available.

Clicking on “Export” opens the WIndows dialog box where you can choose the destination and file name. When exporting to 
an external medium, please make sure it is connected to your machine. Click “OK” to start the export. It will be stored on the 
storage medium as a file with the name of the scene. When exporting a scene, the file name cannot be changed. This file can be 
imported or played in a different area of the system. If you want to export more than one scene at once, you can first mark the 
desired scenes. When clicking “Export” you can choose between “all marked” and “active scene only”.
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Export picture to file: Lets you save a single image of a video scene as a picture. After selecting the “Export picture to file” 
button, the Windows file selection opens, in which you select the folder in which the frames are saved. If you have selected the 
folder, the currently selected scene is displayed in full screen and the Position Selection window opens. 

You can go to any position in the scene. Once you have confirmed 
with “OK”, this single frame will be stored. The “Cancel” button ends 
this menu without generating an image. The name of the image is 

created on the basis of the scene name and the image position. The picture is stored as JPEG-file and has the same resolution 
as your project.

Tip: When using the same scene in different projects and resolutions, you should always switch to the project with the 
highest resolution to get the best result when exporting a picture.

NEU!
In Bogart 9 you can set a so-called “trimming reserve” in the options window between 0 and 30 seconds. The “trimming 
reserve” is used by the system to be able to “trim” out split scenes later. If you need something more “meat” after you 

split the front or back, for example, if the O-sound should start in before the image (see Recording/Editing Chapter 4.10.1 (20)), 
you can define here how much of the length of the footage before and after the split piece is available as a trim reserve. The 
range is adjustable from 0 to 30 seconds, of course always depending on how long the original scene is. This trim reserve is set 
for the entire program. In the Audio Mix menu (kap. 4.10.2.4) you can find the same controller under “opt” ions.

G  (29) and (30) Another way to adjust your scene bin or the organization of the storyboard is using the two buttons found at the 
bottom edge of the of the screen. This is where you will find the two buttons “Mark” and “Action”. Both of these buttons are used 
in combination.  This function can be used to re-sort the scenes in your scene bin. This means that, besides the group function-
ality, you now also have the ability to sort your scenes within the listing according to your wishes. In order to do this, you have to 
select scenes in your bin which you can then copy/move to a new location of your scene bin and have them listed together. 
Press “Mark” to tag the current scene in the scene bin. The scene is tagged with a filled square. Should you want to mark spe-
cific scenes, you should select it and then click on the “Mark” button. It is also possible to use the small left mouse button if you 
are using a 4-button trackball. This is a faster way to mark scenes, since they do not have to be activated to do this. In that case, 
you should position the mouse pointer on the scene and click on the left small trackball button. The scene will then be tagged 
with a filled square. Alternatively, you can also use the Power Key function (an optional add-on product) to speed up the marking 
process.

G  Use the ‘Action’ button to open a menu to select a function for the scenes you have marked.  

The menu can also be opened by clicking on the right small 
trackball taste. Depending on the number of scenes you have 
marked, different actions are available:

• “swap scenes”: This function swaps around two scenes and is only available if you have tagged exactly two scenes.
•  “move here”: All marked scenes are moved to the position after the currently selected scene. This deletes the scenes at their 

previous scene positions.
•  “copy here”: All marked scenes are moved to the position after  the currently selected scene. This will place a copy of the 

scene in the new location. The original scene remains at its old position.
• “mark storyboard”: This marks all scenes in the Storyboard/Timeline.
•  “mark scene bin”: Marks all of the scenes in the scene bin at once. This is useful if you want to select a large number of 

scenes. Since this marks all scenes, individual scenes can then be unmarked.
• “mark Media Pool”: This marks all scenes in the Media Pool.
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• “remove all marks”: This removes all marks/tags without any further action.
•  “Cancel”: This closes the action screen without any further activity. The scene tags/marks remain.

If you have marked several scenes in the scene bin and you want to insert these in the storyboard, you should activate the scene 
after which the scenes should be inserted. When clicking “Add” you can choose between “all marked” or “active scene only”.
Select “all marked” in order to insert the scenes from the scene bin in the order in which they are listed, behind the active scene 
in the storyboard. Marked scenes can also be deleted, if you click on “Delete” after marking them. Before the scenes are deleted, 
you will be asked whether you want to delete the current scenes or the marked scenes. If you select “All marked”, the corre-
sponding scenes will be deleted. Use the “Undo” (24) button to reverse the deletion. Please note that only the last 10 deleted 
scenes can be brought back through “Undo”. Should you delete more scenes, they will be lost. Scenes cannot only be marked in 
the scene bin, but also in the storyboard. You should mark the relevant scenes in the same way as in the scene bin.
The actions will then be performed in the storyboard. Please not that if there is no activated scene in the scene bin when you 
want to apply an action in the storyboard as the action selection would be inactive in that case. Once you have tagged certain 
scenes, the marks will remain until you exit the Edit menu. Once you exit the menu, the tags/marks will disappear.

(31) Undo and Redo: Click the button “Undo” to erase your last action you made in Bogart i.e. adding a scene to 
the storyboard. The undo buffer is not limited so you can gradually erase all previous actions in Bogart. You can reverse the 
“Undo” function by clicking the button “Redo”. 

Switching between “Import”, “Recording”, “Export” or “Record, Edit” menu does not effect the undo buffer. Switching the proj-
ect, starting Arabesk or quitting Bogart will erase the undo buffer. This also applies to the function “Undelete scene” (24).

(G) Setting up the Bogart user interface (GUI)
Bogart gives you a couple of options to individualize the user interface. Setting up a high monitor resolution usually results in 
small texts and buttons which a hard to see on the screen.

Click this button  to open the menu “Change user interface (GUI)”.
In this menu you can change the size of the stamps in the storyboard and scene bin 
to “small”, “medium” and “large”.

Additionally you can activate “Smaller scene names” which might be useful when working with longer scene names. Activat-
ing “Show group” will show the group name of a scene below the preview window. You can also trim your scenes direct in the 
preview window when “Show trim” is activated.

Try different settings to see what you like best and suits your requirement for an optimal workflow.
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4.5  Export

You can export your storyboard at any time and save it as file on your internal /external hard disk drive or USB stick. Click the but-
ton “Export” to open the “Export” menu.

At the top left of the menu the length of your storyboard is displayed. If you do not want to export the complete storyboard but only 
a sub-range, click the button “Choose Range” to select the “IN” and “OUT” points. 

Effects and audio must be rendered before you can export the storyboard. The field “Rendered” indicates whether the video foot-
age, effects and audio samples are “Created” (green check mark) or still “Unrendered” (red dash). Even if all effects except one 
have been calculated, the display will show “Unrendered”.

Click the button “Overlays” if you want to add a logo or the timecode to 
your film. Therefore the “Overlays” menu offers various options.
Please note that when you decide to place a graphic or timecode to 
your film, it is not possible to choose only a range of the storyboard. 

Use graphic: When active (check mark), a graphic is rendered to the film. Bogart will use automatically the last imported graphic. Is 
no graphic available, Bogart requests to import one.

Keep aspect: If this function is activated, the aspect ratio of the used graphic remains unchanged. If “Keep aspect” is disabled, 
you are completely free in “Place graphic” in terms of position, width and height.

Import graphic: Click this button to import a graphic (format: png –True Colour) from any media (i.e: CD, DVD, USB stick).

Place graphic: Clicking this button opens a menu where you can adjust “Size” and “Position” of your graphic.

Casablanca timecode: When active (check mark), the timecode of your film is displayed. The format (mmm.ss:ff or hh:mm:ss:ff) 
depends your setup in the menu “Settings -> User Interface -> Timecode display”.

Original timecode: When active (check mark) the timecode of every single scene is displayed.

Date and Time: When active (check mark) the current date and time is displayed.
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Select font: Here you can select the desired font for the timecode.

Place timecode: Clicking this button opens a menu where you can adjust the “Position” of the timcode, date and time. In this menu 
you cannot adjust the size since this is given by the font size.

Click “Start rendering” to create the video footage with all effects, audio samples and overlays. Click the button “Play” to play back 
the rendered film.

”Options” (formerly known as “Presentation-Options”) add three options, which can be enabled and disabled at any time.

Play-Counter: This switch can be used to turn off the always visible play-counter. Nor-
mally this tiny display does not inconvenience the user. In fact it does give you a visible 
time-code and – more important – a visible stop-button. 
But sometimes it can be important to play back the storyboard with no visible overlay. It 
can be useful to play back clips during a public presentation.

Loop-Mode: Sometimes you might want to play back the entire storyboard in a loop 
again and again.

Play on startup: You can save some seconds of your time, when using this option. If active, the playback of the storyboard 
starts automatically after Bogart has been started.

The “Eject” button opens the DVD/Blu-ray tray in case you want to export the storyboard to a CD, DVD or Blu-ray.

Click the button “Mode” to choose the desired export format (AVI, MPEG-2 (TS), H.264 (TS), MP4, MTS and JPEG).

G  With activated Gold Edition and Smart-Booster you will find also hardware accelerated M2TS formats. In this case the export is 
faster than the runtime of the video.

When “Mode” is set to “JPEG”, Bogart will export single pictures without audio.

With the button “Quality” you can choose between “Low”, “Medium”, “High” and “Max” quality. With this setting you cannot only 
adjust the quality of your film but also the size of the exported file. 
In example exporting a 2.5 minute clip with a resolution of 1.920 x 1.080 pixel will create a 200 MB AVI file in low quality and a 500 
MB file in max quality.

When all settings are done click the “Export” button to export your film to the desired destination.
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G  „Expert“ menu
More export options are available when you activate “show Expert menu”.

Project settings: Shows your current project settings.

Resolution: Here you can select the desired resolution. Choose “other” to input the resolution freely into the field beside  
“Dimension”.

Aspect: Choose “keep” (default) if you are satisfied with the aspect of your project. You can change the aspect by selecting: 
“black borders”, “no borders”, “centered” or “distort”.

FPS: Here you can change the frame rate if desired.

Deinterlacer: You can activate the “Deinterlacer” (which is “off” by default) if a comb effect is shown in your footage.

NEU!
360º-Video-Export
With Bogart 9 there is the possibility to import, edit and export videos recorded with 360 º video cameras.

General to 360º video cameras: While a very expensive camcorder was needed for the production of 360º videos about 2 years 
ago, such models are already available for low budget. They can even record 360º video movies in 4k resolution. Of course there 
are also more expensive and professional camera systems, but you can now go for relatively “small money” into the “adventure 
360º-video”.

“Adventure” because the 360º video is providing astounding and seldom seen views that allow some entirely new approaches to 
video consumption.

Low-cost 360º cameras usually produce the all-round image with two lenses, each of which represents a “180º sphere”, i.e. right 
and left, up and down. With a little overlap (most cameras do not take 2 x 180º, but 2 x 206º), it is possible to put together from 
these two halves a picture that looks “all around” and at the same time “from the ceiling to the feet”. 
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Viewed as a flat, folded-out image, a 360º video looks strange, but special players allow you to literally look around while playing 
such a video, or looking up and down.

360° videos are now widely used (apartment tours, nature considerations, folk festivals) and also YouTube© offers a “360º video” 
section with corresponding player.

With Bogart we can import and edit 360º videos in full HD or UHD projects. You can cut them, add long-term effects and transition 
effects, title them and tone them up like a normal video. And in the end we can export these movies with Bogart 9 and the 360º 
export option.

For the export, the video has to be adjusted ac-
cordingly so that the corresponding players can 
recognize the 360° format.

The reason is that a 360º video must be exactly twice as wide as high. Therefore, the format resolution of, for example, 1,920 x 
1,080 pixels does not fit. Therefore, Bogart automatically adjusts the export settings if you activate “360°”.

Bogart is one of the few editing softwares that can easily edit 360º videos from recording to export!

4.6  Arabesk

Start Arabesk by pressing this button. This part of the software allows you burn projects (the current one and others) to DVD or 
Blu-ray and even add menus. Arabesk is an optional software which has its own manual. Make sure to read about the Arabesk 
functions there.
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4.7  Transition effects

When your project has been completely arranged in the Edit screen, and you are pleased with the results (but with hard cuts be-
tween the scenes), then you can apply transition effects. Transition effects are transformations from one scene to the next. The 
transition effects are always inserted between two scenes in the storyboard.
Transition effects must be calculated. Creation can be time-consuming, depending on the effect desired. For this reason it is 
possible to preview the effect in a small window. You can then “batch-render” the effects in the Finish menu.

(1) The “Transitions” screen shown above displays the storyboard you are already familiar with. But here, two scenes instead of 
one are displayed in the center. You thus see two time displays in the upper panel. You can now move the scenes meant for the 
transition to the middle. A further difference is the Play button which in this menu only plays the effect with 1 second before and 
after, and not the entire storyboard. If you have not already inserted an effect, clicking on this button plays the last 3 seconds of 
the first scene and the first 3 seconds of the second scene. This enables you to view hard cuts even between very long scenes. 
The slider and the arrow buttons are used in the same way as in the Edit menu.

(2) You can choose the desired transition effect in the effect list. Either click on the effect directly so that it is highlighted by the 
dark-gray bar, or use the slider or arrow buttons in order to move the desired effect to the correct position. If you do use the slid-
er, then after selecting the effect you must press the left trackball button so that the light-blue bar again changes to dark-blue. 
Clicking either the button “Fav.” or “LRU” will split the effects list. In the top part you will see then also your favorite or often used 
effects.

(3) After you have selected an effect that has further options, the effect options are displayed in the field to the right of the effect 
list. There you can, for example, define colors and effect directions, and other parameters specific to the individual effects.

G  (4) Realtime-Preview: After you have added an effect into the storyboard, the effect will play back in this window for one time. 
You can activate “Audio” to hear the audio as well. Additionally you can activate the Loop-Mode to play back the effect in a loop. 
You manually can play back and stop the preview with the two buttons below “Loop-Mode”.

S  G  (5) This button features different options, depending whether you have activated the Silver or Gold Edition.The selection 
button below the effect list allows you to switch the effect list to single points. The button offers at least three settings. The func-
tion “All” shows all transition effects which are to be found in the system. “Default” shows the transition effects, which are inte-
grated in the system and “Optional” only shows the transition effects which have been installed afterwards. Clicking on “FAV.” or 
“LRU” shows additionally your favorite or often used effects in the list.
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(6) Clicking on the “i” button, you’ll get information about the transition effect activated in the effect list. If it is an add-on effect, 
the window “product information” appears, which offers a description of the effect. Is the effect to be found a standard effect, 
the product information refers to the manual.

(7) Use the “Add” button to apply the selected and defined effect between the scenes in the storyboard middle. The effect 
symbol then appears between the two scenes with a red flag (must be created). The effect duration corresponds to the duration 
that was last used. This enables you to insert many effects with the same duration between different scenes. If you select an new 
transition effect although there already is one between the two scenes, then the new effect replaces the old, without you having 
to click again on “Add”. After you have added an effect you can setup the options for this particular effect (3). In many cases not 
all options are shown before you addid the effect to the storyboard (i.e. the preview).

(8) A click on the “Remove” button removes the added effect from the storyboard. If you would like to replace the current effect 
with another, then you can simply select the new effect and it automatically replaces the current effect in the storyboard. In this 
case you don’t have to click on the “Remove” button.

(9) With this button you can set the duration of the effect. This button is enabled after you have inserted an effect between two 
scenes. The duration then shown is 1 second (assuming that neither of the two scenes lasts less than 1 second). Clicking on this 
button displays a window in which you use a slider to set the time exactly.

Also provided are the durations 1/2 sec, 1 sec and 2 sec, which you can click directly, or use the 
slider to set the duration to its maximum limit – the length of the shorter of the 2 scenes used. You 
can set your own values for the three buttons with fixed transition lengths. This way, you can set 
your own transition durations for quick access.
This is how you can set a new effect length for a button. Set the desired effect length with the 
slider. Next, click on the Save button. It will remain pressed until you have selected one of the 
three buttons. This will then transfer the new duration, which will be available for new effects.

An effect between two normal scenes shortens the total storyboard length by the running time of the transition effect. An effect 
between a normal scene (background) and an Insert scene (foreground) does not shorten the length of the storyboard. Transi-
tion effects may not overlap. For example, if a scene is 5 seconds long then the total duration of the two effects connecting this 
scene with the previous scene and next scene cannot be longer than 5 seconds. For effects where an insert scene is present, the 
duration of the insert scene is the maximum limit. Audio is automatically cross-faded. This means that the audio of the previ-
ous scene becomes quieter and the audio of the next scene becomes louder. If a scene’s audio is too quiet or too loud, then 
you should correct the volume when dubbing (audio mix). If an insert scene is involved with the effect, the audio is not changed 
because Inserts do not affect the original audio of the background scene.

(10) The “Preview” button can only be clicked when the inserted effect is an effect that must be created (indicated with red 
outline). A screen opens in which the last second of the first scene, the effect, and the first second of the following scene are dis-
played, so that you can view the transition and perhaps make further corrections (concerning color, direction, time, etc.), before 
you finally create the transition effect. The duration of the preview is approximately that of the final version. The preview may be 
a little “jittery” because it does not work at the normal frame rate. This will not occur in the created effect. For complex effects a 
certain wait time even for preview may be necessary. A preview does not require any hard-drive space.

(11) After you have added a transition effect and perhaps defined its duration, you can click on the “Full Size” button and bring 
up a further preview menu ( S  G  the Bronze Edition does not feature all options, only with the Gold Edition the full functionality 
is availablefor this menu.).
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There you see the middle frame of the transition effect (e.g. 1 second effect = image 12 or 2 second effect = image 24).
The video image is superimposed by an operating panel in which you can see the effect options (if available) on the right side. On 
the left side you see the button “Frame”. You can use this button to specify the point in time of the transition effect you want to 
see. In this way you can observe the applied effect at any point in time of the scene. The button does not have to be confirmed - 
you can scroll slowly through this part of the scene and view it at the same time. The button “Display” below allows you to select 
from different display modes, which can help you to check an effect more precisely. Depending on the selected effect, it may be 
useful to change the display mode.

Original: shows just the selected scene without effect.

Effect: allows you to see the scene for the time only relevant to the effect chosen.

Orig.+Effect: splits the scene display vertically and shows one scene half as the original and the other with the chosen effect.

O+E centre: unlike “Orig. + Effect”, always compares the centre part of a scene, on the left the original and on the right together 
with the effect. This comparison type is suitable for effects that appear mostly in the centre of an image.

O+E small: this display type shows you the complete original scene (at transitions, the left scene) smaller in the left preview 
screen. Next to it, on the right, you can see the same scene, with the effect. This display type shows you miniature versions of 
the scenes. However, remember you can’t see fine details in this fashion, as opposed to larger effect previews. It can be very 
useful for image processing effects, comparing the original and the effect scene with each other.

Compare: halves the image, with the right screen half showing your new scene and the left any scene that you can choose us-
ing the “Choose scene” button (below) from the edit bin. The compare function can therefore be used to adapt the color tone of 
your scene to an already present scene.

C center: has a preview style comparable to “Compare”, but in this case, the centre part of the scene is focussed on, as the 
most important part of the scene is often found in the centre. For example, if you want to apply an image processing effect such 
as Color Correction in order to adapt that scene’s color tone to other scenes, a comparison in full size is a good solution.

C small: If however, you are fine working with a smaller preview, you can switch it to small. This simply allows you to compare 
the scene with the effect as a whole, yet in smaller preview screens.

Tip: It is recommended to switch back and forth between the different modes while working on the effects. This way, you 
can experience the scene in its completeness. You can also change the effect options to directly compare different colors 

or directions. Here you’ll also get a real-time preview, too. Therefore the selection of the sliders does not have to be confirmed.
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In the top left corner of the menu you will find a button with which you can play a small preview. This will give you the ability to 
see the effect of your settings, which you have had so far to assess in a single image, in a real-time preview.

The settings made in this menu are confirmed with “OK” and you are returned to the Effect menu. With “Cancel” you leave the 
“Full Size” menu without saving any changes. The arrow buttons serve to move the single-image menu to the top edge of the 
screen.

(12) If the inserted effect shows a symbol outlined in red, then it must be created. When you click on the “Create” button a 
screen appears in which the course of the effect can be seen as it is created. After the creation is completed, the symbol’s out-
line is blue.

(13) With the function “scene” (which comes with the Gold Edition) you can make use of the multi-layer technique. In the Bronze 
Edition, this functionality is limited. 
If you want to overlap several transition effects, you at first add one effect between two scenes and create it. Then you create a 
single scene from the two scenes and the inserted effect. To do this you click on the “Scene” button so that a window appears in 
which you can select the range for the new scene.

The name of the used transition effect appears next to “Name” and is given as default name for the new scene. If desired, you 
can enter another name by clicking and using the keyboard that appears. You also see the three options “Effect”, “Effect + 
scene(s)”, and “Range”. If you only want to convert the effect with the previously set range into a new scene, then click on “Ef-
fect”. G  Furthermore, you can choose if a new scene is added to the Scene Bin and/or if it is to replace the Scene + Effect in 
the Storyboard. Click on “OK” so that the effect is turned into a scene and added as selected above. You can also let the length 
of the new scene extend beyond the range of the two previous scenes (with inserted effect). In this case click onto “Effect + 
scene(s)” and then (once you have selected where it is to be added) on “OK”. Alternatively, you can create the scene from the 
entire length of or from a portion of the storyboard. Click onto “Range”, select how it is to be added and then confirm with “OK”. 
Use the IN and OUT points (in the now familiar Range menu) to select the range of the new scene. The G  wave form can be of 
help (chapter 3.3 “Sound envelope and audio scrubbing”) and can be toggled on/off with the loudspeaker symbol.

Then click on “OK” in the Range menu and the scene is created and stored in the Edit menu. Of course, you can also create a 
separate scene from a portion of the storyboard in which there is no effect. Simply select a point in the storyboard and click on 
“Scene”. In the window that is displayed only the function “Range” is enabled. Specify a range and click on “OK”. Then you can 
view the new scene in the Edit menu.

(14)  Here, you can see two buttons that have an effect on sound effects. Once you have added a transition effect 
between two scenes, you can click onto the Note symbol to add a sound effect.

A window opens up (the “Audio Pool”), contain-
ing a pre-selection of various effects on the 
left side, which you can select with the help of 
the vertical slider. On the right, you can see a 
graphic representation of the sound. The button 
“Product” shows you the available products 
that contain sound effects. The button “Type” 
shows you that the sounds are split into three 
groups:
You can choose between the groups: “Sounds 
for Fades”, “Realistic Sounds” and “Synthetic 
Sounds”. The button ‘Play’ is used to play se-

lected sound. The maximum playback time is five seconds, just like the graphic display. The button below, called “Channels”, al-
lows you to swap the left and right channels around by setting the direction symbol as desired. This may be useful if for example, 
you wish to change the direction of the wipe effect (e.g. the train the video scene travels from left to right across the screen).

Click on “OK” after selecting to close the audio pool again. You will then see a little sound effect symbol just underneath the 
transition effect symbol in the storyboard.
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When you enter the “Audio Mix” menu, you will see the sound effect in the first effect 
track of the Audio Mix menu. If this track was already occupied, maybe partially, the 
sound will be moved to another track. In this menu, you can additionally edit the sound 
(move, trim, change volume). Please note that the sound effects are locked to the 
transition effects. If you remove the transition effect, this will also delete the sound 
effect. Select the crossed out Note symbol found in the transition effect menu and the 
sound effect shall be split and removed from the transition effect. 

(15) Bottom right you see ten menu symbols for the following menus: Recording, Import, Edit, Transition effects, Image Process-
ing effects, Titling, Audio Record, Audio mix, Settings and Main menu.

Keep in mind: If you change a setting for an effect that has already been created, change the duration, or even replace the effect 
with another, the effect must then be created again. Be careful!

G  (16) Click on the button “Options” to setup the properties of the transition effects.

This is where you can determine how the sound of both scenes has to be treated during the 
fade. Should it be mixed in a uniform way, or should it be reduced during the fade.

It is also possible to influence the speed of the effect while it is running. To do this, you 
should go to the “Run” setting. The “linear” setting lets the effect run at a uniform speed, if 
the effect does not have any other settings. Use “slow down” to have the effect slow down at 
the end of the effect. Use “speed up” to have the effect speed up at the end of the effect. 

It is also possible to automatically add or remove several effects in the storyboard.

Add automatically: This leads you to a selection where you 
can automatically add transition effects from the current 
position in the storyboard. These functions are particularly 
interesting for slide shows or still sequences, but they can 
also help with normal video projects. Select “Add automati-
cally” to access the menu listing your transition effects. You 
will see that these are the standard user interface elements 
required to add effects to the Storyboard. You will see that 
these are the standard user interface elements required to 
add effects to the Storyboard. There’s the effect list and the 
selection for effects shown. Also, there are the effect settings 
if available for that effect and the effect length. This menu is 
special in that it allows you to select several effects. You can 
mark single effects with a tick or make a multiple selection. 
These effects are then used later, in the storyboard. Don’t 
forget to apply any settings for your effects. As you can 

select multiple effects, there’s also an option for choosing the mode for applying the effects in the storyboard. Choose “Cyclic” 
to add the effects one after the other to the Storyboard. Once the last effect is added, the system begins adding the first effect in 
the list once again. The “Random” mode on the other hand, does what it implies: It adds random effects from your selection to 
the Storyboard. Remember that in such a case, sometimes the same effect may be used several times in a row.

The effect length is set globally for all effects. You can not enter a separate length for each effect. Therefore, all effects added to 
the Storyboard in this fashion will have the same length, unless the scene length itself prohibits this. After you make the selection 
and make your settings, click onto OK to confirm. You will be asked once more if you really want to add these effects, as this will 
place all transitions in the Storyboard from this position on. Any transitions already found in the Storyboard shall be overwritten. 
Confirm with Yes to add the effects.

Remove automatically: Once you have applied effects to the Storyboard, it must be possible to delete these effects in just as 
easily if you are unhappy with your choice. This is why the menu following the “Options” click also contains a delete option. Click 
onto “Remove automatically” and confirm with “Yes”.
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Tips/Notes:
• The transitions are always added/deleted form the current Storyboard position on.
•  You can have more variety by adding effects automatically and then choosing a point in the Storyboard to add one or more ef-

fect automatically once more. Any effects already found will be replaced by the new ones.
•  If you want to use an effect length longer than the effects allows for, the effect will automatically be shortened. In such cases, 

you may find that a transition can’t be added any more if a scene is already occupied by another effect.
• The effect selection will be abandoned if you switch to another product display.
•  Using the optional Power Key hardware and software combination, it is also possible to insert effects with a predetermined 

repetition (e.g. 20x Page turn).
•  In the positioning menu of an effect (e.g. rectangle fade), a grid can also be activated, to make it easier to set the position of 

a scene. Positioning by means of a raster is especially useful when a multi-layer effect has to be created, taking into account 
other existing transitions.

S  G   (17) Archives: Many effects can be individually configured by a number of options. These settings, once made, can now 
be saved in an archive and loaded again later.

(18) Presets: With this button you can reset an effect to its default settings. This option is available for most of the effects, but 
not for all.

The transition effects in detail

The following transition effects belong to the basic package.

Bars: The new picture either pushes (“Type” “Push”) the old with from 2 to 200 “Bars” out of view or superimposes itself (“Type” 
“Inset”). Under “Direction” you have a choice of six. Two are interlocked (come from two sides). Recommended duration: 0.5 to 2 
seconds.

Circle wipe: This effect changes from one scene to another with a circle containing a scene and which becomes steadily larger 
or smaller. The direction can be chosen with “Mode”. “In” means that the second scene overlays the first scene with a circle that 
begins in the center of the screen and grows outward until only the second scene is visible. With “Out” the first scene is in a cir-
cle covering the screen but which then becomes steadily smaller until it disappears, having been replaced by the second scene. 
The well-known end to cartoon films can be replicated by using the “Black” effect from the “New scene” list and the mode “Out”. 
Recommended duration: 0.5 to 2 seconds.

Color fade: With this effect the first scene fades into a specifiable color and from there fades into the second scene. Such a 
fade is popular, for example, with edited interviews, where a hard cut or other transition emphasizes the participant’s movement. 
The usual color box is used here to set the “Color”. For this effect black or white is the usual choice. Recommended duration: 
0.5 to 2 seconds.

Crossfade: This effect is the classical fade. Next to the hard cut, this is certainly the most frequently used type of scene transi-
tion. The first scene is transformed gradually into the second, whereby with increasing time the first scene becomes less and less 
visible and the second more and more. As with all transition effects both scenes remain in movement. Simply freezing a scene is 
not attractive and is no longer supported by Bogart SE. Recommended duration: 0.5 to 3 seconds.

Double exposure: This effect is the classical double exposure as it has been used in film for the last hundred years, and leads 
to a very atmospheric picture transition. In essence, it is an extended fade. With “Mode” you can choose between “Crossfade” 
(normal usage) and “Fade In/Out” (recommended for inserts). The “Fade time” (sum of fade-in and fade-out) can be set for up to 
12 seconds. Under “Mix” you can set the proportion of the scenes involved up to 100%. If the control for the mix proportion is 
set to 0%, then the first scene is shown in full. For 100% you see only the second scene. With 50% both scenes are shown with 
the same intensity. This is suitable for normal transitions. Don’t forget to specify the duration of the effect with the corresponding 
buttons. You will usually use the “x s” button to set the duration to the maximum so that the transition takes effect throughout 
the entire double scene. For this case you should trim both scenes to the same length beforehand.

Field changer: The scenes in this effect are alternated in half images with each other so that a strobing effect ensues keeping 
both scenes in movement. This effect can be used for creating 3D videos, if you have suitable footage.
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Gate: With this effect you can call up the color box with the button “Color” in order to specify which color the gate should have. 
The gate closes from opposite sides of the screen over the first scene. Under “Direction” you specify whether the opposite sides 
are top and bottom, or left and right. After the bars have met at screen center, they reverse direction, moving out of the picture 
and revealing the second scene.

Pattern fade: This effect fades the second scene by using the pattern you have selected from the Image Pool. You can choose 
between “Wipe” and “Split Screen” to achieve the effect you want. In addition, select the color for the border: “None”(no border), 
“Soft” or “Color”.

Picture in picture: This is not really a true transition effect. But Bogart SE handles it as an effect because it affects two scenes 
simultaneously. The first of the two scenes fills the entire screen in the background. The second scene is inset on it as a reduced 
image. The position of the small image can be set in the effect options with the button “Location”. The buttons “Shadow” and 
“Frame” are used to set a value from 0-50. The frame color can be set with the color box through the button “Frame Color”. 
Avoid using very strong colors, because this can lead to jaggedness in the upper-right and lower-right corners. For the picture-
in-picture effect audio is not cross-faded, as is the case with all other effects, but instead only the audio of the first scene (back-
ground video) is used. You can change this default setting by using audio mixing. Recommended duration: at least 5 seconds.

Placeholder: This is not a real, proper effect. This effect is used after a restore, when the project contains effects that have not 
yet been installed on the system that is being used. This can occur after a new installation or when transferring a project to a 
different system. The effects that are not available are not simply ignored, instead they are replaced by the exclamation mark. 
This reserve the space (if it is not replaced or erased) until the project is stored and used on the original device again, or until the 
extension software has been installed.
The placeholder is also used with Disk-Juggler when a project on an external hard disk is being used on a different device. As 
long as only the placeholder is being shown, the effect will not change the scene when it is calculated. The effect settings field at 
the right contains a warning that this is not a proper effect.

Random lines: This effect transforms the first scene to the second by continuously covering the first scene with randomly po-
sitioned lines from the second scene.

Rectangle wipe: This effect changes from one scene to another with a rectangle containing a scene and which becomes 
steadily larger or smaller. Below “Position” you can set the “Location” and “Size” of a rectangle where the sides increase or 
decrease in proportion to each other. A grid can also be activated, to make it easier to set the position of a scene. Positioning by 
means of a raster is especially useful when a multi-layer effect has to be created, taking into account other existing transitions.
The direction can be chosen with “Mode”. “In” means that the second scene overlays the first scene with a rectangle that begins 
in the center of the screen and grows outward until only the second scene is visible. If you chose “Out”, the first scene will shrink 
until it reaches the rectangle size you have defined. Once this is achieved, the screen is completely filled with the second scene, 
which was seen before in the background of the rectangle.

Scale: Under “Position” you can set the “Location” and “Size” of a rectangle where the sides always increase or decrease in 
proportion to each other. If you choose the option “Grow” under “Type”, the second scene is zoomed into the first scene. The 
scene is scaled to fit proportionately into the rectangle and increases or decreases in size according to the sides of the rect-
angle. If you choose the option “Shrink” the opposite occurs. The first scene is in the rectangle covering the screen and gradually 
becomes smaller until it disappears, having been replaced by the second scene.

Stripe fade: This effect changes from one scene to another by dividing the first scene into stripes which are then faded out 
while the second scene can already be seen in the background. You can specify the number of “Stripes” from 2-32. Under 
“Mode” you can specify the direction of the stripes (you have the choice between “Horizontal” and “Vertical”).
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4.8 Image Processing effects

Apart from transition effects there are also image processing effects. In contrast to transition effects, image processing effects 
are applied to entire scenes or segments of the storyboard. You can make a part of your video brighter or invert it, or convert it 
into a charcoal drawing or relief and a lot more. These are sometimes referred to as “filters” in old analog editing systems. In the 
same way, for example, as a yellow filter on a camera lens modifies the color of pictures taken, an image processing effect is ap-
plied to a particular segment of the storyboard. In the image processing effects screen only one scene is selected. The selected 
scene represents the approximate range for the intended effect. You can process just one image, or an entire scene, or in the 
extreme case the entire storyboard.

(1) The “Image processing” screen shown above displays the storyboard you are already familiar with. You should select the 
scene to which you want to apply the image processing effect. A difference to the storyboard from the “Edit” menu is the play 
button. In the image processing effects screen the play button does not play the entire storyboard, but only the active scene. If 
an effect has been added, then the length of the entire effect is played.

(2) You can choose the desired image processing effect in the effect list. Either click on the effect directly so that it is highlighted 
by the dark-gray bar, or use the slider or arrow buttons in order to move the desired effect to the correct position. If you do use 
the slider, then after selecting the effect you must press the left trackball button so that the light-blue bar again changes to dark-
blue. 
Clicking either the button “Fav.” or “LRU” will split the effects list. In the top part you will see then also your favorite or often used 
effects.

(3) After you have selected an effect that has further options, the effect options are displayed in the field to the right of the effect 
list. There you can define, for example, the colors and intensity of the effect.

G  (4) Realtime-Preview: After you have added an effect into the storyboard, the effect will play back in this window for one time. 
You can activate “Audio” to hear the audio as well. Additionally you can activate the Loop-Mode to play back the effect in a loop. 
You manually can play back and stop the preview with the two buttons below “Loop-Mode”.

S  G  (5) This button features different options, depending whether you have activated the Silver or Gold Edition.The selection 
button below the effect list allows you to switch the effect list to single points. The button offers at least three settings. The func-
tion “All” shows all transition effects which are to be found in the system. “Default” shows the transition effects, which are inte-
grated in the system and “Optional” only shows the transition effects which have been installed afterwards. Clicking on “FAV.” or 
“LRU” shows additionally your favorite or often used effects in the list.
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(6) Clicking on the “i” button, you’ll get information about the image processing effect activated in the effect list. If it is an add-on 
effect, the window “product information” appears, which offers a description of the effect. Is the effect to be found a standard 
effect, the product information refers to the manual.

G  (7) Options: Click on the button “Options” to setup the properties of the image processing effects. This is where you can influ-
ence the speed of the effect while it is running. You can do this with the “Run” setting. The “linear” setting lets the effect run at 
a uniform speed, if the effect does not have any other settings. Use “slow down” to have the effect slow down at the end of the 
effect. Use “speed up” to have the effect speed up at the end of the effect.

(8) With the “Add” button you can apply the selected and configured effect to the scene located in the center. The effect symbol 
appears in the scene outlined in red. If you select a new image processing effect even though there is already one in the scene, 
the new effect replaces the old, without you having to click again on “Add”. The length of the newly inserted effect corresponds 
at first to the length of the actual scene, but can be changed with the button located at the top-left (10).

(9) A click on the “Remove” button removes the added effect from the storyboard. If you would like to replace the current effect 
with another, then you can simply select the new effect and it automatically replaces the current effect in the storyboard. In this 
case you don’t have to click on the “Remove” button.

(10) After you have inserted a scene the scene length is displayed in this button (and thus the maximum length of the effect). 
Click this button so that the “Specify Range” menu opens and you are given four selection options. You can let the effect run 
“1 sec at beginning”, “1 sec at end”, over the “complete scene”, or over a specifiable “Range”. Choosing the function “Range” 
opens a Trim menu, similar to “Trim” from the “Edit” menu, in which you can set the applicable range for the effect. The effect 
will begin at the In point (first frame of the scene), and end at the Out point (the last frame). Some segments of the storyboard 
cannot be selected. The reason is that other effects are already defined. Overlapping between image processing effects and 
titling is not possible. You can also choose between the “Trim” and “Position” functions here as well. Please refer to the notes 
for “Insert” (chapter 4.4, item (13)). When you have set the range of your choice, return to the “Image Processing” menu (click on 
the right button). If you have extended the effect to other scenes, then you will also see the effect symbol in these scenes. (By 
choosing the option “complete scene” you can remove the selected effect from the other scenes.) The range that you just set is 
displayed in this button.

(11) Clicking on the “Preview” button opens a small screen in which the video plus the effect runs. In this way you can judge and 
perhaps make corrections (for color, intensity, time, etc.) to the effect before creating it. The running time of the preview will cor-
respond approximately to the time of the calculated effect.
The duration of the preview is approximately that of the final version. The preview may be a little “jittery” because it does not 
work at the normal frame rate. This will not occur in the created effect. A preview does not require any hard-drive space.

(12) After you have inserted an Image Processing effect and perhaps specified its range, you can click on “Full Size” to bring 
up an additional menu ( S  G  the Bronze Edition does not feature all options, only with the Gold Edition the full functionality is 
availablefor this menu.). 

In the background you see the middle frame of the entire 
segment for the inserted image processing effect (if the 
effect is applied on the entire scene, then you will see 
the middle frame of the video scene). The video image is 
superimposed by an operating panel in which you can see 

the effect options (if available) on the right side. The button “Display” below allows you to select from different display modes, 
which can help you to check an effect more precisely. Depending on the selected effect, it may be useful to change the display 
mode. “Original” (shows the just selected new scene). “Compare” halves the image, with the right screen half showing your new 
scene and the left any scene that you can choose using the “Choose scene” button (below) from the scene bin. The compare 
function can therefore be used to adapt the color tone of your scene to an already present scene.

O+E centre: unlike “Orig. + Effect”, always compares the centre part of a scene, on the left the original and on the right together 
with the effect. This comparison type is suitable for effects that appear mostly in the centre of an image.
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O+E small: this display type shows you the complete original scene compared to the effect. Both scenes are smaller previews. 
However, remember you can’t see fine details in this fashion, as opposed to larger effect previews. It can be very useful for im-
age processing effects, comparing the original and the effect scene with each other.

C center: has a preview style comparable to “Compare”, but in this case, the centre part of the scene is focussed on, as the 
most important part of the scene is often found in the centre. For example, if you want to apply an image processing effect such 
as Color Correction in order to adapt that scene’s color tone to other scenes, a comparison in full size is a good solution.

C small: If however, you are fine working with a smaller preview, you can switch it to small. This simply allows you to compare 
the scene with the effect as a whole, yet in smaller preview screens.

Tip: It is recommended to switch back and forth between the different modes while working on the effects. This way, you 
can experience the scene in its completeness.

Above the function “Display” you see the “Frame” slider with which you can set the point in time of the long-term effect that you 
want to view. You can use this button to specify the point in time of the effect you want to see.

In this way you can observe the applied effect at any point in time of the scene. The button does not have to be confirmed. You 
can scroll slowly through this part of the scene and view it at the same time. Of course, you can change the effect options as you 
wish and thus have the possibility of directly comparing various colors and directions. The effect options can be set directly in 
this window, while watching a real-time preview. The selection of the sliders does not have to be confirmed.
In the top left corner of the menu you will find a button with which you can play a small preview. This will give you the ability to 
see the effect of your settings, which you have had so far to assess in a single image, in a real-time preview.
The settings made in this menu are confirmed with “OK” and you are returned to the Edit menu. With “Cancel” you leave the “Full 
Size” menu without saving any changes. The arrow buttons serve to move the single-image menu to the top edge of the screen.

(13) When you click on the “Create” button a screen appears in which the course of the effect can be seen as it is created. After 
the creation is completed, the symbol’s outline is blue. When you calculate an effect Bogart SE reads all individual images from 
the scene in question and applies the effect to it. The result is stored on the hard drive. This procedure takes time and consumes 
hard-drive capacity. When recording data you should always leave a small amount of hard drive capacity in reserve. Depending 
on how often effects are used, this should be between 2% and 10% of the video playing time.

(14) With the function “scene” (which comes with the Gold Edition) you can make use of the multi-layer technique. In the Bronze 
Edition, this functionality is limited.

If you would like to overlay several long-term effects, you at first insert an effect into 
a scene and create it. Then you convert the scene with the inserted effect into a 
separate scene. To do this you click on the “Scene” button so that a window 
appears in which you can select the range for the new scene. The name of the used 
image processing effect appears next to “Name” and is given as default name for 
the new scene. If desired, you can enter another name by clicking and using the 
keyboard that appears.

You also see the three options “Effect”, “Effect + scene(s)”, and “Range”. If you only want to convert the effect with the previ-
ously set range into a new scene, then click on “Effect”. Furthermore, you can choose if a new scene is added to the scene bin 
and/or if it is to replace the Scene + Effect in the Storyboard. Click on “OK” so that the effect is turned into a scene and added 
as selected above.
You can also adjust the length of the new scene to the range of the previous scene (with inserted effect). In this case click on 
“Effect + Scene(s)” and then - once you have selected where it is added - on “OK”. The new scene is created and appears in the 
scene bin.
Alternatively, you can create the scene from the entire length of or from a portion of the storyboard. Click onto “Range”, select 
how it is to be added and then confirm with “OK”. Use the IN and OUT points (in the now familiar Range menu) to select the 
range of the new scene. The G  wave form can be of help (chapter 3.3 “Sound envelope and audio scrubbing”) and can be 
toggled on/off with the loudspeaker symbol.
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Then click on “OK” in the Range menu and the scene is created and stored in the Edit menu. Of course, you can also create a 
separate scene from a portion of the storyboard in which there is no effect. Simply select a scene in the storyboard and click on 
“Scene”. In the window that is displayed only the function “Range” is enabled. Specify a range and click on “OK”. Then you can 
view the new scene in the Edit menu.
Should you want to create a scene with the possibility “Effect + Scene”, you now have the additional choice to determine how 
the new scene should be treated.

Replace in storyboard: After rendering the scene, the one in the Storyboard will be replaced by a new one. This will also remove 
the image processing effect on the scene, so that only the new scene will be included for the storyboard. You could, for exam-
ple, place an additional effect on the new scene and have it rendered.

Render scene in scene bin: Activate this function to insert your rendered scene in the scene bin (in the Edit menu), behind the 
currently activated scene. These options can be deactivated if you do not want to store the scene. In that case, the scene must 
be replaced in the storyboard.

Note: One of both options is always active, it is not possible to deactivate both of them.

The multi-layering technique for image processing effects can also be applied by using the Edit menu to activate a scene in the 
scene bin and then clicking the “Special” button. All image processing effects are listed there. The effect you select is not ap-
plied into the storyboard. Instead, a copy is made of the active scene in the scene bin with the image processing effect added to 
it. The copy incorporates the effect, and its name is supplemented with SP, SP 2, etc. You can repeat this procedure at will. (see 
also section 4.4 “Editing”, item (20)).

(15) Bottom right you see ten menu symbols for the following menus: Recording, Import, Edit, Transition effects, Image Process-
ing effects, Titling, Audio Record, Audio mix, Settings and Main menu.

S  G  (16) Archives: Many effects can be individually configured by a number of options. These settings, once made, can now 
be saved in an archive and loaded again later.

(17) Presets: With this button you can reset an effect to its default settings. This option is available for most of the effects, but 
not for all.

Note: If you change a setting for an effect that has already been calculated, or change the duration, or even replace the 
effect with another, the effect must then be re-created. Be careful!

The image processing effects in detail

The following image processing effects are available in the standard package:

Binarizer: The scene is divided into two colors according to brightness. With “Color 0” you bring up the color box in which you 
select a color that replaces the darker areas. “Color 1” replaces the brighter areas. The “Threshold” of the transition from light 
to dark can be set from 0-100%. And you can set “Transition” between the two colors from 0-100% in order to prevent “edge 
shimmer”.

Color depth: A very frequently seen effect can be achieved with this. The number of colors in the picture is reduced. This func-
tion can be used to create a sort of animation movie, especially in combination with the special “Jitter” function. The “Depth” can 
be set from 2-50. The “Transition” can be set from 0-100% in order to prevent “edge shimmer”.

Tip: Up to 16 million different shades of color can appear in a video image. This allows fluid transitions. For each color 
component (there are a total of three color components) there are about 256 possible levels. This effect reduces the 

number of possible color levels per component to between 2 and 50. The resulting image has now a maximum of between 2 * 2 * 
2 = 8 and 50 * 50 * 50 = 125,000 different colors.
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Color to Grey: Usually the video material is in color. This effect can convert the video to black-and-white. If you want to convert 
long segments, or perhaps even the entire video to black-and-white, then you can set the color saturation in the Video settings 
menu to 0% when initially recording the material. This might save you long calculation times.

Control Color: With this effect you can correct the colors “Red”, “Green”, and “Blue” in the scene (later adjustment). You can 
set the color from 0-200%, where 100% corresponds to the regular color.

Control Image: With this effect you can change “Brightness”, “Contrast”, “Saturation”, and “Gamma”.

CVBS Filter: This effect can be used to reduce edge shimmer which sometimes arises when using an CVBS (RCA) connection. 
This shimmer can appear at very fine, high-contrast edges arises to a much lesser extent or not at all when using a S-Video con-
nection. Using the filter causes a weak blurring of the image. The filter should therefore only be used when absolutely necessary. 
You can set the “Strength” from 1-3.

Tip: With a CVBS connection the signals for brightness and color, which are normally separate, are mixed. This causes 
considerable loss in the video bandwidth, especially for color. The “CVBS filter” reduces the video bandwidth and thus 

reduces the extent of the undesired effect described above.

Doubler: This effect blurs the scene by overlaying the image with itself so that a light colored shadow appears.

Dynamic range: This effect is used to limit the extent of brightness and contrast. This makes interesting estrangement effects 
possible. You should experiment a little with the settings. The preview offers a good approximation so that you don’t have to 
make time-intensive calculations. All image information is retained under “Type”. “Clip”. The controls “Min” and “Max” are used 
to change brightness and contrast. Under  “Compress”, however, image information is lost for areas brighter than maximum or 
darker than minimum, which are set to maximum or minimum, respectively. You lose the details in the bright and dark areas. 
Other areas are unaffected.

Effect stack: This effect allows you to bundle as many effects as you wish and apply them to a scene in one go. To use it, ac-
cess the settings for this effect. In the screen shot above, you can see the effect list in the top left corner. Below this, you find the 
following options:
“Add effect”: Choose effects from the image processing effect list to be added to the stack.
“Remove effect”: Removes an effect from the stack.
“Move effect up”: Moves the currently selected effect to the top of the stack.
“Move effect down”: Moves the currently selected effect to the bottom of the stack.
Moving effects within the stack makes sense as the effects are applied in the order going from top to bottom. This way, each ef-
fect is influenced by the previous effect. The order of effects may therefore be crucial. Use the preview button to check the result 
before rendering.
The operator makes it possible to also include effects from the image processing effects list. It is possible to archive your com-
posed effect, to make it possible to re-use it later on. The effects that are stored in the archive will also be shown in the effect 
list. If you stored a combination with the archive name “Binary frame”, this combination will be listed as the effect “ES: Binary 
frame”. It is possible to show only the effect stack effects in the selection filter for the effects.

Fade in: This effect helps you to fade in the scene, e.g. at the beginning of your film. Choose the desired color with the effect 
options and see how the color becomes less and less dominant until the scene is completely revealed and the color no longer 
visible. This effect fades in only the footage, not the audio.

Fade out: This effect helps you to fade out the scene, e.g. at the end of your film. Use the “Color” option to select the desired 
color to which the scene is faded. At first, the effect overlays your scene very lightly with the color so that the scene is still clearly 
visible. In the course of the effect the color becomes more and more dominant until the scene is completely overlaid and no 
longer visible. This effect fades out only the picture material, not the audio!

Flip: This effect flips the scene. If you set the “Direction” to “Horizontal”, then you see the scene with the left and right halves 
exchanged. If you set “Vertical”, then the scene is seen upside-down. The setting “Horizontal + Vertical” combines these two 
effects.
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Lineart: With this effect the video is turned into a sort of moving charcoal drawing. All edges and sharp contours look like they 
have been redrawn with a charcoal pencil on a piece of white paper. The “Contrast” control is used to set the blackness of the 
lines from 1-8 depending on the contrast of the original scene.

Mirror: A scene is mirrored. Under “Type” the following directions can be given: “Horizontal Left-Left”, “Horizontal Right-Right”, 
“Vertical Top-Top”, and “Vertical Bottom-Bottom”. You also have the possibility to mirror the two upper or the two lower image 
halves, whereby you can also specify which image half (left or right) should be mirrored.

Mosaic: With this effect you make a mosaic out of your scene. The scene is divided up into individual squares that become 
larger. You specify the “Size” of the squares from 2-200. You specify the beginning and end points for the effect within the scene 
with the “In” and “Out” points. Time can be up to 12 seconds.

Movie mode: This effect is used to turn 50i format scenes (interlace) into progressive 25p format footage. In this fashion, move-
ment is made to simulate the typical cinematic look from the movies. The effect creates 25 different frames rather than 50 fields.

Negative: This is the negative effect known from photography. It is often used for special effects, but also has a practical ap-
plication. With the macro function of some video cameras it is possible to film a slide or a negative in full-screen format. The 
Negative effect can then be used to create a positive image for use in the video. For this effect you also have (under “Type”) the 
choice between “Brightness” and “Brightness + Color”. There is an interesting effect for example, if you invert the “Brightness”. 
The video seems like a negative, but the colors are correct.

NOP: You can ignore this effect. It is listed in the regular effect list but doesn’t do anything. This function causes no change to 
your video material but is used by MacroSystem technicians to help find software and hardware errors so that we can help you 
with problems by telephone. NOP is an abbreviation for “No OPeration”.

Out of focus: With this effect you can make a scene appear blurred. You can set the blur “Intensity” from 2-20. Under “In” and 
“Out” you set the start and end points of the effect (up to 12 seconds).

Pattern 2: A freely positionable pattern (can be set in “Position” and “Size”) is inserted into your video. Click “Select Pattern” to 
opens the Image Pool (described earlier in this manual).

Place holder: This is not a real, proper effect. Instead, it is a place holder for projects that have been copied. The effect settings 
field at the right contains a warning that this is not a proper effect. For more information, please refer to the descriptions of the 
transition effects.

Rectangle: A freely positionable rectangle of any size (can be set in “Position”) is inserted into your video. The color of the rect-
angle can also be set.

Tip: With rectangle you cannot only generate backgrounds for various purposes, but you can also cut border areas, 
“mask” people or create clearly defined BlueBox areas.

Relief: The video image is transformed into a sort of 3-dimensional relief. It looks as if it has been chiseled in stone - a single 
gray tone with light and shadow at the edges. Edges appear where the original has strongly contrasting edges. The button “Di-
rection” can be used to change the illumination source in order to obtain different effects. The arrow shows the direction in which 
the light shines from.

Sharpen: Sometimes you may want to improve a blurred segment of a scene (e.g. old archive material). This effect is used to 
increase image sharpness. The degree of sharpness can be set from 1-8 with the “Strength” control. The preview does not do 
full justice to the result, so you should experiment beforehand with a shortened version (Edit/Copy, Trim) of the scene you would 
like to correct.

Solarize: The video is strongly altered with this effect. The original colors are ignored and new colors are created that are depen-
dent on the brightness. Black is replaced by blue, gray values are converted to orange, yellow, green, cyan, and even blue where 
the very brightest image areas were. You can sometimes see similar images in TV science programs or in crime movies as so-
called “heat images”. Hard transitions may lead to shimmering edges, especially for VHS or when using the CVBS connection. 
The effect “CVBS filter” can be used to alleviate this (before or after). 
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You can set the “Saturation” from 0-100%. The higher the percentage, the more color the image has. 0% results in a black-and-
white picture.

Tip: Solarize is frequently used in science to highlight small differences in brightness for the human eye. The human eye 
can distinguish only about 100 different levels of brightness, but about 100,000 different colors.

Spread: Here you create a “shimmering” image. This is achieved by distributing the pixels within a circle (which you set with 
“Step” 1-10) containing the original pixel.

White balance: In case recording has led to erroneous white balance resulting in white and gray surfaces that look wrong but 
the color is OK, you can specify the location and size of a rectangle with the button “Reference Color”. Then the color fault within 
the rectangle is averaged and the deviations in the entire image are canceled out. Note that only light color faults can be im-
proved. You can turn a red surface into a gray one, but the effects on the rest of the image are extreme (color distortion).
In order to identify this reference color, you should use the slider at the bottom left to find an image that contains a white area. 
In the case that there is no colorless (white) surface in the image, it is possible to use a reference color from another scene as 
the reference color. To do this, you should click on the “Select scene” button. This will enable you to select another scene from 
your scene bin. In this scene, you will also be able to move in time and determine a reference position. Use the top left button to 
switch between the original scene “Effect” and the added scene “Selection”. Once you have selected the scene image, you can 
use the buttons “Position” and “Size” to select the reference color. The color that has been chosen from the range, will be shown 
in the color field below.

Zoom: A defined image area can be zoomed in. Below “Position” you give the location and size of the rectangle area. Below 
“Zoom In” and “Zoom Out” you specify the start and end time of the effect (up to 12 seconds).

Note: Increasing the zoom during editing does not fully replace an optical zoom found in the camera. Digital zooming 
during editing always results in quality loss.

4.9  Titling

Titling essentially works as if it were an image processing effect. However, instead of filtering (brightening...) the image, titling in-
serts digital text in your video. Titling has two menus. The settings in the “Titling” menu correspond closely to those of the image 
processing effects menu.
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(1) The “Titling” screen shown above displays the storyboard you are already familiar with. You should select the scene to which 
you want to apply the title. A difference to the storyboard from the “Edit” menu is the play button. In the titling screen the play 
button does not play the entire storyboard, but only the active scene. If an effect has been added, then the length of the entire 
effect is played.

(2) You can choose the desired titling effect in the effect list. Either click on the effect directly so that it is highlighted by the dark-
gray bar, or use the slider or arrow buttons in order to move the desired effect to the correct position. If you do use the slider, 
then after selecting the effect you must press the left trackball button so that the light-blue bar again changes to dark-blue. 
Clicking either the button “Fav.” or “LRU” will split the effects list. In the top part you will see then also your favorite or often used 
effects.

(3) The selection button below the effect list allows you to switch the effect list to single points. The button offers at least three 
settings. The function “All” shows all titling effects which are to be found in the system. “Default” shows the transition effects, 
which are integrated in the system and “Optional” only shows the titling effects which have been installed afterwards.

(4) Clicking on “FAV.” G  (chapter 4.1.6) or “LRU” S  G  shows additionally your favorite or often used titling effects in the list.

(5) Clicking on the “i” button, you’ll get information about the titling effect activated in the effect list. If it is an add-on effect, the 
window “product information” appears, which offers a description of the effect. Is the effect to be found a standard effect, the 
product information refers to the manual.

(6) With the “Add” button you can apply the selected and configured effect to the scene located in the 
center. The effect symbol appears in the scene outlined in red. If you select a new titling processing effect 
even though there is already one in the scene, the new effect replaces the old, without you having to click 
again on “Add”. The length of the newly inserted effect corresponds at to the length of the actual scene, 
but can be changed with the button located at the top-left (8).

(7) A click on the “Remove” button removes the added effect from the storyboard. If you would like to replace the current effect 
with another, then you can simply select the new effect and it automatically replaces the current effect in the storyboard. In this 
case you don’t have to click on the “Remove” button.

(8) After you have inserted a scene the scene length is displayed in this button (and thus the maximum length of the effect). Click 
this button so that the “Specify Range” menu opens and you are given four selection options. You can let the effect run “1 sec 
at beginning”, “1 sec at end”, over the “complete scene”, or over a specifiable “Range”. Choosing the function “Range” opens a 
Trim menu, similar to “Trim” from the “Edit” menu, in which you can set the applicable range for the effect. The effect will begin 
at the In point (first frame of the scene), and end at the Out point (the last frame). Some segments of the storyboard cannot be 
selected. The reason is that other effects are already defined. Overlapping between titling and image processing effects is not 
possible. You can also choose between the “Trim” and “Position” functions here as well. Please refer to the notes for “Insert” 
(chapter 4.4, item (13)). When you have set the range of your choice, return to the “Titling” menu (click on the right button). If 
you have extended the effect to other scenes, then you will also see the effect symbol in these scenes. (By choosing the option 
“complete scene” you can remove the selected effect from the other scenes.) The range that you just set is displayed in this  
button.

(9) You can then enter the “Titling” menu by clicking on the button “Enter/edit text” below the effect options.

NEU!

(10) Previously, you can use the Titler selection to determine which titler you want to use. The default titler is the “Bogart 
9 Titler”, which we will describe on the following pages.

As an alternative to the standard Titler, you can also create your titles with 
“Titel-Studio 2” or with the “Vertigo Titler”. There are separate manuals 
for both titlers available. Both titles can also be tested as a demo version.

Note: Some few functions are only available with activated Silver or Gold Edition.
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In the “Titling” menu you see the first frame of your video scene that contains the titling effect. On the scene you already see a 
sample text or the last entered text.

The quality of the shown text 
depends on your screen settings 
and may not match with the finaly 
rendered text that depends on your 
project settings.

4.9.1  Text operators and text entry

Essentially there are three different ways to operate titles.

4.9.1.1  Pages

All document pages are displayed in sequence. Display is done without fading and pauses. The display time is such so that the 
entire scene is affected. The text is placed on a scene and can adjusted in size and position. 
Text can be placed in so called boxes. Boxes can also have a background. To show your text properly, the text must fit within a 
box. Pages can contain any number of boxes.

4.9.1.2  Vertial scrolling titles

A rolling title scrolls vertically over your scene. This effect is a good choice for longer texts.

Text entry here also is done in a box. In this panel, the text is scrolled upward when it is longer than the box can represent. This 
is not a problem since it is a rolling title. The text is scrolled while playing the scene, so it is completely legible. The box repre-
sents only the right and left text positioning within the scene. The text will scrolled over the entire scene height. With rolling titles 
it is not possible to place a background image. Multiple pages and boxes can be used.

4.9.1.3  Horizontal scrolling titles

The text moves across the screen from right to left at the bottom of the screen. In the Text-entry menu you can enter as many 
letters as you wish for the text. Text entry is done in a box, which is contrary to the nature of a marquee. If the text is longer 
than the space in the panel, the text is scrolled upward. This represents not the result of the later “ticker”. However, the result is 
represented as a line in the marquee.
You have two design options:
• Enter your text without line break (return / enter), the text is calculated in one line of scrolling text.
• If you want more than one scrolling line (starting flush), enter your text with a newline (return).
Multiple boxes are supported here, but you cannot use multiple pages and no background images.

The Bogart 9 Titler is operated by three riders, which are divided into the groups „Text“, „Boxes“ and „Pages“ (see picture abo-
ve). It is advisable to edit these three headings in turn.

Here we describe a standard sequence of a titling and show all the possibilities the Bogart Titler offers.

On the left side of the menu you see the following system buttoms.

 Opens the Titler settings. Here a grid can be activated in 2-pixel increments from 2 to 32 pixels. The default is off.

 Here you can see the current version of the Titler and whether you use “demo” fonts or imported fonts.

 Lets you display the menu at the top of the screen and then back down again after you have pressed the button again.
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 Minimizes the Titler menu, for example, to quickly have a complete title impression without a distracting menu. A new Click 
opens the menu again.

4.9.2  Text entry

In the background you see the first frame of your video scene. This full frame display serves as an orientation for adding text. 
This lets you immediately see how the text looks overlaid on the particular scene you are editing.
At the vertical or horizontal edge of the window you may see – according to effect – a scroll bar, with which you can scroll 
through the text box. If text boxes are already present in the video image, then you can use this menu to enter text with the help 
of an external keyboard.

 Click the little keyboard symbol 
to open the onscreen keyboard. With 
the keyboard you can enter the text of 
your choice. It is also possible to enter 
the text with your PC keyboard. Any 
adjustments you make to the settings 

will automatically be applied to the next line of text entry. If you want, you can enter the text later, but it is recommended that you 
enter some letters now in order to better judge the results later. If you would like to format every line with its own settings (e.g. 
font, size, color), then click on the newline key after every line you enter and then specify the desired format. Separate formatting 
for individual words or letters in the same line is not possible.

 For the text alignment click one of the Line buttons “left”, “center” or “right”.

The switch “Font” and “Style”, which we describe in the following, bring us to the respective menus without a detour via the 
Titler main menu.

 With this switch we get back to the Titler main menu.

The “Exit” button completes the title entry and returns to “Titling”.

After entering a word or title, we return to the Titler main menu.

4.9.3  Font

A click on the button “Font” (the currently selected is next to the switch) opens a window in which you have a choice of fonts and 
many type sizes (10-500 points).

The font can be selected by clicking on its name or with the slider, as you already know from the 
effect list. Next to the fonts in the list, there are also different symbols. Most of the fonts that 
come with the program are marked with a “A”. This means that they contain all usual Western 
European characters). A font marked with a happy face (there is one supplied in the standard 
package) contains pictures and/or symbols instead of letters and punctuation. Fonts that are 
marked with “A+” also contain Eastern European characters. These fonts are available as exten-
sion products. Fonts marked with “A-” are not always complete and may contain deviations from 
the usual fonts. These fonts are not sold, but can be obtained free of charge in appropriate 
instances.

Note: The Carolann font supplied with the standard package has two different forms for 
“s”, in addition to “ß”. The “s” key on the keyboard is the more frequently used long “s”, 

that is something like an “f” without the horizontal stroke. The small, round “s” is mapped to the 
“#” key.
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The size of the font is determined with the slider. The display shows a preview of the current font type and font size as applied to 
“MacroSystem”. 
Beyond using pre-installed fonts, you can use any TrueType font with Bogart. Click the button “Import font(s)” and choose the 
desired font files from your hard-disk, CD or USB-stick.

The currently selected font will be shown in a preview. The Multi Select function allows you to choose multiple fonts to import. 
You can import a maximum of 100 fonts. Once you have tagged all the desired fonts, press OK to import them. Once imported, 
the fonts are added to your font list. These fonts are listed with their font name. They are marked by an “A” with a superscript 
“x”.
Should you have installed too many fonts, you can remove the superfluous ones by clicking on the “Delete font(s)” button. You 
should then mark the ones you want to delete and click “OK” to delete them.

With “OK” or “Cancel” you leave the font selection.

The “Opt” button to the right of the font selector opens the “Font-Options”. Here you specify the charwidth, charspacing and the 
linespacing. The setting range is between 50 and 200%.

 With this button, you set the settings back to the defaults (100%).

The “Charwidth” widens the letters and punctuation marks in a line. To do this, first click 
anywhere in the row you want to edit, and then use the slider to set the desired percent-
age. Depending on the percentage specified ,the letters become wider (> 100%) or nar-
rower (< 100%), which widens or narrows the entire line. You cannot edit the words of a 
row separately, the settings apply to the entire row. 
Use “Charspacing” to stretch or jam a row, but the width of each letter remains un-
changed, so that the letters can also “slip into one another”. “Linespacing” allows you to 
change the distance between the selected row and the line below it. The percentages you 

have set are retained for each line and can be corrected later.

Click “OK” to see how the settings affect the text.

4.9.4  Style

A click onto the “Style” button opens another screen. Here, you can see a preview 
to the right displaying a smaller version of your video. The text part and back-
ground are related to the position of the text cursor. If you have not yet entered 
text, the system displays some other letters. In the top left corner, decide which 
pattern is to be used for the text. Press “Color” for the color box or “Pattern” to 
open the “Select pattern” screen. In this screen you can select a pattern of your 
choice. The mode (positive/negative) and alpha value can also be specified.

Clicking on “OK” in “Select pattern” confirms your settings and you are returned to 
the “Style” menu. Now you can see the “Outline” button. With the aid of the slider 
next to it, define the strength of the outline with values between 0 (not active) and 6 
(strong). The “Color/Pattern” button leads you to the image pool, in which you can 

decide if the outline is to consist of a pattern or color.

In the box below, you should see the “Shadow” button. Use it to determine a width between even values of 0 to 20. The “Di-
rection” and “Color” of the shadow can now also be determined. The slider for “Blur” allows you to change the outline of the 
shadow to a blur type effects and thus make it look more realistic.

Note: The shadow settings are always for all lines of a box. If you want to combine rows with shadows and rows without 
shadows, you must work on different boxes. Further below.
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In the right area of the screen, you can see the function “Italic”. You can activate it by selecting the empty box next to it. The 
button “Smooth” is use to apply a slightly smeared look to the text. It also may help to weaken any unwanted artefacts resulting 
from video compression.

Below, you can see the “3D” option. The strength of the three-dimensional effect can be set with even values between 0 and 20 
using the slider. The effect makes the letter look as if they had a certain thickness. If you use higher values, make sure to set a 
character space of around 120% so that the 3D effect does not interfere with the letters themselves. The “direction” can be set 
to eight different possibilities.

The structure of the effect can be set using the “Color/Pattern” button. It is recommended to use a tone similar to the text color, 
yet with brightness between this and the background color’s.

Below left, in the “Style” screen, you can see the “Archives” button. The Archives allow you to save the styles you have created. 
You will also find some examples of styles that come with the software. The Style screen can be closed by pressing the “OK” 
button (meaning that you confirm the settings made) or by pressing “Cancel”.

Once you have returned to the text menu, you will see the “O S I 3D” indicator next to the used surface, which show us that in 
the style editing an “O”utline, an “S”hadow, the property “I”talic and the “3D” design were used. A useful info for more elaborate 
title creations.

 The “Copy Properties” button copies the settings made in the selected row to all other lines of the current box.

4.9.5 Alignment

You can set the horizontal alignment of your text (left-aligned, centered, right-aligned) with the three switches on the right side of 
the text menu. This setting can be set separately for each rowwithin the same box.
 
Under the horizontal alignment switches, the switches for the alignment of the complete box, i.e. all rows, are located at the top 
or bottom edge of the box or in the center of the box.

 With this switch, the vertical alignment can be transferred to all boxes of a page.

Clicking on “Delete active line” causes the line containing the position marker to be deleted. The window disappears.
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4.9.6  Boxes

To the above left in the menu you at first see the label “Box 1/1”. The box, on which we have designed our text, is marked with a 
broken line. On the right side of the menu you can see how big the box is (in our example 1,536 x 864 pixels) and where on the 
screen is the upper left corner of this panel (in our case 192 pixels on the right and 108 pixels below the upper left corner of the 
screen, the position 0-0).

With “Position” you can change the position of the active text box. You drag it with the trackball and confirm the new position 
with the left trackball button. Alternatively, you can position the trackball cursor on the upper left corner of the text box so that 
a symbol (four spearheads) appears. Then click on the left trackball key so that the task bar is hidden and you can move the 
selected text box. After you have reached the desired position, click again on the left trackball key.

After clicking “Size” you use the trackball to resize the panel at the bottom and right edges and fix the new size by clicking on 
the left trackball button. Alternatively, you can change the box size by clicking directly. Point the screen cursor to the upper or 
lower edge so that an arrow symbol appears, click on the left trackball key and drag the edge up or down by rolling the trackball. 
Moving the left or right edge functions in the same way.

If you point the cursor to the lower right edge, a diagonal arrow symbol appears. Click on the left mouse key and then roll to 
change box height and width simultaneously.

Note: When the size of the box is reduced, the font is initially framed, with further reduction the text does not shrink, but 
the box cuts it off (see picture below).

 For the fast definition of the box size there are three switches, that create either a box with a minimum size (text is 
framed as closely as possible), with visible size (see large image above) or with maximum size (panel as large as the screen or 
project settings, no margin visible).
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By default, the boxes are transparent, so the text is directly above the video image. But there is the possibility of placing the title 
on a visible “box”. For this purpose, the “background” switch is used, which calls up the image pool and allows you to load any 
graphic (including your own images) as a background for the box.

 With this switch, the backgrounds can also be copied to other boxes if necessary.

The margin setting (range from 0 to 25%) defines a text-free border. Default is 5%.

Use the button “Add” to put an additional text box onto the video image. The second box is placed (preset is “visible size”) in the 
middle of the screen. The properties are taken from the first existing box, each added box is placed above the previous one.

You see the display “Box 2/2” after you have added a text box. After adding still another text box “Box 3/3” is displayed, and so 
on. With the help of the right arrow key you can move forward through the boxes. The left arrow key is used to display the previ-
ous box.

Note: You can toggle between the text boxes by clicking directly on the corresponding spot in the preview screen. The 
box is then marked with a broken line.

You can use the trackball to position the box. After the upper left corner of the box has reached the desired position, confirm 
by clicking the left trackball button. Rolling the trackball now determines the size of the box. Clicking on the left trackball button 
again confirms the setting.

When a text panel is hidden by others you can make it visible either by resizing or moving the overlying panel, or by clicking 
repeatedly the TAB key on the keyboard (to the left of the letter q) until the text panel you want appears.

Note: Please note that after calculation the text boxes are ordered in the same sequence as they were created. The 
sequence that you used to place the boxes on top of each other is irrelevant for the calculation.

Clicking on “Delete” causes the active (outlined) panel to be deleted. The previously inserted panel now becomes the active 
panel.

The switch “Text-Import” allows you to import texts written on a computer for titling (for instance, a text from an e-mail with a 
customer’s preferred credits text). This saves work and prevents typos. The system supports the standard text formats ASCII.

Tip: If your word processor does not support this format, save your text as a „. txt“ file and load this file into the Windows 
„notepad“. This is the standard text editing program included with Windows. From the editor, you can then export the text 

again, with the encoding „ANSI“. This text can then be imported into the Bogart 9 Titler in any cases.

If you want to import a PC text, please note that only the plain text is applied, but not the settings (font, type, size). The fonts, 
sizes, etc. that are set in the Titler are applied to the imported text.

After selecting the Import button, a Windows window opens and you can choose the text file you want to import. If you do not 
want to import from hard disk, before starting the import process, ensure that the appropriate media is inserted (CD/DVD) or 
connected (USB stick, external hard drive). Once you have selected the desired source, the texts are displayed and you can 
select the desired text to import.

Note: The Bogart 9 Titleist may need a little longer, especially for longer texts, to do the import, or to display the text with 
all the properties you have defined. With a very large font with textured surface, edge, 3D effect, and blurred shadows, you 

have to be patient until a few hundred characters of text are on the screen.
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4.9.7  Pages

After clicking on the “Pages” tab you will be taken to a new menu where you can create and edit pages.

A title can not only contain multiple boxes on one page, but you can also create as many pages as you want. 

At the above left in the Pages menu (according to the effect) you see the label “Page 1/1”. After you have added a page you see 
the label “Page 2/2”. After an additionally added page “Page 3/3” appears, etc. With the help of the right arrow you can move 
forward through the pages. The left arrow displays the previous page.

The newly added page takes the background of the last active box from the previous page and creates an empty box in “visible 
size” on the new page.

Each page can be filled with one or more boxes as described above.

The pages are played in order with the selected side effects (see chapter 4.9.1.1).

Tip: Please note that all pages must share the effect time selected at the beginning. If you create a 6-second title with six 
pages, your viewers will have one second time to read each page.

Pressing “remove page” deletes the current page and you will see the next available page on the screen. If you have deleted the 
last available page, the previous page will be seen.

A click on “Archive” opens a field displaying four buttons: “Load”, “Save”, “Delete”, and 
“Cancel”. Clicking on “Load” displays a list of the previously saved titles. In this list you select 
a title, either directly or with the slider, and confirm (“OK”). A click on “Save” displays the same 
list. There are now two possible courses of action:

1. You can click the gray rectangle below the list so that the keyboard is displayed and you can assign a name to the previously 
created title, followed by clicking on “OK” within the keyboard and in the text archive field.

2. You can select a title from the list and then click on the gray line which now contains the name of the selected effect. Within 
the keyboard field you now overwrite this name with another of your choice. The difference to the first possibility is that you 
overwrite not only the name, but also the archived title, which is then irrevocably lost. Alternatively, you can select a title without 
clicking on the yellow line. You can then confirm by clicking on OK. The selected entry will be replaced by the previously cre-
ated title, but it will keep its name. With the help of archiving you can save your frequently used standard text independently of 
projects and reuse them at any time.

If you click on “Delete”, a list of saved titles is displayed in which you can now select the title to be deleted and confirm with 
“OK”. A click on “Cancel” closes the menu without accepting any settings.

4.9.8  Further buttons in the titling menu

The “Preview” button can be used to (if you have already added a title effect to the storyboard) see a preview of the effect you 
have selected. If you have not yet added an effect, the trackball pointer will display a little cross when trying to click on  
“Preview”.

A click on the “i” button displays information on the selected title effect, the length of the effect (in the case that you have already 
placed it in the storyboard), and whether you have applied the typefaces installed only in the demo version to your text boxes. If, 
while experimenting, you have been using a demo font and are now unsure where to find it (a space is sufficient), use the button 
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text / font for all lines to determine a common, active font.
With the “OK” button you confirm again all settings made and are returned to the “Titling” menu.

With “Cancel” you exit the Text-entry menu without accepting any settings made for the “Titling” menu.

G  (11) Realtime-Preview: After you have added an effect into the storyboard, the effect will play back in this window for one 
time. You can activate “Audio” to hear the audio as well. Additionally you can activate the Loop-Mode to play back the effect in a 
loop. You manually can play back and stop the preview with the two buttons below “Loop-Mode”.

(12) Clicking on the “Preview” button opens a small screen in which the video plus the effect runs. In this way you can judge and 
perhaps make corrections (for color, intensity, time, etc.) to the effect before creating it. The running time of the preview will cor-
respond approximately to the time of the calculated effect.
The duration of the preview is approximately that of the final version. The preview may be a little “jittery” because it does not 
work at the normal frame rate. This will not occur in the created effect. A preview does not require any hard-drive space.

(13) After you have selected an effect that has further options, the effect options are displayed in the field to the right of the effect 
list. There you can define, for example, the colors and intensity of the effect as well as fade-in and fade-out times.

(14) When you satisfied with your effect settings click the “Create” button to render your title.

(15) Options: Click on the button “Options” to setup the properties of the titling effects. This is where you can influence the 
speed of the effect while it is running. You can do this with the “Run” setting. The “linear” setting lets the effect run at a uniform 
speed, if the effect does not have any other settings. Use “slow down” to have the effect slow down at the end of the effect. Use 
“speed up” to have the effect speed up at the end of the effect.

S  G  (16) Archives: Many effects can be individually configured by a number of options. These settings, once made, can now 
be saved in an archive and loaded again later.

(17) Presets: With this button you can reset an effect to its default settings.

(18) Bottom right you see ten menu symbols for the following menus: Recording, Import, Edit, Transition effects, Image Process-
ing effects, Titling, Audio Record, Audio mix, Settings and Main menu.
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4.9.9  Title effects in detail

Title effects can be selected in the effect list. This list contains several effect options. For many of them additional attributes can 
be modified, as will be shown in the following:

Moving pages: The direction in which the title is scrolled (over one or more pages) into (“into”) or out of (“out of”) the page is 
specified here. Any one of eight directions can be given. In addition, the “Movement” can be set up to 12 seconds.

Fading V-Scroll: The text scrolls from the bottom to the top through the picture. The scroll speed depends on the scene length 
and the text length (the text scrolls fast enough so that it moves entirely over the screen within the duration of the scene). The 
title enters the screen in a transparent state, becomes clear (solid) in the center of the screen, and again more and more trans-
parent as it scrolls out of view. You can set the height “Fading height” of this fade-in and fade-out from 10-200 pixels.

In/out fading pages: All pages are faded in and out in sequence. The “Fade” indicates when the title should be faded in (up to 
12 seconds) and the “Pause” indicates the duration between two pages.

Horizontal scroller: The text moves across the screen from right to left at the bottom of the screen. In the Text-entry menu 
you can enter as many letters as you wish for the text. There is a slider below the video you can use to move the text further.

V-Scroll: The text scrolls from the bottom to the top through the picture. The scroll speed depends on the scene length and the 
text length. The text scrolls at a speed so that it scrolls entirely over the screen within the duration of the scene. Several pages 
can be inserted.

Pages: All document pages are displayed in sequence. Display is done without fading and pauses. The display time is such so 
that the entire scene is affected.

Place holder: This is not a real, proper effect. Instead, it is a place holder for projects that have been copied. The effect settings 
field at the right contains a warning that this is not a proper effect. For more information, please refer to the descriptions of the 
transition effects.

Through fading pages: All document pages are crossfaded one after another in sequence. The speed can be set from 0-12 
seconds in “Fade”.

4.10  Audio

You should not begin audio mixing until you have finished editing the video. Effects and titling should already be completed. 
Editing video or adding effects after audio mixing has been completed can damage the careful editing work which you have 
already done on the sound track. To avoid misunderstandings: When you edit video in Bogart SE you also change the original 
audio. Transition effects in the video are also applied to the audio. This section deals with audio mixing, which involves adding 
additional audio tracks overlaying or supplementing the original audio.

Audio mixing employs the same principle as video editing:

1. Recording of the raw (audio) data

2.  Splitting of the audio sample into a number of discrete passages (if desired)

3.  Trimming of these data, i.e. cutting out of undesired components such as coughing, residual material from adjacent  
CD tracks, etc.

4.  Special processing of the audio sample or of a part of it (e.g. interchanging of stereo tracks)

5.  Insertion of these audio samples into the storyboard
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6.  Adjustment of the volume of the original audio and of any commentaries and the background music to each other, and adjust-
ment of any fading

7. Addition of audio effects (if desired)

8.  Fine adjustment of the volume of individual audio samples by means of wave form (if desired)

9. Creation (if necessary) of the complete sound track (all stereo tracks are mixed on a single stereo track)

10. This just leaves exporting to file, and your video is finished

4.10.1  Record, Edit

This is the “Record, Edit” menu (accessed via the main menu, or by pressing the respective quick select button in other menus). 
Use this menu to record your audio material by clicking on the round red Record button. You can also use this function to split, 
trim and name recordings.

(1) Use the volume display (top left) to adjust the volume level. Try to set the recording volume level as high as possible so as 
to obtain optimum sound quality, but do not over-modulate it. Click on the scrollbar below the volume display to change the 
volume level.
Flashing blue in the volume display indicates that everything is in order, flashing yellow indicates a risk of over-modulation during 
audio mixing (only if several over-modulated segments are mixed), and flashing red indicates over-modulation.

(2) Click the button “Input” to select your audio source for recording, i.e. an USB Microphone. The field below the “Input” button 
displays the remaining capacity of the audio partition

(3) When you have imported your sound recordings and your samples, you will find them in the audio bin. This list of available 
sound recordings can be modified to suit your needs. Below the list, you will find the option to determine how the list should be 
sorted. You may choose between:

original: This lists the sound recordings in the order in which they have been acquired by the system through recording and 
importing.

By name: The sound recording list can now be sorted alphabetically in ascending order.
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By length: The sound recordings are sorted by length in ascending order. 
The audio samples which you have recorded are automatically assigned a label (A 1, A 2, etc) in the audio list, and their length 
displayed. If you have added an audio sample to one of the sound tracks of the Audio-Mix menu, it is marked with a small white 
dot next to the length.

(4) The New Sample button opens a dialog in 
which the Sound, Silence and Sine Wave 
Sound functions can be configured and 
launched by means of the respective buttons.

The effect “Sound” allows you to transform 
sound effects from the audio pool (see chapter 
4.6.13) and thus use them for the audio mix. 
Click onto the button “Select Sound” to open 
the audio pool selection. Select the desired 
sound effect, exit both the audio pool and the 
‘New sample’ window with “OK”. 
Note that the length that can be set in the “New 
sample” window is not relevant – instead, the 
original length of the sound effect is used.

The Silence button creates a completely silent audio sample with which, for example, you can influence parts of another au-
dio sample indirectly for the duration of the silence (see Audio-Mix – indirect volume control). The silence created in the audio 
bin has the length you have chosen. In addition, this sample has been trimmed 5 seconds in the IN range and the OUT range. 
Should you nevertheless need a slightly longer silence, the range can be trimmed.

Use Sine Wave Sound to create a tone the frequency (440 Hz or 1 kHz) and volume (-20 to 0 dB) of which you can define. Soft 
crackling may be audible at the beginning and/or end of the sinusoidal tone. This cannot be eliminated entirely during play back.
The samples created in this fashion are added to your sample list.

Clicking on “FAV.” or “LRU” shows additionally your favorite or often used effects in the list (see also chapter 4.6.1 for setting up 
your favorite effects list).
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(5) “Special” can be used to apply a number of special 
effects to the audio sample, many of which are however 
only available or worthwhile on stereo audio samples. 
With these functions, Bogart SE creates a copy which 
includes the desired changes, i.e. the original audio 
sample is preserved unchanged. The following special 
functions are included as standard:

Width: This function artificially increases the distance between the loudspeakers. This increase is achieved by negative channel 
crosstalk. You can select a width of between 0 and 175%.

Copy Channel: As can be seen under Mode, this function copies the left-hand channel to the right-hand channel or vice-versa, 
as desired.

Swap Channels: This function interchanges the left-hand and right-hand channels.

Volume: Use this function to increase or reduce the volume for the audio sample in question from -20 to +20 dB. 

Volume LR: Use this function to adjust the two channels (left and right) of an audio sample separately. Here too, you can select 
within a range from -20 to +20 dB. Mono switches the stereo signal to mono.

Mono: Mono switches the stereo signal to mono.

NOP: This function cannot be used to make any changes to your audio sample. As with the image processing effects, it is used 
by MacroSystem for internal debugging.

Mute: This function mutes either the left-hand and/or the right-hand channel as desired. In addition, you can also deactivate the 
function using the ‘---’ button so that the audio track is only muted for a specific period of time and so that you need not remove 
the effect.

Surround: The surround effect is used in conjunction with a surround receiver or amplifier to assign the sound of an audio 
sample to a certain channel, i.e. to a certain loudspeaker. It can be used to create interesting acoustic impressions, in particular 
during audio mixing with commentaries. On a normal mono or stereo television set, surround audio is reproduced as “ordinary” 
audio, i.e. without surround effects, through a single or two loudspeaker(s). A film containing surround effects is thus suitable for 
playing over any set. Once the surround effect has been selected, the following options are available:

Sample -> Scene: Clicking on the Sample -> Scene button creates a video sequence with black background from your audio 
sample, which appears in the scene bin. You can use this video sequence as a basis for further video operations (e.g. insert edit-
ing). This function can greatly simplify audio-based editing.

Copy sample: Clicking on the Copy Sample button creates an identical copy of the previously clicked sample in the list of audio 
samples on the right. This function is useful when you wish to use both the original material and a modified version. The copy ap-
pears in the samples list with the same name as the original, but is identified with the suffix. K (e.g. A1.K).

Lengthen Sample: Use this function to extend your sample with silence. This might be useful when your sample is very short 
but you want to fade in or out. Use the sliders “Silence before” and “Silence behind” to extend your sample up to 30 seconds 
before and/or behind your sample.
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S  G  Clipboard 

With this function, you can place the audio sample onto a clipboard. If you 
select “Clipboard”, this will open a selection menu. This menu will enable you 
to add samples to the clipboard, or to insert samples from it into the active 
project.

The top of the screen has a list of all samples found in the Clipboard. This list 
will be empty the first time you see it. The following options exist:

add actual sample: The sample currently selected is added to the Clipboard.

add other sample: You can add another sample than the current one from your project.

add sample from different project: You can add any sample from any of your projects. To do this, first select the project, 
then the sample.

remove sample(s): This option is only available if you have selected at least one sample in the Clipboard. All tagged sam-ples 
will be deleted from the list.

import sample(s): This option is only available if you have selected at least one sample in the selection list. All marked (tagged) 
samples will be added to the current project.

Options: You can determine if trimmed parts of the samples are transferred or left out. 

Any audio samples placed on the clipboard are deleted when you quit Bogart.

Also in this menu you see the button “Pre-listen” under the effect options. Here, you have the option of either deactivating the 
function (“off”), i.e. either hearing the effect or the original. Once you select either Effect or Original, this will loop-play about 20 
seconds of the effect selected in the list (applied to the music selected in the list of sound clips) or some seconds of the origi-
nal sound piece. This option can save you a lot of time, because the audio effects can be heard and compared with the original 
without being rendered.
This function also displays signal amplitude as a control. Flashing blue indicates that everything is in order, flashing yellow 
indicates a risk of over-modulation during audio mixing (only if several over-modulated segments are mixed), and flashing red 
indicates over-modulation.

(6) Click the “Split” button to access the Split Sample menu. You can then split audio scenes in the same way as video scenes.

NEU!

The name of the 
audio sample is 

displayed at the top right. 
The name is followed by 
.001 or .002 etc. (e.g. 
Name.001 or Name.002). 
You can of course click in 
this field to call up the 
keyboard again, and 
rename the audio sample. 

Clicking on the “Split Position” button now enables you to split the audio sample. A graphical display of the part to be split off is 
shown in the bar at the bottom. n addition, the wave form and audio scrubbing (Chapter 3.3 “Sound envelope & audio scrub-
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bing”, only with activated Gold Edition G ), which cannot be disabled in this menu, show the point of the audio sample at which 
you are located. The “Use” and “Drop” buttons and the arrow buttons have the same function as in the Split Sample menu of the 
image material.

 Click on the Play button to start playback of the audio sample currently being edited.

During playback you can split the sample for example at a bar by clicking on “Use” at a suitable point. Your audio sample will 
be split at this point without play-back being stopped. You will then find the numbered pieces in the sample list after the split is 
finished.

f you whish to copy the split audio pieces direct into the Storyboard in the Edit screen, you need to first activate the “Insert as 
scenes in storyboard”  G  by marking the little box. After splitting the sample and confirming with “OK” or waiting until the end 
of the sound, the video data will be created. The sample parts are automatically copied in the form of empty scenes, containing 
the respective parts of the sound. These empty scenes are placed into the Storyboard in the Edit screen. They’ll be easy to spot: 
Black scenes with a little music note symbol.

Additionally, you can now press the “Replace” (or “Insert”) button (see chapter 4.4), so that the selected empty audio scene 
takes the place of the selected scene in the scene bin. If the video scene is too long, it is trimmed to the right length at the end.
This function is great for audio pre-editing as you can comfortably make your cuts and then implement the rhythmically cut up 
audio piece to any video footage. Once you have split your audio sample, the sample list shows that copies of it have been made 
and that your original sample is still available.

(7) Use the “Trim” function to remove unwanted components at the beginning or end of the recorded or split audio material. 

Coughing in the commentaries and residual material from adjacent CD tracks can thus be eliminated. The Trim function is also 
familiar to you from video editing, and functions in the same way with audio. The wave form and audio scrubbing cannot be 
disabled in this menu.

(8) Click on the “Delete” button to delete the selected audio sample.

(9) Click on the Undo button to undo deletion of an audio sample. The last ten samples deleted can be recovered in this way. De-
leted scenes cannot be reactivated following a restart. When the sound clips have been loaded, you will see their titles displayed 
in the list of sound clips.

(10) The name of the audio sample clicked on in the sample list is displayed automatically in the name field. The name can be 
changed in the manner familiar from video. Click in the name field to call up the keyboard. The length of the audio sample is 
displayed in the adjacent field.

(11) The text field at the bottom right contains the group name that has been assigned to the sound sample. Should you want to 
change the group or assign it for the first time, click in this text field to activate the “Assign Group Name” button. This menu is 
also activated when you click on the “Opt” button. This menu is explained in item (20).

(12) Use these buttons to control the Stop/Play functions for the audio sample highlighted in color in the audio list.

(13) Click this button to record audio live from your active input (see item (2). Click the stop button (12) to stop the recording.
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(14) This button allows the import of audio samples from an internal/external hard drive, USB stick or any other media that is 
connected to your PC.

(15) Click this button to open the menu “CD Import”. Now click on the Display 
CD contents button to read all available tracks of an audio CD you have 
inserted before into the optical drive of your machine. To sample your tracks, 
check the box next to Play intro time in order to play the audio sample auto-
matically as soon as it is selected in the list. You can choose between different 
play back times or you can switch off this function altogether. 
If you wish to import merely one track, make sure to check mark the box 
beside the desired track and confirm with “OK”.  After the import the window 
“CD Import” closes automatically and you see the title displayed in the list of 
sound clips.
IIf you wish to import multiple texts from the CD, make sure to activate the box 
by placing a checkmark. Mark the desired tracks and start the import proce-
dure by clicking onto “Import active track” (the window will remain opened) or 
“OK” (window will close). The tracks read in beforehand are now displayed in 
the list of audio samples.
If you whish to import all titles from the CD, first mark all titles by activating the 

horizontal stripes in the box, or click onto the button for ‘All’. It is unimportant which title in the list has already been selected.
If you cancel the operation while the titles are being read, then all titles that have been successfully read are displayed in the list. 
When the sound clips have been loaded, you will see their titles displayed in the list of sound clips.

(16) Click on this button to open the drive tray of your machine.

(17) Click this button to open the menu “MP3 Export compilation”. This screen allows you to select samples export as MP3 files. 
You could export your audio comments or extracted original sounds or even load a music CD and save it with a different track 
order.

On the left, you can see a list with sound samples (“All samples”). Select the desired sample and press “Add”. The sample 
should now appear in the right list (“Selected samples”). This way, you can continue adding sounds for the export. Any samples 
selected from the left list are highlighted with a little dot. The “Estimated usage” of the choosen media (i.e. USB stick) can be 
monitored on top of the screen.
Of course, you can remove any tracks from the list again by simply clicking on “Remove”. Once you have finished assembling 
the list of tracks for the export, choose the desired target folder on your hard disk or USB stick and set the “Quality” to “High”, 
medium” or “low”. Click “OK” to start the export.
It is not possible to export directly to CD. To do this, first export your selected samples as MP3 files to your hard disk. Now you 
can burn the files to CD with a CD burning software of your choice.
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S  G  (18) Media Pool / Clipboard
Like in the “Edit” menu you can access the “Media Pool” also in the “Record, Edit” menu. Click the little drawer symbol (18) to 
open the “Media Pool”. The audio bin is divided into two halfs. On the left side you see the audio bin, on the right side you see 
the Media Pool. Click either into the aera of the scene bin or Media Pool to activate it. The non-active aera becomes slightly 
shaded

The use of the Media Pool is identically like in the “Edit” menu. The “active” area is bright and clear to see, from here you can 
copy audio samples to the audio tray, either by clicking on the upper arrow between the areas or via “Drag and Drop”.
If video scenes from the MediaPool are pushed into the tray, only the audio portion (with the name of the video scene) will be 
placed there.
Audio pieces that are pushed into the MediaPool are given a note key as an identifier.
The handling of the folders and sub-folders (blue icons on the top right) is the same as in the “Edit” menu, also the controls (19) 
for importing temporary files and their handling are exactly the same as described in Chapter 4.4.1.

Similar to the “Edit” menu, you can listen to the MediaPool content and delete it. However, you cannot apply “Trim”, “Split”, 
“Special” or “New Sample”.

(20) S  G  Opt: Group

G  You can assign a group to any sound recording. This will make the list more clear 
and better structured. For example, you could then only show the scenes of a particular 
group. Activate the sound recording you want. Click on “Opt” to open the group op-
tions and select “Assign group name” to assign a group to a sample. If a sound record-
ing has been assigned a group, you will find the group name in the bottom-left field of 
the menu, between the display of the name of the recording and the counter.
Once you have a large number of group names, it may be beneficial to reorder the 

groups that are being shown.  This way, you could create archives in which only specific group names are visible. This way you 
can limit the choice of groups.
This way you have also made it possible to select scenes in the group selection. With the Stock button, all the existing group 
names of the project will be listed.
When you work with groups, you have several possibilities to select scenes in the bin. If you wish to show only sound recordings 
of a particular group or even several groups, press “Opt” and then “Group selection”.

 
This next list contains all available groups for this project. Use the multiple selection 
function to choose one or more groups by placing a tick next to the groups. Press 
OK to show only the scenes that have been assigned to those groups. The remaining 
scenes are not deleted, merely “hidden”.
If you wish to delete the group name of a sound recording (un-assign), select the “---” 
name from the group list. If you wish to see all sound recordings, even those not as-
signed to any group, open the group selection once more and confirm by pressing 
“All”. You will now once again see all of your clips in the scene bin. If not all of them are 
listed, you should look at the top edge of the menu. To the right, you will the information 
“Filter active”. Make sure to check for this if you feel that some clips are “missing”.

S  G  You can even improve the organization of the bin more by hiding any clips that 
you already added to the storyboard. Go to the options menu “Opt”. If the checkbox 
next to “Show added scenes” is ticked, any added scenes (all scenes marked with a 

small white dot above the stamp) will be shown in the scene bin. An unticked box means that the function is deactivated and 
that already added scenes are not shown in the scene bin. Of course, “hiding” scenes in this fashion does not mean that they are 
deleted, but merely not shown.

NEU!

 The previously mentioned trimming reserve (“Edit” menu, Chap.4.4. (28)) is also adjustable here. It is identical to the trim 
reserve in the “options” of the “edit” menu.

(21) Click “Mark” to tag the current audio sample in the sample list. The sample is tagged with a filled square. You can mark 
samples faster by clicking in front of the desired samples direct in the sample list.
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NEU!
(22) The “Action” switch allows a fast multiple selection of various audio clips.

With “mark Sample Bin”, all items listed in the tray are marked with a hook and can then be “used” to-
gether.

”mark Media Pool” selects all samples in the Media Pool (see picture beside). The samples 
are marked with a square above the note symbol and can then be copied completely to the 
sample bin, for example.

“remove all marks” deletes all markers.

(23) Setting up the Bogart user interface (GUI)

Click this button  to open the menu “Change user interface (GUI)”.
In this menu you can activate “Smaller scene names” which might be useful 
when working with longer scene names. Additionally you can change the size 
of the stamps in the Media Pool to “small”, “medium” and “large”.

(24) Click on one of the menu symbols to access the menus Recording, Import, Edit, Transition effects, Image Processing ef-
fects, Titling, Audio Record, Audio mix, Settings or Main menu directly from this menu.

4.10.2  Audio-Mix

Use this function to arrange recorded commentaries and the background sound in the storyboard, add audio effects, and fine-
tune the volume for the sound tracks.
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4.10.2.1  Premixing audio

The audio premixing is a possible alternative to properly edit the sound.
In the audio premix, you can, if the storyboard contains at least one scene, insert a sound sample in the audio mix, and then 
continue to build the rest of the storyboard in a way that fits your sample. If the Storyboard contains at least one scene, you can, 
for example, insert a song below it. The song will automatically be shortened to make it fit the scene. You should set he track you 
use for this to “free” in the audio settings menu, in case you happen to have chosen a linked track. Pre-mixing is only possible 
for free sound tracks.
In the audio-mix, you will now see the storyboard scene and the sound sample which has automatically been shortened at the 
end in the sound track that you have selected previously. When scenes are added to the storyboard, your sound sample will 
automatically lengthen with the storyboard. This means that, in our example, you could insert scenes, and the song that was pre-
viously shortened will automatically be made longer again, until the end of the song is eventually reached. Should the storyboard 
now be shortened, the song will once again automatically be shortened at the end. This way, you can add pre-mixed sound to a 
storyboard and then modify the storyboard as you see fit. You can insert and remove transition effects, or modify their duration. 
You can replace scenes by longer or shorter scenes. The pre-mixed sound will always remain. This makes it very easy to change 
scenes, with or without transition effects, following the rhythm of the music.

4.10.2.2  Audio mixing

Audio mixing is similar in principle to video editing.
S  G  A few functions are only available with activated Silver or Gold Edition.
The audio mix menu depends on the view that has been chosen. It can be shown in storyboard or in timeline mode. You can 
switch between the storyboard and timeline views using the Mode in the settings, after selecting “Storyboard, Timeline”. The 
audio mix menu has a button at the bottom left with which you can directly switch the view. The storyboard with the scenes and 
video effects which you have added to it is visible at the top of the screen.
Unlike the storyboard view of the Edit menu, transition effects are however displayed as discrete scenes in the storyboard. This 
display mode is advantageous, as it enables other audio samples to be situated exactly within the duration of the effect.

Below the storyboard are several horizontal bands, the sound tracks. If you have set the control “Audio tracks” to “normal” in 
“Project settings” under “Audio settings”, the specific differences between the sound tracks are as follows:
Audio samples from the original sound track 1, the commentary track 2 and the effect track(s) are 5 and 6 bound to the scene(s) 
above them. Where changes are subsequently made to scenes before and after the audio samples, the sample remains synchro-
nized with its previous position. Where changes are made to scenes which overlap the audio sample in time, the latter must be 
deleted (following a prompt).

Audio samples in the music tracks 3 and 4 are not bound to a scene; instead, they retain their position in relation to the starting 
point of the storyboard. Changes to the video before or during the audio sample result in shifts which are, however, generally 
uncritical in the case of background music etc.

Owing to this difference in behavior, the tracks bound to the video material are particularly suitable for commentaries or for 
sound effect dubbing. The music track is mainly meant for background music and similar audio. Provided the differences be-
tween tracks are observed, it can of course be used for any other purpose. You can also deactivate these links and define them 
freely.

NEU!

G  In Bogart 9, you can even have 9 audio tracks, each of which can be defined as free or bound.

Audio mixing can be described in the following way.

1. Adding audio samples to a sound track.

2. Moving and trimming audio samples

3. Creating and checking audio.
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4. Correcting sound volume. Bogart offers a total of three methods of volume control: Direct sound volume control, indirect vol-
ume control and volume control via the sound envelope.
The method of volume control employed in each case is therefore determined primarily by the task concerned:
•  If the volume of a complete audio sample is simply to be increased or reduced, direct volume control is the solution. Using the 

wave form for this purpose would be to use a sledgehammer to crack a nut.
•  If an audio sample is to be dampened while another audio sample is playing, for example the background music is to be soft-

ened for the duration of a commentary, indirect volume control is the most convenient solution. Modifying the audio samples 
by means of the wave form or splitting the music manually would also entail a disproportionate amount of work.

•  If unwanted noises are to be eliminated from a audio sample or over-modulated passages of an audio sample adjusted to the 
general volume level, the wave form represents a powerful tool, albeit one which is not particularly easy to use. Once an audio 
sample has been edited by means of the Wave Form function, indirect volume control is however subject to certain limitations.

5. Smooth-fading audio samples in and out.

6. Adding audio effects. Audio effects (standard effects, surround effect, supplementary effects) can be added to individual audio 
samples in the same way as to complete sound tracks.

7. Rechecking audio mixing.
Add the remaining audio samples in turn and adjust the volume, fading and effects as required.

8. Creating audio. Create the sound. The color control bar immediately beneath the storyboard should no longer contain any yel-
low components.

4.10.3  Screen elements in the storyboard view

The following screen is shown in the Audio-Mix menu with the storyboard view:

We first describe the “system elements” and then the functions of the various tabs (4).

(1) The storyboard and its operation is familiar to you from other menus. You can use the slider to move very quickly through the 
storyboard scene by scene.

With the buttons , you can go from scene to scene through the storyboard.

With the buttons , you can go directly to the first or last scene of the storyboard.
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With the buttons , you can go from sample to sample through the film strip in the currently active sound track. This func-
tion is very helpful when a large number of audio samples are located below a single video scene, as the samples are displayed 
only very briefly during normal play-back. Select the desired sound track either directly or by clicking on the corresponding sym-
bol on the right-hand side of the screen.

(2) The color control bar directly beneath the storyboard shows the range of the original video scenes in which the audio has not 
been created (yellow) or has already been completely created (blue). Over-modulation is indicated in red. Overmodulation will be 
indicated as soon as the audio level is clipped. Such clipped audio should be edited until it is no longer clipping. In most cases, 
you can simply reduce the volume level by -1 db for the original audio.

(3) By selecting the number of a soundtrack or by clicking on the track, the respective audio track is “active”, the number of the 
track becomes white, the track turns blue, on the track lying clips are lightened (picture below). If you leave the mouse pointer 
over the track for a longer period, you will see the number of the track and the volume set.

 

The actions that are now executed are related to this track.

If you select a sample directly, it turns blue (picture below).

Here, too, the mouse pointer hovers over the piece after a short time to display information about the track and the selected 
sample.

NEU!

(4) On the right side of the Audio Mix menu you can see one of the major changes of Bogart 9. Here, various functions 
are offered via so-called “tabs” for quick access. We will explain this whole section further below, if we have explained 

the basic functionalities of the audio mixing.

(5) User interface settings

 Click this button to open the “User interface settings” menu.

Here you can first define whether you want to work in the 
storyboard (selected here) or in the timeline mode (see chap. 
4.10.2.4).

On the right side, we can see the up to 9 audio tracks, which you 
may select (check mark) or hide (stroke). If tracks are deselected 
here, because they are not needed (yet), the display changes in 
the audio mix menu, the remaining tracks then divide the place 
of the hidden tracks. 

If you need more tracks, the “deselect” can be undone at any time, then up to 9 tracks are available again.
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You can also define whether a track should be “locked” or “unlocked”. A “locked” track is bound to the video scene under which 
it starts. The consequence: if material is still inserted in front of this video scene, the scene with a bound track in the film slides 
backwards, so the inserted sound keeps its connection to the scene. In the case of comments or sounds that relate to very spe-
cific events in the picture, this is absolutely correct and is also expected.
Samples on a unlocked track remain in the course of the film exactly where they are inserted. So let’s start a music at 5 minutes 
25 seconds, it starts right there. If scenes are still inserted in the front of the film, the music does not “slip” in relation to its own 
start time (5 min. 25 sec.), but probably in relation to the scene under which it once began, when we inserted it.

”Unlocked” tracks are not marked separately, “locked” tracks are marked with a lock behind the track number.

Note: In earlier times, it was recommended to place music on „unlocked“ tracks, since the music to scene is not so direct, 
and a general and conclusive music setting of the entire film has a higher priority. In the meantime, however, we believe 

that it is very important for most users that a music starts at the or „under the“ scene under which it was also inserted. 
We therefore recommend that you set all tracks to „locked“ as default. 
If you have to cut music and rely on a music at a very precise time, you can of course switch one or more tracks to „unlocked“.

On the left side of the settings menu, we see the options for the timeline selection (now inactive) and the image size selector for 
the storyboard. Depending on the taste and space on the screen can be selected between small, medium and large.

(6) You can use this switch to display yellow guides that visually separate the scenes from the transition effects. They represent 
the starting point of a scene and facilitate the overview when arranging the various clips in the different tracks.

(7) This switch is used to turn an audio scrubbing on or off. If we turn on scrubbing, the envelope of the currently active Ton-
stückes is displayed under (8). The effects are described in the “Range” tab.

(9) The “Undo” and “Redo” switches, which are familiar from other areas, are of course also available in Audio-Mix menu.

(10) The info switch provides information on how the project is called, how long it is in total, at what time the currently active 
scene starts and how long the remaining duration of the project is. This is particularly important for long-term projects.

(11)  With this switch you can have your complete project tested on overdrives. After the search is successful, the system 
displays the result.

 

The system asks if you want to display the first over modulation.
The oversteered areas are displayed in the tone and also on the 
Control strip (2) and can then be corrected.
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Note: It is advisable to carry out the test and correction at the end of the audio-mixing, since any subsequent insertion of 
audio clips can cause new over modulations.

(12) With the “Opt” switch you get the possibility to merge audio tracks. Multiple audio tracks can be combined to create a 
soundtrack. For example, you can create space if all the audio tracks are already occupied (with 9 tracks, not likely) and you 
want to add another audio clip to your arrangement. 

The range defined for the merge can be set to “active sample”, “vis-
ible range”, or “entire storyboard”.

You will get a new sample (name: Mix) that will be inserted directly 
into a track you have selected (if you have selected the “Replace in 
storyboard”. The merged tones are deleted.

If you have selected the option “Create sample” (either alone or at the 
same time as “Replace in storyboard”), the merged sample also ap-
pears in your audio bin.

“Merge now” triggers the action that can be undone with “Undo” if 
necessary.

Another setting that can be defined here is copying the O-tone to another track. Edits such as volume changes to the O-tone are 
not a big problem in the original sound track.

But if you want to move the O-tone for a more elegant transition, so that the sound starts before the picture, this does not work, 
because next door are the neighbor O-tones.
The copy of the O-sound could already be done in earlier Bogart versions, but here we now have the possibility to automate 
this copy a bit far. As with the merging of tracks, the time period can be set to the “active sample”, “visible range”, or “entire 
storyboard”. Here, too, the target sound track can be set, at the same time it is possible to define whether the O-tone should be 
muted or not.
With “Copy now” you can execute the operation immediately, but the settings made here also apply to the “quick copy” possible 
under the “Range” tab. More on that later.

(13) Render storyboard: Use this switch to calculate the entire storyboard in video and audio.

(14) Render storyboard audio: This switch only calculates the audio of the storyboard.

(15) S  G  Clicking the Record button causes the storyboard (starting from the current scene) to play. At the same time can be 
recorded via the set audio input. For example, if you have selected the microphone input or your USB microphone, you can com-
ment on your video appropriately. During audio recording, you will see the control panel that overlays your video material at the 
bottom of the screen.

The recorded comment is automatically inserted into track 2 (formerly comment track) as long as there is enough space or until 
the available space is filled. At the same time, the recorded sample appears in the audio bin.
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NEU!
(16)  The position marker enables precise and efficient working. Generally, the position marker jumps, visible as 
an orange line over all audio tracks, when selecting a Tonstückes to the start of the newly activated piece. After pressing 

the play button (17), the storyboard plays exactly from this point.
The position marker can be moved to any other part of the storyboard, even in the middle of a long scene, after selection using 
the “Position control” (Chap.. 4.4.14). Then plays from there. The position marker is much more important in the “Mix in the pre-
view window” (20)-(23).

(17) The play button to the right of the storyboard’s scroll bar allows you to play from the position of the position marker in the 
movie bar. The other tracks that run at the same time are played. During playback, a control panel is displayed so that you can 
see any clippings. The control Panel has a peak level indicator. This means that the highest level of control is displayed until it is 
exceeded.

(18) The sound track options allow you to set certain properties or values for a complete track.

 Clicking on this button opens a selection field, which we can close again with “Cancel”.
“Volume” opens the “Mixer” tab on the right (Chap. 4.10.4.6), where we can adjust the volume of the selected 
track.

”Mute” does just that, the track is muted, indicated by the crossed track number. “Unmute” will return “volume” to the 
track.

“Hide” hides the track completely, it can be activate again in the settings (5) if necessary.

“Effects” opens the “Effects” tab (Chap. 4.10.4.5) in which you can define effects for the entire track.
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(19) The track options allow you to set certain properties or values for the selected track.

 After selecting this switch, a selection field will open, which we can close again with “Cancel”.
“Move free” allows just this, the newly displayed track disappears and “hangs” at the mouse cur-
sor, which gets an envelope symbol.

As you move the cursor horizontally on the soundtrack, the corresponding image on the storyboard appears on the right side of 
the preview window. With a left-click the sample is placed in the selected location. 

“Trim / move (with panel)” gets the large trim menu. Here you can now trim or slide the sample with a view of the first and last 
image on which the sample is located.

 This switch will take you back to the Audio-Mix menu.

“Volume”, “Correction”, and “Fade” opens the “Fade” tab (Chap. 4.10.4.3), where you can change the settings for the volume 
and set the fade in and out point of a sample.

“Envelope” opens the “Envelope” menu of the sample (Chap. 4.10.4.4).

“Effects” opens the effect selector. Lets you choose an effect that is applied to the sample (Chap. 4.10.4.5).

“Create sample” creates a new sample from the samples used in the audio-mix. It 
is possible to define the “Range” of the newly produced sample and has the choice 
between the length of the “active sample”, the “active scene” (i.e. the above cen-
tered), the “active sample + scenes” or a freely selectable area (“select”).

Secondly, it is possible to determine whether the video sound is to be integrated 
into the new sample.

Third, you define whether the new sample should replace the samples previously 
placed in this area and determine the video track in which to place the new piece with “insert in track”.

Finally, it is possible to decide whether the newly created piece should also appear in the audio bin. The new piece will be given 
a new name if needed.

This function can be used to summarize clips and thus to bring more complex “constructions” to a trace.  

The last of the sample option is “Play sample only”. However, as we will see, this can be done more effectively and beneficially in 
another place.
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NEU!
Completely new is the possibility to perform the post-recording in the small (depending on the monitor and setting even 
not so small) preview window at the top right.

For this purpose, we find under the preview picture switch, which is relatively easy to explain itself.

(20) Here we see the switches  and , which optionally play the active track or all tracks, starting with the position 
marker. On the one side, the preview with a moving Image (21), secondly, a marker is running (red arrow), which shows us the 
current position.

(22) The level meter shows us any over modulations.

(23)  A click on the left “stop” button will stop the playback as usual, the marker and also the preview image will bounce 
back to the position marker. Now you can still make corrections and listen to the whole thing again.

 A click on the new “Stop here” button causes a jump of the position marker to the current position (image below, Green 
arrow) In addition to the fact that the playback stops.

In this way, one can listen to each other by its mix, stop at one point if necessary without getting back to the beginning of the 
samples “stopped” and, unlike the previous point of view, always has all the traces in view.

Working in the preview window is much faster, even in conjunction with the tabs, than the previously necessary switching be-
tween different full-screen views.
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Playing one or all of the audio tracks under full screen view is, of course, still possible via the “play” switch (17).

As is accustomed to other menus, there is also the possibility to switch to the other Bogart departments with “Quick jump 
switches” (24).

Now that we have described the basic functionalities of the audio-mix, we come to the “tabs” mentioned below (4).

4.10.4  The functions of the „Tabs“

On the right side of the audio mix menu We see the above mentioned “tabs” (1). These tabs are different menus (which become 
active after dialing) and allow access to the funtions “Insert/Replace”, “Range”, “Fade”, “Envelope”, “Effects”, “Mixer” and “Info” 
without switching to the working screen or open new windows.

This type of menu management allows, much like the audio-mix in the preview window, a faster, more effective and less strenu-
ous way of working than before.

4.10.4.1 The Tab „Insert/Replace“
 

When the tab is activated, the clips stored in the audio archive are displayed (2). If necessary, the pieces can be sorted (3). We 
have the choice between “original”, “by name” and “by length”.

A selected piece can be played before adding (4). Of course, the playback can also be stopped (5).

Under “Opt”-ions (6) You have the possibility, similar to the “Edit” menu, to sort or display your audio pieces in groups, in order 
to have a better overview of dozens or even hundreds of pieces of music, description see chap. 4.10.1.20.
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With “Add” (7) insert the selected sample into the audio-mix, it jumps to the activated soundtrack under the central selected 
scene.

Alternatively, you can also use the mouse to “grab” the sample and drag it over the desired soundtrack. The piece then appears 
there – hanging on the envelope cursor. At the same time, the video image appears at the top right of the preview window, under 
which the sample starts when you drop it here.
In this way, a sample can be placed very precisely, so that the “fine-tuning” for exact placement is often no longer necessary.

“Replace” (8) replaces an activated Tonstück with the one selected in the list.

 This switch (9) removes the activated sample.

 With this “Reset” button known from other menus (10) you reset all the settings of the selected tab menu. In this menu the 
switch makes little sense, in others very well.

With the “Clipboard” or “MediaPool” switch (11) we change the view and now get the media pool displayed (menu in the upper 
right corner), whose operating mode is identical in this menu with the procedure just described.
Or almost identical, because from the MediaPool we can also draw video scenes or their sound into the audio-mix.
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4.10.4.2 The Tab „Range“

The second tab “Range” allows you to “Trim” (1) or “Position” (2) the selected samples.
Here too you can work with the “In” and “Out” (3) knobs directly in the post-setting without having to leave the screen.

At the top right, the preview shows which image is currently active at the “In” or “Out” point (4), including the information about 
how long the sample is, what trimming was made, and at what time position of the storyboard you are currently in.

For example, if you trim the in-point, this is also clear when you look at the audio-mix (see picture below).
 

The piece extends forward (left image), after releasing the mouse, the new trim is fixed, the position marker jumps forward to the 
newly trimmed sample start (right image).

“Position” (2) works the same way.

(5)  and (6)  Who prefers to trim or position his clips in the old way, this can also be done: after selecting “trim” or 
“position”, you can use these switches to “trim or position large” (5) or “trim or position small” (6) (compare Chap. 4.4.13).

Note: The „reset“ switch (7) will return the selected and possibly trimmed sample to the original length. However, an 
accidental operation can be corrected with „undo“.
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The “Copy video sound to another track” section (8) brings the selected O-Tone to a different track with one click after selecting 
the target track. Details about the settings and conditions of this copy under Chap. 4.10.2.3 (12).

4.10.4.3 The Tab „Fade“

The third tab “Fade” allows you to adjust the volume of the selected sample under Volume (1). The control range has its normal 
position at 0, becomes quieter to-30 db (Next Level “mute”) and becomes louder up to + 30 db. The corresponding setting is im-
mediately visualized via the envelope of the sample (see below).

Here you can see the differences in the envelope. At 0 db everything is fine,-23 db on the left are very quiet, + 23 db on the right 
side pointing up with the red line that there would be a significant over modulation, if we would set the volume like so.

Here you can also define a “fade in” (2) or “Fade Out” (3) from 0 to 30 seconds, which is also displayed in the envelope of the 
selected Tonstücks (see below). In our example it becomes clear that the sound is “hard” in and out of 0 seconds. At 2 seconds 
The climb is still relatively steep, with 5 seconds already a lot smoother.

 Under the fade in and out knobs we find the switches with preset times of 0, 1, 2, 5 seconds and the switch “Store” (4). 
Those who want to take the switches with their own “favorite values” can do so. Set a desired blending timer, press the switch 
“Store” and then select the preset switch to which you would like this blending.

In the tab “Fade” we can also make the so-called “correction” between the volume of the individual audio tracks. The “correc-
tion” switch refers to the area covered by the active piece (see image below, light blue area).
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For example, for the duration of our commentary “KOMM01” we can regulate our music “Take8” quietly so that you can under-
stand the commentary well.

For this we choose – our “KOMM01” is activated – the correction option (5).

Now that we have selected the track we want to correct (in our case the track 4), we drag the Correction knob 
(6) to the desired value. We’re going to fix track 4 to -22 db and set it so that the piece of music will not turn out 
abruptly, with a suitable fade-in and fade-out time. With this, we have built a classic “bathtub” (and also in blue), as 
shown in the picture below, where the music level drops gently, while the commentary starts and also rises gently 
again when the commentary ends.

Very simple and with just a few clicks we create a harmonious music composition.
If other elements such as the “Pageturn” inserted into the scene change appear too loud, we can correct them with one click and 
slide the correction knob, just like the sample on track 7.
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If we now call the correction option again, it looks like this: so we always see from the period of our commentary 
on track 2, the corrections in tracks 4, 5 and 7. These corrections or volume rules remain in force for this area as 
long as the comment piece exists.
If we delete it, the corrections are also deleted.
If we put another sound directly in front of the gong or our sound on track 7, this sample will also be regulated ac-
cording to the specifications for the period of our commentary.
We can also reset all values in the “Fade” tab with the “Reset” switch (7).
However, the reset values only applies to the active sample.

4.10.4.4 The Tab „Envelope“

The audio envelope of a sample is edited with the so-called “rubber band func-
tion” via the “envelope” tab, which contains only one switch “envelope”.

If an audio passage is to be raised or lowered within a clip, for example to 
eliminate a loud noise, the envelope is the appropriate tool. Click on the desired 

sample so that it is blue and then select the “Envelope” button.

At the top of the envelope window, the so-called envelope view, the volume of the selected sample is displayed graphically in 
the form of an envelope (1). You can see a presentation of all audio tracks for better Orientation (2). The length of the envelope 
representation always corresponds to the length of the selected sample, which appears brighter in the overall display than the 
other pieces.

In the level view directly below the envelope view, the “Rubber Band Function” (3) can be used to raise or lower the volume of 
the selected sample. To do this, you must first specify the processing points within the sample that will be used to raise or lower 
the volume. The insertion of these points is done either by a left click in the level view near the desired location, or by clicking on 
the “Add” button (4) below the level view. Now activate one of the newly added points by either clicking it directly, or by using 
the slide bar (5) or the single step switches (6) to the right of the level view. The color of the active point changes from red to 
green. Then the exact positioning can be done as follows.

• Positioning in the level view
Click the enabled (green) point again. Its color changes from green to blue. Then drag the point horizontally to the desired time 
position in the level view. To raise or lower the volume, move the point up (louder) or down (quieter). Note that the first and last 
points in the level view cannot be moved horizontally (temporally). With another left click you confirm the position of the point.

• Positioning via Slider
After clicking on “position” (7) The active point can be moved horizontally. The volume at the selected time is set by the level 
slider (8). Drag the level to the right to raise the volume or to the left to decrease the volume.



109Bogart for Windows User manual

Chapter 4

• Positioning in front of the video background

G  To determine the position of a point based on its location within the video, click “Range” (9). 

The view changes and you see your video at exactly the point that was selected on the envelope. The position of the point, i.e. 
the beginning or the end of a fade-in or fading-out, can then be determined by “position” or by single-screen switching. Alterna-
tively, you can play the sound of the sample or the entire storyboard and display it when the envelope button is activated. This 
makes it easier to find certain audio events, “POPs” or the like.

A click on “OK” takes the selected setting.

The volume at the selected time is then set again in the envelope display using the Level slider (8). Proceed as well with the 
remaining points in the level view until the desired result is achieved. You can set the volume between-30 db and + 30 db in 1-db 
increments.

The insert switch (4) inserts an edit point after the currently selected (green) point in the level view. However, it is not possible to 
insert a point between two very close points.

The “Remove” switch (10) removes the currently selected edit point from the level view.

With the help of the “Block” switch (11), it is possible to combine several adjacent processing points into one area, i.e. a com-
mon group:

• Select the outer left (= first) point of the desired area with a left-click or single-frame switch so that it appears green.

• Click “Block”.

• Select the outer right (= last) point of the desired area with a left click. All points within the selected area are also shown in 
green and thus active, the area is highlighted in dark at the top of the envelope.
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The following functions can now be applied to this area:
• Raise or lower the volume level for the entire range. To do this, use the Level slider (8).
• Move the position. To do this, either use the Position slider (7) or set the position using the time period (9).
• Remove all points of the selected area. To do this, click Remove (10). A click in the slider bar below the level view or any point 
stops the range selection.

There are two switches available for play.
• The left play switch only plays the currently edited sample, i.e. the one shown in the envelope.
• The right play switch also plays all other audio tracks, so that you can control the overall sound of all audio tracks.

With the play switch, you can play the sample currently displayed in the 
Envelope view from the selected point. The dashed mark indicates what 
you’re listening to. To the left of the play button, the playhead is displayed in 
minutes:seconds:single frames. The current playback volume is shown in the 
level meter. The play can be interrupted at any time with the stop switch.

Clicking “OK” stops the envelope editing and takes care of the settings. Please note the following points:
• The insertion of a fade in an envelope sample is also possible, the envelope is adjusted accordingly.
• The indirect volume control on an envelope sample by “correction” from another sample is also possible. However, a recalcula-
tion must be made.
• Audio effects can be inserted into envelope clips.
• The envelope is preserved if you have moved a clip.



111Bogart for Windows User manual

Chapter 4

4.10.4.5 The Tab „Effects“

The next tab in the series are the “effects” which can be applied either to the selected sample (picture bottom left) or, with the 
track options (Chap. 4.10.3 (18)) to an entire audio track (bottom right image).

  

The difference between these two representations is the “4” next to the “FX” at the top of the tab, 
which in addition to the “in track 4 used” indicates how many effects are used in the track (in our ex-

ample track 4). In addition, such a track is marked with an “FX” at the front.

The left effect menu tells us that 2 effects have been used in the sample. In addition, the clip gets a small “FX” sign 
on top right.

The check marks in front of the effects provide information about the effects. Under the effect selection, the setting options of 
this effect appear.

The audio effects are divided into several categories, which can be selected separately for better clarity.

All: All effects are displayed.
Default: Only the effects contained in the Bogart 9 software are displayed.
Optional: Only the effects from all additional software packages are displayed.
Favorites: Only the effects specified in the favorites setting (Chap. 4.1.6) are displayed.
[Effects pack]: Only the effects from the respective effect package are displayed.

The standard effects available here are described in detail in chapter 4.10.1. (5).

 Under “Info” you can get information about the selected effect.

 Under “Archive”, effect combinations can be saved with sub-settings and also reloaded.

 With the “reset” switch known from the other menus you reset all settings.
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4.10.4.6 The Tab „Mixer“

The “Mixer” tab allows a total mix of the storyboard. The active track is indi-
cated by an asterisk in front of the track.

The values set in the mixer therefore refer to the complete track and not to 
individual clips.

Effects or corrections of individual pieces or tracks added before or after are not 
invalidated by the settings in the mixer, and all of the settings are aggregated.

In this respect, the mixer serves global settings rather than the
fine tuning.

For example, if the O-sound or the music is generally to be slightly quieter or the 
comments are to be set slightly louder, this is done with the mixer more quickly 
than with the manipulation of individual clips.

4.10.4.7 The Tab „Info“

The last Tab “Info” gives information about both the selected sample and the 
current soundtrack.
The names, volume, lengths and effects used are briefly listed here, with the 
keyboard there is the possibility to change the names. Good for orientation, if 
you want to get a quick overview After a number of adjustments and correc-
tions.
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4.10.5  Screen elements in the timeline view

G  The timeline view is only available with activated Gold Edition!

Note: Most of the following functions described for the timeline view are identically for the storyboard view. Therefore, we 
only describe the different timeline functions.

The main difference between the timeline and the storyboard view in the audio-mix is the fact that in the timeline the length rep-
resentation of the scenes corresponds to their real length.
While a scene in the storyboard view is always the same size, whether it is 5 seconds or 50 seconds long, the 50-second scene 
in the timeline view will actually be 10 times as long as the 5 second scene. Therefore, in the timeline display at the top of the 
screen, the “timeline” (1) can be displayed, a time ray in seconds and minutes.

In this way, we know exactly where in the film we are in the timeline view.

Furthermore, in the timeline below the video scenes, three more tracks are “added” that show us, also proportional to the real 
length, inserts, effects, titles and transition effects (2).

Under these tracks are the up to 9 audio tracks. To be more orientated, the yellow guides from the video track, which visually 
separate the scenes from each other (4), can be extended to the full height of the audio tracks via the switch (3). They represent 
the starting point of a scene and facilitate the overview when arranging the various clips in the 8 different tracks (without the O-
sound track).
If you add or move clips, the guides will make it easier to position them (more details later).

The samples are in the individual audio tracks. The samples show the so-called tone curve (5) in the upper half. This roughly 
shows the volume gradient of the sound. The envelope is shown in the lower half (6). You can freely adjust fades and other vol-
ume gradients.

Clicking the mouse in the envelope of a sample opens the Envelope tab (Chap. 4.10.4.4, image below). Here you can now di-
rectly edit the envelope without having to change screens or menus. In the timeline view, the tab structure is also noticeable with 
a plus in the overview and possible working speed.
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In the O-ton track, the appearance of the clips in the range of transition effects looks different. Here the aperture between the 
samples is indicated by a diagonal line.

The display of the envelope can be switched off in the settings.

The audio mix with the addition of samples, fades, effects etc. takes place in the timeline display just like in the storyboard dis-
play via the tab menus.

The appearance of the timeline and the individual clips can be defined in more detail as follows:

With the zoom switch (7), we have a slider that lets us zoom in on the timeline. Our picture above is set to a zoom of one minute 
(1m), with which you should “go” well with “normal” video editing and high screen resolution.

The following picture shows the ten minutes (10 m) representation.
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Pretty colorful, but in effect “eye powder”, which may serve as an overview for very long audio pieces, but just no longer for 
detailed work.
The zoom can be “drawn” up to 57 minutes, the field (9) provides information about the selected level.
Those who do not like to push (7) can also do the setting using the “+” and “-” switches (8).

The switches (10) to (12) allow special display modes at the touch of a button.

(10)  The switch “display to current sample normalize” brings the selected sample to approximately the size of the screen 
(image above).

(11)   The “Bring to maximum size” switch is a switch that zooms the selected sample to maximum. If it is pressed, you 
can undo the action with its pending “restore size”.
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(12)   Even larger, the selected audio track is displayed with the switch “bring to maximum size, temporarily turn off 
other tracks”. Also this switch is a toggle switch that switches back to the previous view with “Restore Size”.

(13)  The last switch in this series “Overview” toggles the timeline zoom into a 6-minute summary level, which, as shown 
above, allows a few normal orientation.

You will notice that the  new designed Audio-Mix menu requires a little bit of training, but then allows a much more relaxed and 
faster working than before.

4.11  Quit

This button quits Bogart. When quitting Bogart, your project will be stored automatically, so that after turning 
on the machine later you can continue your project where you left off.
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